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Asset Accounting

This part of the Implementation Guide contains all the implementation steps for the Asset Accounting (FI-
AA) component.

The first section, "FI-AA Implementation Guide - Lean Implementation,” contains the minimum steps
required for a quicker, more streamlined implementation of Asset Accounting. (See the FI-AA
Implementation Guide - Lean Implementation).

Note

- You can get more information about the concepts of SAP Asset Accounting in "FI-AA Asset
Accounting” in the SAP library. In the individual steps of the Implementation Guide, you find
references to this documentation under the heading "Additional Hints."

Asset Accounting (Lean Implementation)

Information about this Segment of the Implementation Guide

This segment of the Implementation Guide contains all the implementation steps needed for a minimal
configuration of the FI-AA Asset Accounting component. After you have completed all the activities in
this segment, the component is ready for production start-up. This reduced configuration is based on the
basic functions generally required of asset accounting.

In order to make quicker implementation possible, the complete functions of the FI-AA component are not
discussed here. The following topics have been omitted (among others):

- Depreciation areas in foreign currencies

- Requirements for consolidation of a corporate group

- Group assets

- Definition of your own depreciation keys (in addition to those provided in the standard system)
- Definition of your own transaction types (in addition to those provided in the standard system)
- Definition of your own reports in (addition to those provided in the standard system)

If you need any of the above functions, you have to use the more comprehensive SAP Reference IMG for
Asset Accounting.

Organizational Structures

In this section, you define the features of the FI-AA organizational objects (chart of depreciation, Fl
company code, asset class). All assets in the system have to be assigned to these organizational objects that
you define. In this way,

- You can represent your organizational structures that are relevant to Asset Accounting in the system -

you can classify your assets according to asset accounting criteria.
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At the same time, you can also assign assets to other organizational units in other components (such as cost
centres, plants, and so on). You define these organizational units in Customizing for the component they
belong to (such as cost centre accounting).

Copy Reference Chart of Depreciation/Depreciation Areas

In this step, you define your charts of depreciation. The chart of depreciation is a list of depreciation
areas arranged according to business and legal requirements. The chart of depreciation enables you
to manage all rules for the valuation of assets in a particular country or economic region.

You must assign a chart of depreciation to each company code that is defined in Asset Accounting. SAP
provides country-specific charts of depreciation with predefined depreciation areas. These charts of
depreciation serve only as a reference for creating your own charts of depreciation, and are therefore not
directly accessible in the SAP system. When creating a chart of depreciation, you have to copy the
reference chart of depreciation.

Note

When you create a chart of depreciation, the system copies all of the depreciation areas in the reference
chart of depreciation. You have to delete any depreciation areas that you do not need in your chart of
depreciation.

Depreciation areas that are not used can still be activated at a later point in time (after the production start-
up). A newly activated depreciation area can take over values from another depreciation area. (See the
SAP library FI-AA: Calculation of Asset Values (General) -> Subsequent Creation/Deletion of a
Depreciation Area)

Standard settings

SAP delivers country-specific reference charts of depreciation for each country. They contain all
depreciation areas for that country that are necessary to meet legal and business requirements. For
example, there are reference charts of depreciation for the following countries:

- USA

- Great Britain
- Germany

- Austria

- Spain

- Switzerland

- and so on

Activities

NIXONTAGMAN@GMAIL.COM | Asset Accounting



Create a chart of depreciation, using either an SAP standard chart of depreciation, or your own existing
chart of depreciation as a reference (Organizational unit -> Copy org. unit).

1.  If you want to create a chart of depreciation for a country for which a standard chart of depreciation
is not delivered by SAP, you can refer to a country-specific standard chart of depreciation with similar
depreciation parameters. You then have to specify any further country- specific characteristics during
the other customizing steps.

2. Enter the name of your chart of depreciation.

3. Delete the depreciation areas that are not needed from your new chart of depreciation and/or add new
depreciation areas by copying them.

Further notes

SAP library FI-AA: Organizational Elements

Assign Chart of Depreciation to Company Code

In Asset Accounting, you can only use company codes that have already been defined in Financial
Accounting as being generally valid. In addition to the general FI data for a company code, you have to
make additional specifications that apply for Asset Accounting. One of the most important of these
specifications is the assignment of a chart of depreciation to the company code.

In this step, you assign a chart of depreciation to each company code.

Requirements

- You have to have defined the generally valid data of the company code in Financial Accounting.
Standard settings

SAP supplies company code 0001 as an example.
Activities

1. Define your company codes for Asset Accounting by assigning a chart of depreciation to them.
Further notes

SAP library: Organizational Elements -> Company Code

Depreciation Areas

In this section, you specify
- which depreciation types are allowed in the individual depreciation areas

- which depreciation areas post automatically to the general ledger
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Specify Allowed Depreciation Types for Depreciation Areas

In this step, you specify which depreciation types and special valuations (such as interest) are allowed in
your depreciation areas.

Example

For example, if you want to manage ordinary depreciation as well as special depreciation in the book
depreciation area (01), you have to allow the management of ordinary and special depreciation in that
depreciation area.

Standard settings

The standard depreciation areas already have the necessary settings.
Activities

Check the standard settings.

Define How Depreciation Areas Post to General Ledger

In this step, you specify the depreciation areas that post their APC transactions and/or depreciation to the
general ledger.

The system can post the APC transactions of one depreciation area to the general ledger online
automatically. Usually this is the book depreciation area 01. You can post transactions from other
depreciation areas to the general ledger automatically using periodic processing. (The exception to this
rule are the depreciation areas for investment support shown on the liabilities side, which can also post
online.) You always have to use periodic processing to post depreciation to the general ledger.

Standard settings

The standard depreciation areas in the SAP reference chart of depreciation are set up so that book
depreciation area 01 posts APC transactions automatically to the general ledger online. It posts
depreciation automatically to the general ledger (using batch). The definitions of other depreciation areas
depend on your country-specific chart of depreciation.

Recommendation

It is usually sufficient to have automatic posting of APC transactions and depreciation from the book
depreciation area. There could be other circumstances under which you might need automatic posting to
the general ledger from other depreciation areas:

- You might need to post cost-accounting interest (that differs from book depreciation) to certain
expense accounts or cost elements.

- You might have special requirements for the balance sheet, such as showing special reserves.

- You might have special requirements for legal consolidation of your corporate group.
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Activities

Specify how (if) your depreciation areas should post to the general ledger:

- no values

- APC transactions online and depreciation in periodic processing

- APC transactions in periodic processing and depreciation in periodic processing

- only depreciation in periodic processing
Further notes

SAP library FI-AA: Periodic Processing

Asset Classes

In the following step, you define your asset classes and the control parameters for asset classes. The most
important control parameters are:

- the account determination
- the screen layout rule

- the number interval that the system should use for assigning asset main numbers in the asset class

Generate Asset Classes from G/L Accounts (1to 1)

In this step you generate:

- Asset classes

- Account determinations
- Screen layout rules

- Number ranges for the assignment of the main asset number
These objects are generated in a 1 to 1 relationship to your asset balance sheet accounts. The system enters
account determinations, screen layout rules and number ranges in the asset class as control parameters.

Note: Carrying out this step is not mandatory. Generating your asset classes from your G/L accounts is an
optional step you can use to simplify the creation of asset classes. If you want to define asset classes without
the help of your G/L accounts, use the step Define asset classes. You also use the "Define asset classes"
step to copy asset classes. Copying classes is useful for adding to your asset classes, if you generated asset
classes from your G/L accounts using the current step.

You define additional account determinations, screen layout controls and number ranges (if needed) in the
section Organizational Structures.

Requirements

You must be able to enter all your asset balance sheet accounts.
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Standard settings

SAP supplies example asset classes.

Note

This processing view has 7 navigation levels. The first navigation level is the overview screen containing
the generating function. The next 6 navigation levels are detail screens for this overview screen. You have
to work through all of the detail screens before you can start the generation of the asset classes in the first
navigation level.

The first detail screen (account selection) has to be processed first. There is no hierarchy for the remaining
detail screens (no detail screens for the prior navigation level). They are not dependent on each other. You
can work through each of these screens independently from the other.

Activities

A Wizard guides you through the different navigation steps. Asset classes are not generated until you save.
1.  Enter your chart of accounts and the chart of depreciation.
2. Select all G/L accounts that are APC balance sheet accounts.

3. The system prepared an account determination for each APC account, with a description that is the
same as that of the given APC account.

Add to the account determination by entering the corresponding accumulated depreciation account
for each account determination.

4. Enter accounts for expense, ordinary depreciation, and asset retirements for all account
determinations.

In a later step, you can change these accounts for each account determination.

5. The system created a number range interval for each APC account. Change the number range intervals
as needed:

a) Change the limits of the number ranges.

b)  Specify whether the assignment of the main asset number should be external or internal. SAP
recommends internal number assignment. You could define the number range intervals, for
example, so that the first characters of the asset number agree with the first characters of the
APC account number.

6. The system created a screen layout control for each APC account.
When the APC account has a number that is at most 5 characters long, the system automatically
assigns the account number as the key for the screen layout control. If the account number has more
than 5 characters, you have to enter the 5-character key for the screen layout control manually. Select
the field groups that you want to be optional entries in the asset class.

7. The system created an asset class with the same name as each APC account. Add to the asset classes:

a) Specify the type of the asset class (asset under construction, low value asset with or without
collective management, no special class type).
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b)  Specify the default depreciation key and the default useful life for each depreciation area. You
can add to this information for more depreciation areas in a later step.

Caution

You can use the function for generating asset classes more than once. The system uses the following logic
when you do so:

- First, the system checks whether the company code is already in production status. If it is, then the
system creates, based on the G/L accounts you have selected, only asset classes, account
determinations and so on that were not yet created. Any existing asset classes are not changed; nor
are they deleted and created again.

- If the company code is not yet in production, the system checks whether assets already exist for the
existing asset classes. If not, the system deletes the existing asset classes and generates them again.

- If assets do exist, the system checks if there are also transactions for the assets. If there are no
transactions, you can decide which of the following you want to do:

- Delete all asset classes and their assets, and generate them again
- Only add new asset classes

- If transactions exist for the assets, then you can only add new asset classes. In order to completely
regenerate all asset classes, you first have to reset the company code (under "Production Start-up™).

When you choose the "New start™ function, the system does not delete any Customizing objects that were
already created (asset classes, and so on). This function simply resets the internal working table for this
transaction. This means that after you reset, the transaction is returned to its original state (state the first
time it was called).

Specify Required Entries for Asset Master Data

In this step, you make any corrections to the screen layout controls that you created when you generated
the asset classes. The screen layout controls all the essential features of the fields of the asset master record.
One of the especially important features you can set is which fields should be required entry fields.

&NOTE

In order to make sure that you’re later asset master data maintenance is as quick and efficient as possible,
you should work through this step very carefully.

Activities
Define the features of the field groups
- their treatment in the asset master data screen (required, optional, display or suppressed)

- the maintenance level

- whether they can be copied (when creating a master record using a reference asset)
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Define Allowed Entries for User Fields

In this step, you define the following fields:

- asset master record fields for which you can set up your own meaning (evaluation groups)
- a field for identifying environmental protection measures

- afield for the reason for investment

You can use these fields (just as you can any other master data fields) as selection criteria in reporting
(using dynamic selections). You can also use these fields in sort versions.

Note

You can enter the valid entries for these evaluation groups in a check table, but you do not necessarily
have to define them there. The system uses the following logic:

If at least one entry is defined for an evaluation group in the check table, the system checks the values
entered in the asset master record against this table. If no entries are defined in the check table (table
empty), the system does not check the entries to see if they are valid. In this case you can enter any
evaluation group you like.

Activities
Create the definitions for these master data fields.

Further notes

SAP library FI-AA: Master Data -> User Fields

Copy Asset Classes from Reference

In this step, you make copies of the asset classes that were generated from the G/L accounts. When you
copy the asset class, it gives you the opportunity to control the default values in the asset class (particularly
the depreciation terms) more finely than at the G/L account level.

Example

If you have a G/L account for buildings, for example, you can set up individual asset classes for each type
of building depreciation. These asset classes would then contain the depreciation keys and default values
for the given type of depreciation.

Requirements

You must have created your asset classes.

Recommendation
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Use one asset class to group together assets that use the same G/L account and the same depreciation
method. You can have the useful life as a default value in the asset class. However, it does not make sense
to create more asset classes just to reflect useful lives of different length, since this would make your asset
class catalogue unnecessarily large.

Activities

Copy the asset classes you generated from the G/L accounts as needed to meet your requirements Edit ->
Copy as.

Note

You can change the depreciation terms and the default values of the asset classes you copied in the next
implementation step.

Enter Default Values in Asset Classes

In this step, you enter default values for asset master data maintenance in your asset classes.

Requirements

You must have created your asset classes.

Standard settings

SAP supplies pre-defined asset classes as examples (1-8).
Activities

Enter default values in your asset classes for

- depreciation terms

- net worth tax, insurance and leasing

- user fields

Note

You define the allowed characteristic values for net worth tax and insurance in the section Special
Valuation.

Specify Asset Class for Creating Asset from Purchase Order

You can create an asset directly from the purchasing transaction for purchase orders. Using this method,
you can enter an asset purchase order, without creating an asset beforehand in Asset Accounting. This asset
will serve as the account assignment object for the purchase order.

In this step you specify the asset classes that the system should use as defaults when you create an asset
from within a purchase order. You have to specify the asset class in relationship to the material group.
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Activities
Assign an asset class to each of your material groups for fixed assets.

Further notes

SAP library FI-AA: "Acquisitions -> Purchase Orders for Assets"

Assign G/L Accounts

In this step, you specify the balance sheet accounts, special reserve accounts, and the depreciation accounts
for Asset Accounting.

Note

If you enter accounts for gain/loss for a special depreciation area, the system does not post revenue from
the write-off of special reserves. Instead, when there is revenue from write-off of special reserves due to
an asset sale, the system includes this amount in the gain/loss. The system then balances the book
depreciation area loss by a posting to an offsetting account, and posts the sum/difference between the
revenue from the write-off of the special reserve and the book depreciation area loss to these accounts.

There are restrictions on the screen layout of accounts that will be posted using collective posting. There
cannot be any required fields that are not supplied with values by the batch input posting run.
Example:

A posting text cannot be a required entry for value adjustment accounts, since the depreciation posting
program does not create any posting texts.

Further notes

SAP Library FI-AA: Integration with the General Ledger -> Account Determination

Specify Intervals and Posting Rules

In this step, you define the posting rules for the depreciation areas that post depreciation values to Financial
Accounting. You define the posting cycle (how often depreciation is posted) and the account assignment
rules for the depreciation posting run.

Requirements

You must have specified which depreciation areas should post automatically to the general ledger.
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SAP supplies country-specific reference charts of accounts. These charts of accounts contain predefined
depreciation areas.

Activities

1. Specify how often the posting runs are to be carried out.
Example (meaning of the entry when there are 12 posting periods):
1 = monthly posting
3 = quarterly posting
6 = semi-annual posting
12 = annual posting
Note

You can also change the posting cycle when the system is productive. In order to do this, you only
have to change the number before the next scheduled posting run.

2.  Specify whether you want additional account assignment to cost centres or orders. The system then
posts account assignment of the order or WBS elements in the given master record. If you specify
both CO account assignments (order and project) for the depreciation posting program, and both an
order and a WBS element are entered in the asset master record, the system makes account assignment
only to the order (no double CO account assignment).

Note that the following is required for the account assignment to CO: the field status variant of the
company code must allow additional account assignment to orders and/or cost centres for the revenue
accounts involved (also see: Change Field Status Variants of the Asset Accounts).

3. For depreciation areas that handle interest, specify if you want to post this interest to the general
ledger.

4. For depreciation areas that post depreciation to the general ledger, specify whether the system
Should use the catch-up method or smoothing.

Assign Input Tax Indicator for Non-Taxable Acquisitions

In this step, you specify an input tax indicator per company code. The system then uses this indicator when
you post acquisitions that are not subject to tax, but which are posted to accounts that are tax-relevant.

Example

An acquisition of this type is an acquisition from in-house production. In the Asset Accounting posting
transaction for this acquisition, the input tax indicator is not ready for input.

Activities

In each company code, enter a tax indicator for business transactions that are not subject to taxes (for
example, VO).
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Specify Financial Statement Version for Asset Reports
In this step, you determine, per depreciation area, which financial statement version the system is to use as
a default. This default applies when the financial statement version is contained in the sort version used
for a given report.

Example

For instance, you may want to assign a different financial statement version to the tax depreciation area
than you assign to the book depreciation area.

Standard settings

In the standard system, the financial statement version INT is assigned to all company codes/depreciation
areas.

Activities

Determine the financial statement version for each company code/depreciation area.

Special Valuation

In this step, you make the system settings for special valuation for

- Net worth tax
- Insurance

Investment support

- Leasing

Assign Accounts
In this step, you determine the general ledger accounts for the write-off or allocation of special reserves.
Note

If you enter gain/loss accounts for this depreciation area, the system does not post any revenue from the
write-off of special items for reserve. Instead, the system includes any revenue from the write-off of special
items for reserve, resulting from an asset sale, in the calculation of gain/loss itself. The system balances
loss in the book depreciation area against an offsetting posting, and posts the total or the difference between
the write-off of special items for reserve and the book loss to these accounts.
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Define Net worth Valuation

In this step, you define the allowed entries for asset master data fields that are used when determining net
worth tax burden.

The fields are particularly helpful as sort criteria for the standard report on net worth tax in the Information
System of Asset Accounting.

Standard settings

SAP provides examples for allowed entries.

Activities

Define allowed entries for
- Property classification key
- Property indicator

- Reason for manual net worth valuation

Further notes

SAP Library FI-AA: Special Valuation -> Net worth Tax

Define Insurance Information for Assets

In this step, you define the asset master data fields that are used for insurance.

These fields are especially important as sort criteria for the standard insurance report in the Asset
Accounting Information System.

Standard settings
SAP provides sample definitions.
Activities

Define the

insurance types
- insurance companies

- insurance premiums

Further notes
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SAP library FI-AA: Special Valuation -> Insurance

Define Investment Support

In this step, you define investment support keys. Investment support keys are needed for claiming
investment support measures. The definition of the investment support key contains all information needed
for claiming the investment support.

When you enter an investment support key in the master record of an asset, you indicate that the asset is
eligible for investment support. There is a standard report in the system that allows you to select all
investment support measures and to create an investment support claim form. Once the investment support
is approved by the authorities, you can use the same report to create a posting session for claiming the
investment support.

Standard settings

SAP provides sample investment support keys.
Activities

1. Define an investment support key for each investment support that you want to claim.

2.  Define plausibility’s for this investment support key for asset master data maintenance. Using this
method, you can specify that the system automatically defaults a certain investment support key in
the asset master record of assets that are assigned to a particular plant, for example.

3. Enter the G/L accounts that should be posted when investment support is claimed.

SAP library FI-AA: Special Valuation -> Investment Support

Define Leasing Types

In the FI-AA system, leased assets can be -

managed as statistical assets (without values)

- Capitalized according to the capital lease method.

In this step, you define the leasing types for the valuation of leased assets which must be capitalized. You
specify the leasing type in the asset class or in the asset master record. You can classify your leased assets
with the leasing type. The leasing type also contains the essential parameters for posting the acquisition of
an asset that is to be capitalized using the capital lease procedure (such as, transaction type). The system
determines the accounts to be posted and the amount to be capitalized with the help of the following
relevant values:

- active depreciation areas in the respective asset class

- leasing conditions in the asset master record
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In this way, you can capitalize leased assets according to the capital lease method using the present value
of future payments.

Note

This capitalization using the capital lease method is only possible at the present time (Release 3.0), if the
book depreciation area is included. If you want to capitalize a leased asset only in the cost accounting
depreciation area, then you have to do it manually. You have to use special transaction types, which only
post to the depreciation areas you want.

Default settings

SAP provides one leasing type as an example (leasing type 1).

Actions

Create your own leasing types according to your requirements.
Define the following for acquisition posting:
- transaction type

- document type

input tax code
- posting key

Further notes

SAP library: Special Valuations of Fixed Assets -> Valuation Methods for Leased Assets

Enter Default Values in Asset Classes

In this step, you enter the default values for asset master data maintenance in your asset classes.

Requirements

You must have created your asset classes.
Standard settings

SAP supplies predefined asset classes as examples (1-8).
Activities

Enter default values in your asset classes for net worth tax valuation and insurance.
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Asset Data Transfer

In the section "Data Transfer", you transfer old assets data from a previous system to your SAP System.

Note

The transfer of old asset data using the old assets transaction does not affect the balances of the
corresponding reconciliation accounts in Financial Accounting. Therefore no automatic balance formation
or reconciliation takes place and you will need to manually reconcile the balances. You can ascertain the
Asset Accounting values using the asset list. When you start this report, specify January 1st of the current
fiscal year as the report date. The system will then provide data as of December 31st of the previous fiscal
year (in other words, no depreciation from the current fiscal year is included). You can make any correction
postings to the reconciliation accounts using a special posting transaction (see Preparations for Productive
Operation.

Further notes

SAP library FI-AA: Asset Data Transfer

Set Company Code Status

In this step, you set your company codes to the status for old assets data takeover.

Requirements

You must have assigned a chart of depreciation to the company codes for Asset Accounting.

Standard settings

As standard, the company codes that have been assigned a chart of depreciation for Asset Accounting are
set to test mode. This means that

- assets can be taken over from a previous system
- posting can be carried out

When the status is "old assets data takeover", posting is no longer possible.
Activities

Set the company codes in question to the status "Old assets data takeover allowed".

NIXONTAGMAN@GMAIL.COM | Asset Accounting



Specify Parameters for Data Transfer

In this step, you specify the control parameters for the transfer of legacy data from your previous system:

- Date, which will be the value date for the legacy data transferred to the SAP Asset Accounting
component (transfer date).

This date also determines the last closed fiscal year for Asset Accounting.
Example:

Transfer date = 12/31/YYYY

=> Last closed fiscal year = YYYY

Transfer date = 06/30/YYYY

=> Last closed fiscal year = YYYY

- Period up to which depreciation has already been posted to the general ledger in your previous system

You only need this entry when you transfer data during the course of the fiscal year (rather than at
the end).

- If your legacy system contains only net book values, rather than depreciation values and historical
APC, you can transfer net book values.

- Depreciation areas, for which the system should recalculate accumulated past depreciation

- Depreciation areas, for which the system should determine a new base insurable value.

Standard settings

You have to make the date specifications yourself. The other transfer parameters are already set up in the
standard depreciation areas.

Activities
1.  Enter the transfer date

- which should determine the status of the legacy data the system transfers from your previous
system and

- which should determine the value date of the data in the SAP System

2. If you chose a transfer date within the fiscal year (not at the end), enter the period up to which
depreciation was already posted.

3. Check the standard settings for the other transfer parameters.

Further notes

SAP library FI-AA: Asset Data Transfer

Data Transfer Workbench: Fixed Assets

The data transfer workbench is a central transaction for the automatic transfer of data from a legacy system
into the ERP system. It offers the tools required for the initial and subsequent data transfer.

The complete documentation about the data transfer workbench is in the SAP Library:
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CA - Cross-Application Components -> CA - Data Transfer Workbench

The documentation tells you step by step how to carry out the data transfer, and which object-specific
special features you should be aware of.

Create/Change/Display Legacy Asset

In this step, you enter legacy assets from your previous system using an online transaction (Asset ->
Create). You can also change or display legacy assets.

Further notes

SAP Library: Legacy Data Transfer -> Transfer Methods -> Manual Transfer Using the Legacy Data
Transfer Transaction

Preparing for Production Start-up

After you have met your functional requirements by making the corresponding Customizing settings, you
carry out the more technically-oriented activities that are necessary for your SAP System to go productive
in the following section.

Reset Company Code

In this step, you can delete test application data (asset master records and transactions) for a company code.
This might be necessary, for example, following a test takeover of old assets data.

Customizing settings are not deleted.

Caution

- Atpresent, you cannot reload the deleted data again.

- If you are also using the IM (Investment Management) component, the assets under construction
belonging to capital investment measures are also reset. This can lead to inconsistencies in relation
to the orders/WBS elements, to which the assets under construction belong.

Requirements

1. The company code you want to reset must be in test status.

2. You must have entered the application data (asset master records and transactions) in the test

Note

installation.
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Keep in mind that Asset Accounting data is deleted in this processing step, but integrated applications (for
example, Financial Accounting) are not affected. Therefore you should only carry out this step in
conjunction with the other applications.

There is no problem with data that was transferred within the framework of the old assets data transaction
(or the batch input interface), since the old data takeover transaction does not update the values in Financial
Accounting.

Activity

1. Settest status in the asset definition of the affected company code.

2.  Start the reset program for the affected company code.

Reset Posted Depreciation

In this step, you can reset the posted depreciation in the asset sub ledger (only when the company code is
in test status). The system then deletes the corresponding value data of all the fixed assets for a company
code. This reset also deletes all data that is used to manage and monitor the depreciation posting runs. This
action might be necessary if you need to return to the original depreciation posting status during the system
installation phase, if errors occurred when you tested the depreciation posting run.

This is not a reset in the accounting sense. No documents or posting sessions are created to cancel the
depreciation posting already made in Financial Accounting. As a consequence, a reset in Asset Accounting
results in differences between the accumulated depreciation of the fixed asset in the sub ledger and the
respective accounts in Financial Accounting. You need to make manual adjustment postings in the general
ledger to eliminate these differences. A reset is therefore only possible for company codes in a test
installation. The reset of the depreciation data is logged in the system log.

Caution

Please keep in mind that the data of all posting runs is deleted, not just the data of the last depreciation
posting run. In addition, the posted values entered during a data transfer during the fiscal year (depreciation
in the year of data transfer that was already posted in the legacy system) are deleted. This legacy data
therefore has to be re-entered.

Activities

1.  Start the reset program. Specify the company code and press ENTER.

2. Modify the number range of the document type for depreciation postings after successfully resetting
the posted depreciation. Define a new interval. As a lower limit of the new interval enter the number
following the last assigned document number.

Example:

Old number range: 0300000000 to 0399999999
last assigned document number: 0300000123 new
number range: 0300000124 to 0399999999

3. Correct the balances of the expense accounts or the accumulated depreciation accounts in Financial
Accounting (see balance transfer).
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Check Consistency

After you have made all needed system settings, you can now check their consistency.
You should carry out this test for the following reasons:

- Along with the dialog checks, you should also check the consistency of your system settings at the
end as a whole (in overview).

- You should print out the settings.
In this step, you can
- check the plausibility of your system settings and

- print them out

Requirements

You must have worked through all of the previous steps.
Activity
1. Check the system settings for charts of accounts, company codes, and depreciation areas in the
corresponding overview lists.
2. Start the consistency report for the asset general ledger accounts.

3. Start the consistency report for the FI-AA Customizing settings.

Set or Reset Reconciliation Accounts

In this step, you can define the G/L accounts of Asset Accounting as reconciliation accounts, or you can
set these reconciliation accounts back to being normal, postable accounts. You can make these changes
only as long as the company code is not live for Asset Accounting. Another prerequisite is that this change
is no longer possible in Financial Accounting itself, because of balances from asset data transferred from
your legacy system.

Set reconciliation accounts

Once you make this change, it is no longer possible to post directly to these accounts. Instead only
integrated posting using Asset Accounting is possible after this point.

Requirements

- You defined your account determination.

- You reconciled asset accounting balance sheet values with the balances of the reconciliation

accounts concerned.
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- Todo so, use the Asset Accounting report Asset List. Enter the report date January 1, YYYY (if
data was transferred at fiscal yearend). YYYY denotes the year the system went live. In
Financial Accounting (FI), you can use an appropriate balance list for this purpose.

- Another option is to use reconciliation reports for this reconciliation.
Activities

Procedure for automatic conversion:
1. On the detail screen, choose Set Reconciliation Ind. for All Accounts.

2.  Print the balances and the FI-AA asset list as a record for audits.

Caution

The accounts affected by the conversion are not allowed to be posted while the conversion is taking place.

Reset reconciliation accounts

Resetting the reconciliation account indicator in the account master data is also allowed only when the

company code is still in test status. This step is not necessary during an ordinary system implementation.

However, changing the reconciliation accounts could become necessary under the following

circumstances:

- You entered an incorrect account in an account assignment for Asset Accounting, and then carried
out the "Set reconciliation accounts” step.

- You have to post balance adjustments to reconciliation accounts after the original conversion.

- You copied the account definitions from an asset accounting company code to another company code,
where asset accounting is not active. This second company code is intended for parallel accounting.
Now you would like to reset all reconciliation account indicators for this second company code.

Activities
3. Choose the company code you want to process.
4. Do one of the following:

a) Reset the reconciliation account indicator for individual accounts.

b) Reset the reconciliation account indicator for all displayed accounts by choosing Delete
Reconciliation Ind. for All Accts.

Caution

Once the indicator is reset, these G/L accounts can again be posted directly, so that consistency between
the sub ledger balances and G/L balances is no longer guaranteed.
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Transfer Balances

In this step you can post balances to G/L accounts which have already been defined as reconciliation
accounts. You can only post these corrections in company codes which have implementation status.

The transfer of legacy asset data using the legacy asset transaction does not affect the balances of the
corresponding reconciliation accounts in Financial Accounting. Therefore no automatic balance formation
or reconciliation takes place and you will need to manually reconcile the balances. You can ascertain the
Asset Accounting values using of the asset list. When you start this report, specify January 1st of the
current fiscal year as the report date. The system will then provide data as of December 31st of the previous
fiscal year (in other words, no depreciation from the current fiscal year is included).

Activities

Copy the balances from any suspense accounts to the Asset Accounting reconciliation accounts.

Activate Company Code

In the "Activate Company Code" step, you set the live indicator (0) for the company codes in which the
test phase and legacy data transfer have ended. The live indicator ensures that data is not deleted from live
company codes by programs for deleting test data.

Requirements

After legacy data transfer and before setting a company code to live (production status) it is mandatory
to reconcile account balances, since the transfer of legacy data does not affect the reconciliation accounts
for Financial Accounting. There is no automatic creation and reconciliation of balances during legacy data
transfer.

Note

It is absolutely mandatory that you set the company code to live status (not test status) before you start live
use of the company code. In order to ensure the safety of live data, a live company code should not be set
back to test status. However, should it become necessary to enter legacy asset data after you have set the
status to live, you can still reset the status.

Activities

Set the live indicator for the desired company codes.

Organizational Structures

In this section, you define the features of the FI-AA organizational objects (chart of depreciation, FI
company code, asset class). All assets in the system have to be assigned to these organizational objects that

you define. In this way,
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- You can represent your organizational structures that are relevant to Asset Accounting in the system -

you can classify your assets according to asset accounting criteria.

At the same time, you can also assign assets to other organizational units in other components (such as cost
centres, plants, and so on). You define these organizational units in Customizing for the component they
belong to (such as cost centre accounting).

Check Country-Specific Settings

Some of the system settings in the FI-AA system are subject to different laws and guidelines in different
countries. SAP provides these settings, for the most part, already preconfigured. However, SAP cannot
take responsibility for their completeness.

The system uses the country-specific data in each company code that agrees with the country in the
definition of the FI company code (FI Customizing).

Example

The maximum amount for low value assets is different in each country.
Requirements

You must have defined your company codes in Customizing for the FI system, and assigned countries to
them.

Standard settings

SAP provides the appropriate default settings for most countries.
Activities

Check the standard defaults provided for your country.

Note

All country-specific system settings are dependent on the company code. The system assigns the settings
you make in this step to the company code (one time only!) as soon as you initially assign a chart of
depreciation to the company code. If you want to change these settings at a later point in time, you have to
use other steps in the Implementation Guide. You can change the changeover amount for depreciation
calculation under "Valuation", and other settings under "Activities".

Copy Reference Chart of Depreciation/Depreciation Areas

In this step, you define your charts of depreciation. The chart of depreciation is a list of depreciation
areas arranged according to business and legal requirements. The chart of depreciation enables you
to manage all rules for the valuation of assets in a particular country or economic region.

You must assign a chart of depreciation to each company code that is defined in Asset Accounting. SAP
provides country-specific charts of depreciation with predefined depreciation areas. These charts of
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depreciation serve only as a reference for creating your own charts of depreciation, and are therefore not
directly accessible in the SAP system. When creating a chart of depreciation, you have to copy the
reference chart of depreciation.

Note

When you create a chart of depreciation, the system copies all of the depreciation areas in the reference
chart of depreciation. You have to delete any depreciation areas that you do not need in your chart of
depreciation.

Depreciation areas that are not used can still be activated at a later point in time (after the production start-
up). A newly activated depreciation area can take over values from another depreciation area. (See the
SAP library FI-AA: Calculation of Asset Values (General) -> Subsequent Creation/Deletion of a
Depreciation Area)

Standard settings

SAP delivers country-specific reference charts of depreciation for each country. They contain all
depreciation areas for that country that are necessary to meet legal and business requirements. For
example, there are reference charts of depreciation for the following countries:

- USA
- Great Britain
- Germany
- Austria
- Spain
- Switzerland
- andsoon
Activities
Create a chart of depreciation, using either an SAP standard chart of depreciation, or your own existing
chart of depreciation as a reference (Organizational unit -> Copy org. unit).

1. If you want to create a chart of depreciation for a country for which a standard chart of depreciation
is not delivered by SAP, you can refer to a country-specific standard chart of depreciation with similar
depreciation parameters. You then have to specify any further country- specific characteristics during
the other customizing steps.

2. Enter the name of your chart of depreciation.

3. Delete the depreciation areas that are not needed from your new chart of depreciation and/or add new
depreciation areas by copying them.

Further notes

SAP library FI-AA: Organizational Elements
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Assign Chart of Depreciation to Company Code

In Asset Accounting, you can only use company codes that have already been defined in Financial
Accounting as being generally valid. In addition to the general FI data for a company code, you have to
make additional specifications that apply for Asset Accounting. One of the most important of these
specifications is the assignment of a chart of depreciation to the company code.

In this step, you assign a chart of depreciation to each company code.

Requirements

- You have to have defined the generally valid data of the company code in Financial Accounting.
Standard settings

SAP supplies company code 0001 as an example.
Activities
1. Define your company codes for Asset Accounting by assigning a chart of depreciation to them.

Further notes

SAP library: Organizational Elements -> Company Code

Specify Number Assignment across Company Codes

In the FI-AA module, you can assign the main asset number across company codes. Therefore, for every
company code, you can determine from which (other) company code number assignment is to be carried
out. In this step, you define a cross-company code assignment of the main asset number. If you do not want
a cross-company code number assignment, you do not need to define any system settings here.

Requirements

You must have edited the system-specific specifications of the company codes.

Standard settings

The assignment of the main asset number is not cross-company code in the standard system. The system
automatically creates a separate number range for each new company code.

For example, SAP delivers company code 0001. This company code is defined without cross-company
code number assignment.

Activities

Determine which company code is to be used for the cross-company code number assignment for your
company codes. The system then assigns the main asset number from the number range of the assigning
company code in these company codes.
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If cross-company code number assignment is not required, you must enter the separate key of the company
code that you are currently editing.

Further notes

SAP library FI-AA: Master Data -> Number Assignment

Asset Classes

In the following step, you define your asset classes and the control parameters for asset classes. The most
important control parameters are:

- the account determination
- the screen layout rule

- the number interval that the system should use for assigning asset main numbers in the asset class

Generate Asset Classes from G/L Accounts (1to 1)

In this step you generate:

- Asset classes

- Account determinations

- Screen layout rules

- Number ranges for the assignment of the main asset number

These objects are generated in a 1 to 1 relationship to your asset balance sheet accounts. The system enters
account determinations, screen layout rules and number ranges in the asset class as control parameters.

Note: Carrying out this step is not mandatory. Generating your asset classes from your G/L accounts is an
optional step you can use to simplify the creation of asset classes. If you want to define asset classes without
the help of your G/L accounts, use the step Define asset classes. You also use the "Define asset classes"
step to copy asset classes. Copying classes is useful for adding to your asset classes, if you generated asset
classes from your G/L accounts using the current step.

You define additional account determinations, screen layout controls and number ranges (if needed) in the
section Organizational Structures.

Requirements

You must be able to enter all your asset balance sheet accounts.

Standard settings

SAP supplies example asset classes.
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Note

This processing view has 7 navigation levels. The first navigation level is the overview screen containing
the generating function. The next 6 navigation levels are detail screens for this overview screen. You have
to work through all of the detail screens before you can start the generation of the asset classes in the first
navigation level.

The first detail screen (account selection) has to be processed first. There is no hierarchy for the
Remaining detail screens (no detail screens for the prior navigation level). They are not dependent on each
other. You can work through each of these screens independently from the other.

Activities

A Wizard guides you through the different navigation steps. Asset classes are not generated until you save.

1.
2.

Enter your chart of accounts and the chart of depreciation.
Select all G/L accounts that are APC balance sheet accounts.

The system prepared an account determination for each APC account, with a description that is the
same as that of the given APC account.

Add to the account determination by entering the corresponding accumulated depreciation account
for each account determination.

Enter accounts for expense, ordinary depreciation, and asset retirements for all account
determinations.

In a later step, you can change these accounts for each account determination.

The system created a number range interval for each APC account. Change the number range intervals
as needed:

a) Change the limits of the number ranges.

b)  Specify whether the assignment of the main asset number should be external or internal. SAP
recommends internal number assignment. You could define the number range intervals, for
example, so that the first characters of the asset number agree with the first characters of the
APC account number.

The system created a screen layout control for each APC account.
When the APC account has a number that is at most 5 characters long, the system automatically
assigns the account number as the key for the screen layout control. If the account number has more

than 5 characters, you have to enter the 5-character key for the screen layout control manually. Select
the field groups that you want to be optional entries in the asset class.

The system created an asset class with the same name as each APC account. Add to the asset classes:

a) Specify the type of the asset class (asset under construction, low value asset with or without
collective management, no special class type).

b)  Specify the default depreciation key and the default useful life for each depreciation area. You
can add to this information for more depreciation areas in a later step.

Caution

You can use the function for generating asset classes more than once. The system uses the following logic
when you do so:
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- First, the system checks whether the company code is already in production status. If it is, then the
system creates, based on the G/L accounts you have selected, only asset classes, account
determinations and so on that were not yet created. Any existing asset classes are not changed; nor
are they deleted and created again.

- If the company code is not yet in production, the system checks whether assets already exist for the
existing asset classes. If not, the system deletes the existing asset classes and generates them again.

- If assets do exist, the system checks if there are also transactions for the assets. If there are no
transactions, you can decide which of the following you want to do:

- Delete all asset classes and their assets, and generate them again
- Only add new asset classes

- If transactions exist for the assets, then you can only add new asset classes. In order to completely
regenerate all asset classes, you first have to reset the company code (under "Production Start-up™).

When you choose the "New start™ function, the system does not delete any Customizing objects that were
already created (asset classes, and so on). This function simply resets the internal working table for this
transaction. This means that after you reset, the transaction is returned to its original state (state the first
time it was called).

Specify Account Determination

In this step, you define the account determinations for Asset Accounting (key and description). The key of
an account determination must be stored in the asset class asset class. In this way, the account determination
links an asset master record to the general ledger accounts to be posted for an accounting transaction using
the asset class.

You specify the general ledger accounts to be posted for the individual accounting transactions in later
implementation activities. You can specify various accounts for each depreciation area to be
simultaneously posted to.

Recommendation

Usually, you need at least the same number of account determinations as you have asset balance sheet
accounts in the general ledger (normally this is the same as the number of asset types).

Requirements
You must have defined your company codes.
Standard settings

SAP supplies account determinations. The account determinations refer to the standard charts of accounts
of Financial Accounting.

Activities
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Create account determinations according to your requirements (key/description).

Further notes

SAP library: Transactions -> Account Determination

Create Screen Layout Rules

In this step, you create your screen layout rules. The screen layout specifies the status of the fields in the
asset master record. You use the screen layout to determine if fields are required entry or optional entry
fields, or if they are suppressed completely, for example.

In this step, you create only the keys and descriptions of the screen layout controls. You define the field
group rules for the screen layouts themselves in the step Master Data.

You can enter a screen layout rule in one of two places: either in the part of the asset class valid in the
entire client, or in the part of the asset class valid for the chart of depreciation. The screen layout rule is
then valid either for all assets in the asset class, or for all assets in the asset class/chart of depreciation.

Note

You create the screen layouts here for the general master data (only the key and description). There is a
separate screen layout control for the depreciation areas and the valuation section of the asset master record.
You define this second screen layout control in the step Define screen layout control for asset depreciation
areas.

Standard settings

SAP supplies pre-defined screen layout rules for the most commonly used asset types.

Recommendation

If you have additional asset types for which you need special screen layout rules, make your own additions
to the standard rules.

Activities
Define the screen layout rule for the general data part of the asset class by entering a key and a description.

Additional information

SAP library FI-AA: Master Data -> Screen Layout and Maintenance Level

Define Number Range Interval

In this step, you define the number ranges for this company code for assigning the main asset number. You
can roughly classify your asset portfolio using the number ranges.

In the asset class, you can specify the number range for the assignment of numbers for that asset class. To
keep administration needed for the number assignment to a minimum, you should use number ranges with
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internal assignment. You can enter asset numbers of unique and special significance in the master data
field "inventory number." Using the relevant customer enhancement project you can use these numbers
as asset keys in standard reports (see the SAP library FI-AA: User Modifications).

Note

The number assignment of asset sub-numbers is also controlled by the asset class. You specify there
whether the assignment of sub-numbers is internal or external. Number ranges are not required for the
assignment of asset sub-numbers.

Requirements

You must have worked through the section Company codes for Asset Accounting

Standard settings

SAP provides standard number ranges.

Recommendation

If possible, use internal number assignment.
Activities

1.  First, determine how many separate number ranges you need for assets. You already specified which
company codes have separate number ranges and which share the number ranges of another company
code, when you defined the company codes for Asset Accounting.

Create the number intervals for company codes which have their own number ranges.

Further notes (Transport)

You transport number range objects as follows:
Choose Interval -> Transport in the accounting document Number Range screen.

All intervals for the selected number range object are deleted in the target system first. After the import,
only the intervals you export are present. The number statuses are imported with their values at the time
of export.

Dependent tables are not transported or converted.

Define Asset Classes

In this step. You define the asset classes. The asset class is the most important criteria for structuring fixed
assets from an accounting point of view. Every asset has to be assigned to exactly one asset class. The
asset class is used to assign the assets (and their business transactions) to the correct general ledger
accounts. Several asset classes can use the same account assignment. You can see that it is possible to
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make finer distinctions at the level of the asset class than at the level of the general ledger accounts. The
most important tasks of the asset classes are:
- the assignment of default values when creating assets (particularly depreciation terms)

- the grouping of assets for reporting purposes

You define the asset classes in the system in a series of steps. The asset class is structured in three parts:
- control parameters

- default values for general master data

- default values for depreciation terms in the chart of depreciation

You can assign depreciation terms to an asset class for any number of charts of depreciation. This
makes it possible to manage an asset class catalogue that is valid for an entire corporate group,
independent of the country-specific charts of depreciation.

In this step, you define the asset classes and their control parameters. In further steps, you add further to
the asset classes by supplying default values for certain logical field groups in the asset master record.

Note

Structuring assets for accounting is not dependent on the technically oriented structuring in the PM (Plant
Maintenance) component. PM has its own terms for classification (functional location, equipment) that
are based on the requirements of plant maintenance. You can set up a relationship between the PM and
FI-AA components by entering the asset number in the master record of the related piece of equipment.

In this way, you can select all pieces of equipment that belong to an asset.

Recommendation

The number of asset classes needed varies greatly, depending on the size of your organization. In many
cases, the number 50 is usually appropriate. Generally, you should at least group together assets with the
same depreciation terms into an asset class. In any case, it must be possible to clearly assign new assets to
an asset class when they are entered in the system.

Defining the asset classes is fundamental to SAP Asset Accounting. Therefore, you should carry out this
step with considerable care and attention.

Requirements

- You must have created a chart of depreciation.

- You must have defined number ranges for assigning the main asset number.

Standard settings
SAP supplies predefined asset classes as examples (1-8).
Activity

1. Inthe overview screen, enter the key of the asset class, a short text and a description of the asset class.

2. Then maintain the control parameters in the detail screen. The following specifications are very
important:
- account determination
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- Screen layout control (define the screen layout control in the step Master data).
- number range for the assignment of the asset main number

- assignment of sub-numbers - (internal or external )

Further notes

SAP library FI-AA: Organizational Elements -> Asset Classification

Specify Chart-of-Dep.-Dependent Screen Layout/Acct Assignment

Generally, the control specifications (the screen layout and the account determination) for the asset class
applies throughout the client, that is, for all charts of depreciation. It is therefore sufficient to make control
specifications once per asset class.

You only need to carry out this step, if, contrary to the usual case, you want these control specifications to
be country-specific (that is, different depending on the chart of depreciation). The system then uses the
entries you make here depending on the chart of depreciation in the given company code. The system then
ignores the control specifications in the asset class that are independent of the chart of depreciation.

Standard settings

The asset classes supplied with the standard system do not have control specifications that are specific to
the chart of depreciation.

Recommendation

In most cases, you do not need entries that are specific to the chart of depreciation.
Activities

Enter your chart-of-depreciation-specific control specifications in the asset class, if needed.
Further notes

SAP library FI-AA: Organizational Elements -> Function of the Asset Class.
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Country-Specific Functions

Russia

Maintain Asset Types

Use

In this IMG activity, you assign each asset class to an asset type.

The asset type is used as a selection criterion in the Russian Asset Accounting reports. In addition, the
asset types Capital Investment and Assets under Construction are used to automatically track
invoices for APC (see the SAP Library documentation listed below).

Note

The SAP reports and programs only use the information in the Asset Class and Asset Type
fields. You can use the other fields for your own purposes.

See also

SAP Library -> SAP ERP Central Component -> Financials -> Country Versions -> Europe and Africa

-> Russia -> Financial Accounting (FI) -> Asset Accounting (FI-AA) -> Business Transactions ->
Automatic Tracking of Invoices for APC

Integration with General Ledger Accounting

The system settings and entries you make in this section are required for the integration of Asset
Accounting with the General Ledger:

Depreciation areas that post depreciation/APC automatically to the General Ledger

G/L accounts that are relevant for Asset Accounting (reconciliation accounts and accounts that are
posted using batch input)

Screen layout controls for G/L accounts
Default input tax indicator for transactions not subject to tax

Specifications for periodic posting of depreciation to the General Ledger
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Define How Depreciation Areas Post to General Ledger

In this step, you specify the depreciation areas that post their APC transactions and/or depreciation to the
general ledger.

The system can post the APC transactions of one depreciation area to the general ledger online
automatically. Usually this is the book depreciation area 01. You can post transactions from other
depreciation areas to the general ledger automatically using periodic processing. (The exception to this
rule are the depreciation areas for investment support shown on the liabilities side, which can also post
online.) You always have to use periodic processing to post depreciation to the general ledger.

Standard settings

The standard depreciation areas in the SAP reference chart of depreciation are set up so that book
depreciation area 01 posts APC transactions automatically to the general ledger online. It posts
depreciation automatically to the general ledger (using batch). The definitions of other depreciation areas
depend on your country-specific chart of depreciation.

Recommendation

It is usually sufficient to have automatic posting of APC transactions and depreciation from the book
depreciation area. There could be other circumstances under which you might need automatic posting to
the general ledger from other depreciation areas:

- You might need to post cost-accounting interest (that differs from book depreciation) to certain
expense accounts or cost elements.

- You might have special requirements for the balance sheet, such as showing special reserves.

- You might have special requirements for legal consolidation of your corporate group.
Activities

Specify how (if) your depreciation areas should post to the general ledger:

- no values

- APC transactions online and depreciation in periodic processing

- APC transactions in periodic processing and depreciation in periodic processing

- only depreciation in periodic processing
Further notes

SAP library FI-AA: Periodic Processing
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Assign G/L Accounts

In this step, you specify the balance sheet accounts, special reserve accounts, and the depreciation accounts
for Asset Accounting.
Note

If you enter accounts for gain/loss for a special depreciation area, the system does not post revenue from
the write-off of special reserves. Instead, when there is revenue from write-off of special reserves due to
an asset sale, the system includes this amount in the gain/loss. The system then balances the book
depreciation area loss by a posting to an offsetting account, and posts the sum/difference between the
revenue from the write-off of the special reserve and the book depreciation area loss to these accounts.

There are restrictions on the screen layout of accounts that will be posted using collective posting. There
cannot be any required fields that are not supplied with values by the batch input posting run.

Example:

A posting text cannot be a required entry for value adjustment accounts, since the depreciation posting
program does not create any posting texts.

Further notes

SAP Library FI-AA: Integration with the General Ledger -> Account Determination

Specify Posting Key for Asset Posting

In this activity you define posting keys which are used for automatic postings when posting to fixed asset
accounts.

Recommendation

Use the standard SAP posting keys.
Activities
1.  Check the standard default values for
- Asset postings and

- GJL account postings which are posted to Asset Accounting

2. Change the standard default values if necessary.

Note

You can currently only use the "Asset Accounting additional accounts” function for intercompany asset
transfers.
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Change the Field Status Variant of the Asset G/L Accounts

In the FI General Ledger system, you can control which fields are contained in the entry screens of
Posting transactions. You can also specify whether these fields are required entry fields (setting the field
status). You need to make specifications of this type if you plan to use integrated posting of asset
retirements (posted with customer). You must make sure that the indicator "asset retirement" and the field
"asset" are defined as available for input.

The field status is controlled by two settings:

- You can assign a field status variant to each company code. In the field status variant, you specify the
status that certain fields should have in certain account groups (field status groups). You define the
account groups yourself.

You assign the G/L accounts to field status groups in the master records of the G/L accounts.

- In addition, you can define the field status as dependent on the posting key used for the given posting.

Standard settings

The field status variant 0001 is entered for company code 0001 in the SAP standard system. Field status
groups are already defined for this field status variant. The standard field status groups and company codes
for asset accounts and asset posting allow additional account assignment to orders and WBS elements.

Note

When you carry out the basic customizing for the FI system (Financial Accounting Global Settings), you
assign a field status variant. Therefore, you should not change the assignment of the field status variant in
this step. Instead, you should only display the field status variant.

Activities

1.  Check the field status variant that is used in your company code.

2. Specify that the field status group "asset accounts” allow the field "asset retirement” and "asset
number" as allowed entries (group: Asset Accounting) in the field status variant.

3. Specify for the posting key for asset retirements that the indicator "asset retirement" and the field
"asset" are defined as available for input.

Assign Input Tax Indicator for Non-Taxable Acquisitions

In this step, you specify an input tax indicator per company code. The system then uses this indicator when
you post acquisitions that are not subject to tax, but which are posted to accounts that are tax-relevant.

Example

An acquisition of this type is an acquisition from in-house production. In the Asset Accounting posting
transaction for this acquisition, the input tax indicator is not ready for input.
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Activities

In each company code, enter a tax indicator for business transactions that are not subject to taxes (for
example, V0).

Specify Financial Statement Version for Asset Reports

In this step, you determine, per depreciation area, which financial statement version the system is to use as
a default. This default applies when the financial statement version is contained in the sort version used
for a given report.

Example

For instance, you may want to assign a different financial statement version to the tax depreciation area
than you assign to the book depreciation area.

Standard settings

In the standard system, the financial statement version INT is assigned to all company codes/depreciation
areas.

Activities

Determine the financial statement version for each company code/depreciation area.

Post Depreciation to General Ledger Accounting

Asset depreciation is a two-step process in the system.
1. First, the system determines the planned depreciation values for the fiscal year for each asset.

2. Posting these values to the expense accounts in Financial Accounting is carried out using batch input.
You have to initiate this batch input posting. It is one of the periodic processes in the system.

Define the posting rules and the document type for depreciation posting run in this step. In addition, you
can specify a weighting of the depreciation amounts here. Using this method, you can distribute
depreciation in varying amounts over the periods in a fiscal year, rather than uniformly. You specify that
this weighting should take place when you use particular fiscal year versions.

Further notes

SAP library FI-AA: Integration with the General Ledger -> System Settings for Posting Depreciation
Specify Document Type for Posting of Depreciation

In this processing step you determine the document type for each company code for posting depreciation.

Standard settings
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SAP supplies document type AF for depreciation posting.

Requirements
You must have defined the document number ranges.
Activities

1.  Check the standard document type AF. If needed, define your own document type.

2. Specify the document type for depreciation posting. The document type you select must meet the
following conditions:

- It must be a document type for batch input.

- It must be defined with external document number assignment.

Document Type for Cross-Company Code Cost Accounting in External CoCode

Use

In this activity, you set up the document type that you want to use for posting depreciation in the target
company code when you use cross-company-code cost accounting.

Requirements

You have to have entered the internal transaction type for depreciation posting:
Determine Transaction Types for Internal Transactions.

This IMG activity is only necessary if you use cross-company-code cost accounting.

Specify Intervals and Posting Rules

In this step, you define the posting rules for the depreciation areas that post depreciation values to Financial
Accounting. You define the posting cycle (how often depreciation is posted) and the account assignment
rules for the depreciation posting run.

Requirements

You must have specified which depreciation areas should post automatically to the general ledger.

Standard settings
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SAP supplies country-specific reference charts of accounts. These charts of accounts contain predefined
depreciation areas.

Activities

1. Specify how often the posting runs are to be carried out.
Example (meaning of the entry when there are 12 posting periods):
1 = monthly posting
3 = quarterly posting
6 = semi-annual posting
12 = annual posting
Note

You can also change the posting cycle when the system is productive. In order to do this, you only
have to change the number before the next scheduled posting run.

2.  Specify whether you want additional account assignment to cost centres or orders. The system then
posts account assignment of the order or WBS elements in the given master record. If you specify
both CO account assignments (order and project) for the depreciation posting program, and both an
order and a WBS element are entered in the asset master record, the system makes account assignment
only to the order (no double CO account assignment).

Note that the following is required for the account assignment to CO: the field status variant of the
company code must allow additional account assignment to orders and/or cost centres for the revenue
accounts involved (also see: Change Field Status Variants of the Asset Accounts).

3. For depreciation areas that handle interest, specify if you want to post this interest to the general
ledger.

4.  For depreciation areas that post depreciation to the general ledger, specify whether the system should
use the catch-up method or smoothing.

Country-Specific Functions
Russia

Permit Negative Posting

Use

In this Customizing activity, you permit negative posting for the chart of depreciation and depreciation
area.

This allows that when you post a correction to a previously posted depreciation, the relevant line items in
the generated accounting document contain negative posting marks as required by law.

Requirements

To activate negative posting, you also have to permit negative posting for:

- Company code
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In the Customizing activity Enter Global Parameters, select the Negative Postings Permitted
checkbox for the relevant company code.

- Accounting document type for depreciation posting

In the Customizing activity Define Document Types, select the Negative Postings Permitted
checkbox for the relevant document type.

BAdI: Depreciation Posting Lines

Use

This Business Add-In (BAdI) is used in the Financial Accounting (FI) component.

By default, all line items are grouped into one document. Accounts Offsetting Russia can#t process such
documents.

You can use this BAdI to allow the RAPOST 2000 program to activate splitting to the several FI-documents
of depreciation posting.

Standard settings

In the standard system, activated BAdI implementation is delivered for countries Russia, Ukraine and
Kazakhstan. The BAdI is designed for single use.

Activities

For information about implementing BAdIs as part of the Enhancement Concept, see SAP Library for SAP
NetWeaver under BAdIs - Embedding in the Enhancement Framework.

Example
See also:

This BAdI uses the interface IF_EXFIAA_RAPOST2000_MAX_LINES. For more information, display
the interface in the Class Builder.

NIXONTAGMAN@GMAIL.COM | Asset Accounting



Segment Reporting

Activate Segment Reporting

Use

In this activity, you activate segment reporting for Asset Accounting.
In this way, you achieve the following:

- The Profit Centre and Segment fields are included in the asset master record.

Initially, these fields are empty (and consequently inconsistent). In the activity Fill Master Data for
Segment Reporting, you fill the asset master data with the relevant values (see Other Activities
below).

- In Customizing for Asset Accounting under Integration with General Ledger Accounting ->

Additional Account Assignment Objects -> Activate Account Assignment Objects, the system
automatically sets the following indicators for profit centre and segment:

- Activation of Account Assignment Object
- Acct Assignment Object Same in Asset Master and Posting

- In Customizing for Asset Accounting under Integration with General Ledger Accounting ->

Additional Account Assignment Objects -> Specify Account Assignment Types for Account
Assignment Objects, you enter the account assignment types for the account assignment objects
Profit Centre and Segment.

- In Customizing for Asset Accounting under Preparing for Production Start-up -> Authorization
Management -> Process Asset Views, the system automatically enters the standard authorizations
for the master record fields Profit Centre and Segment.

- When the asset master data is being posted and maintained, the system checks whether the asset master
records have been maintained consistently. It must be possible to derive the profit centre and the
segment uniquely from the CO account assignments and from the asset master records. Exception: If
investment measures are concerned, the profit centre can be derived from the investment measure
specified in the asset master record in the origin data. In such cases, the derived profit centre of the
cost objects stored in the asset master record does not have to match the profit centre from the
investment measure in the origin data. In the system, you may have to convert the relevant error
messages into warning messages.

Caution: In Customizing for Asset Accounting in the activity Activate Account Assignment

Obijects, you must have set the Acct Assignment Object Same in Asset Master and Posting
indicator. By doing this, you ensure the consistency of the asset master record with regard to the
profit centre. As long as an asset master record is not consistent, it is not possible to post to the
asset.

- You can perform reporting at the profit centre and segment levels. In General Ledger accounting, you
can create an aggregated report on changes in tangible assets at the profit centre and segment levels.

Caution:
Once you have activated segment reporting for Asset Accounting, you cannot deactivate it.

Note:

Before you can use the Reorganization of Fixed Assets, you need to have activated segment reporting
for Asset Accounting. Furthermore, you need to have performed the activities listed under Other Activities
below.
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Requirements
Before you can activate segment reporting for Asset Accounting, the following prerequisites need to be
fulfilled:

- Youuse new General Ledger Accounting (FI-GL (New)) and Asset Accounting (FI-AA) in your
production system.

- In the Financial Accounting Global Settings (New) under Assign Scenarios and Customer Fields
to Ledgers, you have assigned the following scenarios to the relevant ledger:

- Profit Centre Update,
- Segment Reporting, and

- Segment Reporting for Fixed Assets or alternatively Preparations for Consolidation (if already
set up).
You have to use one of these two scenarios because you need the consolidation transaction
type for segment reporting.

Activities

Set the indicator for activating segment reporting and save your entry.
Other Activities:
Before you can actually use segment reporting, you need to perform the following additional activities:

1. Activate the account assignment objects Profit Centre and Segment in Customizing for Asset
Accounting under Activate Account Assignment Objects.

2. If you already use Asset Accounting in your production system, fill the existing asset master data in
Customizing for Asset Accounting under Fill Master Data for Segment Reporting. You can combine
this activity with individual or mass changes to master data.

3. Maintain the Profit Centre and Segment fields in the screen layout rules of the asset master records
in Customizing for Asset Accounting under Define Screen Layout for Asset Master Data (Logical
Field Groups -> Time-Dependent Data).

4. Maintain the Profit Centre and Segment fields in the screen layout rules of the posting keys and
G/L accounts that are relevant for Asset Accounting (in customizing for Asset Accounting under
Change the Field Status Variant of the Asset G/L Accounts).

5. If you want to use the aggregated report on changes in tangible fixed assets in new General Ledger
Accounting, you need to do the following:

a) Assign the consolidation transaction types to the asset transaction types in Customizing for
Asset Accounting under Specify Consolidation Transaction Types for APC Transactions.

b) If you have previously not ever updated the Consolidation Transaction Type field (RMVCT),
go to Customizing for Asset Accounting and perform the activity Fill Consolidation
Transaction Type for Segment Reports in GL Accounting.
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¢) For the Consolidation Transaction Type field, check the screen layout rules of the posting
keys and G/L accounts that are relevant for Asset Accounting. You do this in Customizing for
Asset Accounting under Change the Field Status Variant of the Asset G/L Accounts.

d) In the aggregated report on changes in tangible asserts, adjust the column and row structure.
The relevant transaction types are assigned in the columns and the accounts are assigned in the
rows. Where applicable, use the sets contained in the standard delivery:

- FAGL CONS_ TRANSACTION for the columns
- FAGL ASSET HISTORY SHEET for the rows

To define sets, you can use the activity Define Sets in Customizing for General Ledger
Accounting (New).

Fill Master Data for Segment Reporting

Use

In this activity, you can fill the Profit Centre and Segment fields in existing asset master data. For this,
the system selects all active fixed assets with a CO object in their master data. It checks whether data can
be derived consistently.

Exception: If investment measures are concerned, the profit centre can be derived from the investment
measure specified in the asset master record in the origin data. In such cases, the derived profit centre of
the cost objects stored in the asset master record does not have to match the profit centre from the
investment measure in the origin data. In the system, you may have to convert the relevant error messages
into warning messages.

Alternatively, you can edit the master data using a single change or a mass change. However, we
recommend that you carry out this activity because a consistency check is not carried out when you make
mass changes.

If you nevertheless want to use mass maintenance, we recommend doing so in combination with this
activity (see below).

Requirements

You have made the following settings in Customizing:
- You have activated segment reporting in Customizing for Asset Accounting with the activity
Activate Segment Reporting.

The prerequisites stipulated there need to be met.

- You have activated the account assignment objects Profit Centre and Segment in Customizing for
Asset Accounting in the activity Activate Account Assignment Objects.

Standard settings

You can perform this activity in a test run or an update run:
- In a test run, the system lists all fixed assets corresponding to your selection criteria as follows:

- Highlighted in green: Fixed assets to which the system can uniquely assign a profit centre and a
segment
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Highlighted in red: Fixed assets to which the system cannot uniquely assign a profit centre and a
segment

In a test run, you can navigate to the relevant asset master record by double-clicking it.

In an update run, the system assigns a profit centre and a segment to fixed assets wherever a unique
assignment can be made. In cases where a unique assignment cannot be made, the system issues an
error message.

You can run the program multiple times in update mode.

You have the following options for assigning the correct profit centres and segments to the fixed assets:

You can use an update run to automatically assign a profit centre and a segment to the selected fixed
assets wherever a unigque assignment can be made.

You can maintain fixed assets individually and then use this Customizing activity to carry out checks.

You can maintain fixed assets in mass maintenance and then use this activity to carry out checks.

Activities

On the selection screen, enter the selection criteria for restricting the number of fixed assets. Make a
selection that does not have a negative effect on performance.

Execute the program as a test run first.

To reassign profit centres and segments or correct assignments, use individual or mass maintenance
for fixed assets. When doing so, ensure that the current or future validity period has been defined.

If necessary, repeat both of the previous steps.
Run the program in an update run so that the automatic assignments are made.

If necessary, repeat the steps above for fixed assets without assignments.

Fill Consolidation Transaction Type for Segment Reports in GL Accounting

Use

You need to perform this activity in the following circumstances:

In new General Ledger Accounting, you want to create an aggregated report on changes in tangible
assets.

For this, you need the consolidation transaction type. The consolidation transaction type is part of
the scenarios Preparations for Consolidation and Segment Reporting for Fixed Assets.
However, you have not previously assigned either of these scenarios to your ledger.

In this activity, you ensure that the asset portfolios (balance sheet accounts for APC as well as value
adjustment accounts) produce a complete, cumulated opening balance after balance carry forward in the
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following year. For each company code and ledger, you assign a consolidation transaction type to any
asset portfolios that did not previously have one.

You use this activity to select the account balances corresponding to the selection criteria specified. No
data is updated at the time of the selection. Only once the list has been compiled (based on the selection
criteria) can you post the entire amount to the consolidation transaction types for the opening balance.

Requirements

Before you can perform this activity, the following prerequisites must be met:

1.  The prerequisites listed in the Implementation Guide for Asset Accounting under Activate Segment
Reporting have been met.

2. You have activated segment reporting.

3. You have performed the additional relevant activities listed in the Implementation Guide for Asset
Accounting under Activate Segment Reporting.

Standard settings

The program always selects the balance carry forward data for the year matching that of the system date.
Activities

We recommend the following procedure:
1. Atthe change in fiscal year, perform balance carry forward.

2. Inthis activity, start the program for determining the consolidation transaction type.

Using the system date, the program selects the balance carry forward values that were posted without
a consolidation transaction type and proposes them for correction.

3. Start the adjustment postings.

The system makes the adjustment postings using the system date (where system date = posting date).
Additional Account Assignment Objects

Activate Account Assignment Objects

In this step, you make settings for additional account assignment objects (for example, cost centre,
investment order) during posting in Asset Accounting.

Requirements

For the posting transactions to the General Ledger, you have to make sure that the account assignment
objects you want to use are available for input, using the field status of posting keys 70 and 75 (debit asset
and credit asset). You make this setting under the step Integration with the General Ledger -> Change the
Field Status Variant of the Asset G/L Accounts.

Activities
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1. Activate the account assignment objects you need for Asset Accounting.

2. Specify whether the account assignment object is relevant to the balance sheet. Account assignment
objects that are relevant to the balance sheet can no longer be changed directly in the asset master
record once the asset has been capitalized. Instead, such assets have to be transferred to a new asset
master record to make this change.

3. Specify whether the account assignment object you enter when posting has to agree with the account
assignment object entered in the asset master record. If you set this indicator, you cannot change the
account assignment object when posting.

Example

GBER (Fund)

Active: YES
Bal.sheet: YES
Agree: NO

Result: The account assignment object Fund
- Is active (available for input) in the asset master record
- Can no longer be changed in the asset master record once the asset is capitalized

- Can be changed during posting, in other words, you do not necessarily have to use the account
assignment object that is entered in the asset master record Note:

For the cost centre account assignment object, it is not possible to deactivate the Agree indicator,
since the cost centre always has to agree with the cost centre in the asset master record. This prevents
you from entering a different cost centre during later account assignment processes.

Further notes

Note that the account assignments objects you want to use have to be defined as available for input in the
Screen Layout of the asset master record.

Specify Account Assignment Types for Account Assignment Objects

The possible account assignment types for account assignment objects are: APC balance sheet posting or
account assignment of depreciation. In this step, you assign account assignment types to the account
assignment objects. These assignments are dependent on

- Company code
- Depreciation area
- Transaction type

If you want to assign both account assignment types to an account assignment object, you have to make at
least two table entries for the account assignment object.

You can make a generic entry, using an asterisk (*), for the transaction type. The system then uses the
account assignment type you entered for all transaction types for that account assignment object (in the
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company code and depreciation area). SAP also supplies a generic company code and two generic
depreciation areas (see below).

Program logic

If you use both generic transaction types and "normal” transaction types in the table, the system gives
priority to the non-generic entries before generic entries. The system also gives priority to the non-generic
company code over the non-generic transaction type. This applies especially to deactivate account
assignment types.

Example

The entries below have been entered in the Customizing table for an account assignment object. The system
determines the account assignment type by checking the entries in sequence from top to bottom, until it
finds a suitable record.

- CoCd 0001, Area 20, Trans. type 100
- CoCd 0001, Area 20, Trans. type *

- CoCd* , Area00, Trans. type 100

- CoCd* , Area00, Trans. type *

Standard settings

SAP provides one generic company code (*) and two generic depreciation areas (00 and 01). The settings
for depreciation area 00 are valid for all depreciation areas other than 01. The settings for generic
depreciation area 01 are valid in all company codes for depreciation area 01.

Activities

Make your settings for the account assignment type in the account assignment object in the following order:
1. First for the generic company code and the generic transaction type

2. Then for the generic company code and non-generic transaction types

3. Then for non-generic company codes and the generic transaction type

4.  Last for non-generic company codes and non-generic transaction types

Activate the account assignment types you need. You do not have to delete those you do not need. You
can just deactivate them, and activate them later if you need them.

Process Error Table

You only need to carry out this step if you have set the agreement indicator for account assignment objects.
If this indicator is set, then the account assignment object at posting has to be the same as the one entered
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in the asset master record. You make this setting for each account assignment object in the Activate
Account Assignment Objects step.

The settings you make here in this step do not apply to account assignment objects, for which no agreement
is required between the asset master record and postings.

In this step, you specify which error message the system outputs when the account assignment object
entered during posting is different from the one entered in the asset master record. The system issues the
message and makes account assignment to the account assignment object entered in the asset master record.
The account assignment object entered in the posting is ignored.

The following settings are possible:
- No message

- Information message

- Warning

- Error message

Recommendation

If, when activating the account assignment objects, you specified that the account assignment objects
Have to be identical to the account assignment object in the asset master record, then you should choose
the "warning" setting.

Display of Active Account Assignment Objects

The program lists all active account assignment objects for the

Selection criteria you enter. This list includes the entries that belong to the generic company code and
depreciation areas (but not the generic transaction type). The report is displayed using an SAP List Viewer
table.

Requirements

You have activated account assignment objects for Asset Accounting.
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Post APC Values Periodically to General Ledger Accounting

Maintain Posting Rules for Parallel Accounting Principles
(OBSOLETE)

Note

This IMG activity is obsolete. Here you can only change or delete Customizing entries.
Instead of using this activity, you can now use the Define Depreciation Areas IMG
activity for entering the parameters needed for parallel posting. SAP recommends that
you check the settings here in this activity and copy them manually to the Define
Depreciation Areas activity. At actual runtime, the system performs enough checks on
how much the old and new settings might overlap.

Use

Parallel valuation is represented in Asset Accounting using different depreciation areas. In certain cases,
you want this parallel valuation to be visible not only on the fixed asset, but also on accounts in Financial
Accounting, or, by using different accounting principles, in a special ledger. If this is the case, you can use
this IMG activity to specify in Asset Accounting which depreciation areas post to which Financial
Accounting accounts, as well as the accounting principle on which posting of the values of the area is to
be based.

Periodic posting normally takes place in the company code of the asset master record. The majority of asset
transactions are grouped together and posted as totals according to the account assignment objects in
Financial Accounting.

In this IMG activity, you can make settings that differ from the norm stated above. You can specify that
postings to Financial Accounting are made to a company code that differs from the company code of the
fixed asset. Or you can specify that values are updated to a special ledger rather than to the general ledger.
For the second of these two, you have to enter an accounting principle, which is in turn assigned to the
special ledger. In addition, you can have the system post asset transactions singly, by changing areas that
normally post periodically to direct posting.

Recommendation

If you want to post to an alternative company code, do not choose a real company code. Instead you should
set up a company code for the technical purposes of representing differences due to different valuations,
such as the difference between US GAAP and the German commercial code.

Posting of single documents per depreciation area is not recommended, if you already have a large number
of asset documents due to the size of your fixed asset holdings. If you specify in this IMG activity that
posting of single documents should be used, you have to expect a greatly increased volume of documents
in Financial Accounting. When you choose Post direct, the system generates a document in Financial
Accounting or in the special ledger for each APC transaction and each depreciation area that is posted
directly for each asset master record.

To set up posting of single documents (‘direct posting’) of a depreciation area that posts periodically,
proceed as follows:

- In this IMG activity (possibly in the 'Maintain Enhanced Posting Rules' sub-activity), maintain all
parameters as best suits your needs, but do not set the 'Post Direct' indicator.
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- Start the periodic posting run RAPERB2000 (transaction ASKBN) in test mode for a few posted
assets. During the test run, the system performs all checks that it carries out in an update run or for
direct posting. Examine the log and correct any errors that occurred.

- Once the test run is completed successfully, set the 'Post Direct' indicator for the depreciation area.
Perform some test postings. If any errors occur now, these are logged in the application log. To access
these entries, use transaction ARAL with the selection criteria: Object = FIAA and Sub object = 006.
In RAPERB2000, you can check at any time which line items were posted successfully in direct
mode.

Note

- When you use an accounting principle, then reconciliation between asset accounting and the general
ledger is only possible on a limited basis.

- By setting the Treat Derived Depreciation Area as Real Area indicator, you can have the system post
real APC differences in this depreciation area. Keep in mind that if you choose this option, then you
have to maintain asset APC accounts for the asset instead of the special reserves accounts.

- The alternative depreciation area is used for determining the accounts that are used when posting
values to an alternative company code. Usually this will be depreciation area 01, if you copied the
account set of the original company code to the alternative company code. Note that you have to reset
the reconciliation account indicator of all accounts in the target company code.

Assign G/L Accounts

In this step, you specify the balance sheet accounts, special reserve accounts, and the depreciation accounts
for Asset Accounting.

Note

If you enter accounts for gain/loss for a special depreciation area, the system does not post revenue from
the write-off of special reserves. Instead, when there is revenue from write-off of special reserves due to
an asset sale, the system includes this amount in the gain/loss. The system then balances the book
depreciation area loss by a posting to an offsetting account, and posts the sum/difference between the
revenue from the write-off of the special reserve and the book depreciation area loss to these accounts.

There are restrictions on the screen layout of accounts that will be posted using collective posting. There
cannot be any required fields that are not supplied with values by the batch input posting run.

Example:

A posting text cannot be a required entry for value adjustment accounts, since the depreciation posting
program does not create any posting texts.

Further notes

SAP Library FI-AA: Integration with the General Ledger -> Account Determination

NIXONTAGMAN@GMAIL.COM | Asset Accounting “




Reset Reconciliation Accounts

In this step, you can redefine the reconciliation accounts in Asset Accounting as ordinary accounts that can
be posted. This resetting of the indicator "Reconciliation account” in the account master record data,
however, is only possible in company codes which are still in test status. This step is not required during
normal system installation. Changing the reconciliation accounts can be necessary, however, for the
following reasons:

- You entered an incorrect account in an account assignment in Asset Accounting and then performed
the ""Set reconciliation accounts" step.

- Balance corrections have to be posted to reconciliation accounts retroactively.

- You copied the account definitions of an asset accounting company code to a different company code.
The second company code does not have active asset accounting, but is used for parallel accounting
principles. Now you want to reset all reconciliation accounts for this second company code.

Caution

Keep in mind that after you reset the indicator, the affected G/L accounts can be directly posted again. As
a result, consistency between the sub ledger and general ledger balances is no longer ensured.

Actions

1. Choose the company code you want to edit.

2. Reset the "reconciliation account” indicator for certain accounts.
OR

3.  Reset the "reconciliation account" indicator for all displayed accounts by choosing Delete
Reconciliation Ind. for All Accts.

Specify Document Type for Periodic Posting of Asset Values

Use

In this IMG activity, you specify a default document type for periodic posting of asset balance sheet values
(values other than depreciation). This document type is used only by the periodic posting program,

RAPERB2000.

Requirements

You have to have created a document type already.

Notes

If you have activated the function for direct posting for depreciation areas that post periodically, then
directly posted documents are posted using the document type that is also used in the master depreciation
area. Only those documents that are posted later using the periodic posting program are posted using the
document type entered here. In order to be able to find all documents - both those directly posted and those
generated by the periodic report - select using transaction ASKBN when you make a document search.
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Valuation

In this section, you make all configurations that have to do with the valuation of fixed assets. The following
basic functions are available in the FI-AA component for the valuation of assets:

- You can define country-specific charts of depreciation. You can define and manage all valuation and
depreciation parameters in the chart of depreciation. In each chart of depreciation, you can calculate
asset values in parallel for different purposes using depreciation areas. You can have any number of
depreciation areas for different requirements (such as, the balance sheet or cost accounting needs).

- You can modify the periods in the FI fiscal year to meet the needs of depreciation calculation.

- The calculation rules for depreciating assets are defined using flexible keys. You can change and add
to the keys that SAP supplies in order to reflect new methods of valuation (without needing
programming skills).

- There are special functions for the valuation of assets for special purposes (see Special Valuation).

Set Chart of Depreciation

You only need to carry out the following step if you have created more than one chart of depreciation.
Some of the definitions in the following Customizing steps depend on the chart of depreciation you want
to work with. If you have recently created several charts of depreciation (NOT standard charts of
depreciation), you therefore need to specify the chart of depreciation you want to configure. The work you
do in the system after this point will affect that chart of depreciation. The system therefore determines the
chart of depreciation that you are working on according to the following logic:

- If you have created only one chart of depreciation, the system automatically uses this chart.

- If you have created more than one chart of depreciation, the system asks you to identify the chart of
depreciation affected the first time you call up a function that affects the chart of depreciation. The
chart of depreciation you select at this point remains active during your log-on, unless you specifically
enter a new chart of depreciation. If you had set one chart of depreciation, and now want to work with
a new one, you set the new chart of depreciation in this processing step.

Another possibility is to specify a chart of depreciation as a user parameter (parameter ID: AFP). This
specification then remains in the system from one log-on to another.

Requirements

You must have created at least one chart of depreciation of your own.
Activities

Choose one of the charts of depreciation offered.

Note
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Status management is not possible here.

Depreciation Areas

When you create a chart of depreciation, the SAP system takes over the depreciation areas from the
reference chart of depreciation in the new chart of depreciation. In addition to the depreciation areas taken
over from the reference chart of depreciation, you can also create your own depreciation areas (for
example, for parallel valuation). You need to copy an existing depreciation area in order to create your
own depreciation area.

You define the characteristics of your depreciation areas in this step. It is important to specify the
relationships between the depreciation areas in regard to posting values and depreciation terms.

Note

It is also possible to create new depreciation areas when the system is in productive use. However, this is
only possible by limiting the determination of values in the new depreciation area. Therefore, we
recommend that you define all the depreciation areas you need during the system configuration. For
example, if it is possible to foresee that you might need an additional depreciation area for managing a
different currency, you should define this area during the system configuration and manage it for your
assets.

Define Depreciation Areas

In this step, you define your depreciation areas. You can change the definition of depreciation areas adopted
from the standard chart of depreciation, and you can add new depreciation areas if needed.

For parallel financial reporting (that is, valuation based on different accounting principles) you can define
real depreciation areas and derived depreciation areas. The values in the derived depreciation area are
calculated from the values of two or more real areas, using a formula you define. The system does not store
the values from the derived depreciation area. Instead they are determined dynamically at the time of a
request. Otherwise you can use the same system functions for derived depreciation areas as real
depreciation areas. Most important, they can be evaluated in the same way, and posted to the general ledger
(for example, for showing special reserves).

Requirements

You have added at least one chart of depreciation of your own in the Copy Reference Chart of
Depreciation/Depreciation Areas IMG activity.

Standard settings

The country-specific charts of depreciation (such as OUS for the United States, ODE for Germany) contain
standard charts of depreciation, for example for:

- Book depreciation
- Tax depreciation

- Cost-accounting depreciation
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- Special reserves

- Investment support

These standard depreciation areas provide a reference. From the point of view of SAP, this reference meets
all requirements for accounting and legal considerations. You always have to copy one of the standard
depreciation areas in order to create a new depreciation area. Therefore, you should delete standard
depreciation areas only after careful consideration. It is usually better to avoid deleting them, and instead
set unneeded standard depreciation areas to inactive in the asset class (in the Determine Depreciation Areas
in the Asset Class IMG activity).

Activities

1. Check the definition of the depreciation areas that were created by reference to a standard chart of
depreciation (in the detail screen).

2. If necessary, define new depreciation areas by copying an already existing depreciation area.

3. Specify the characteristics of your depreciation area in the detail screen:

Procedure for Setting up Online Posting and Periodic Posting

Management of Values Group Box:

a)

Specify the type of value management that is allowed for the different types of valuation (such
as, acquisition and production costs (APC), depreciation, interest).

You must allow APC and positive net book values in all areas in which you want to depreciate

capitalized asset values (the usual case). Allow negative net book values in depreciation areas that
depreciate below zero, and in areas for managing value adjustments posted on the liabilities side
(special reserves). The second of these also are not allowed to manage APC or positive net book
values. Define Depreciation Areas Group Box:

b)

Specify if the APC values/depreciation of the area should be posted (APC values:
Online/periodic/direct).

The system can only automatically post asset balance sheet values from one depreciation area
online (with the exception of retirement transactions). Generally, this area is the book
depreciation area. Other areas (for special reserves or cost accounting depreciation) can be
posted automatically to the general ledger using background processing (application menu:
Periodic Processing), when the Post to G/L Account indicator is set). Depreciation can only be
posted during periodic processing.

There is also direct posting, a different approach than automatic online posting to the general
ledger. With this approach, the values are also posted relatively quickly, as with online posting.
Any documents that could not be updated in direct mode due to technical problems have to be
posted at a later date during periodic posting (in the application menu: Periodic Processing).
Also keep in mind that direct posting considerably increases the document volume as compared
to periodic posting, which creates collective documents.

You can choose either a new account set in the general ledger or a parallel general ledger as
The target for posting. If you choose a parallel general ledger, then you can post using the
account set of a different depreciation area if you enter that different depreciation area here.

(Usually you choose the master depreciation area here.)
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In the Assign G/L Accounts IMG activity, you can enter all reconciliation accounts and
offsetting accounts for reconciliation for all depreciation areas that post to the general ledger. Entries
for Derived Depreciation Area Group Box:

c) If you need depreciation areas that derive their values from other depreciation areas, you can
define derived depreciation areas (for example, for special reserves). For this purpose, enter the
depreciation areas that are to form the basis for its values. Enter whether the values from these
areas should be included as positive or negative values in the formula. Make sure that the Real
Depreciation Area indicator is not set.

The effect of setting the Derived Depreciation Area as Real Area indicator is that APC
differences are posted in this depreciation area, rather than the special reserves procedure being
used. Make sure that, in this case, you enter the asset balance sheet accounts for the depreciation
area, rather than the special reserves accounts.

A derived depreciation area can be for reporting only (that is, its values are not posted). In this
case, you can specify that the system does not perform a value check for this derived area
(indicator: Area for reporting purposes only).
4. In the Specify area type action, check the standard classification of the depreciation areas. The
depreciation areas in the standard chart of depreciation all have a type. When you create a chart of
depreciation, the system takes over these types from the referenced standard chart of depreciation.
For example, the type of depreciation area 01 is Valuation for trade balance sheet.
The area type is especially important in the following case:
If you are also using the Investment Management (IM) component, the depreciation area with
type 07 (cost accounting valuation) has special importance. At the present time, you cannot
transfer capitalization differences as no operating expense to this depreciation area. This
limitation is required in order to make sure that all non-capitalized debits on a capital investment
measure are accounted for in Controlling.

Procedure for Setting up Direct Posting

To set up direct posting (single posting) in a periodically posting depreciation area, follow this procedure:

4.  Make all settings for the depreciation area as described above. In the Posting in G/L field (automatic
posting indicator), enter 2 (Area Posts APC and Depreciation on Periodic Basis) or 5 (Area Posts
APC Only).

5. Start the periodic posting run for APC values, RAPERB2000 (transaction ASKBN), in test mode for
a few posted assets. During this test run, the system performs all checks that it would also perform in
update mode or during direct posting. Analyse the log and correct any errors that occurred.

6. Once the test run was completed successfully, then activate direct posting for the depreciation area.
In the Posting in G/L field (automatic posting indicator), enter 4 (Area Posts APC Only) or 6 (Area
Posts Only APC Directly).

7. Make several test postings. If errors still occur, these are recorded in the application log. You can
navigate to these entries using transaction ARAL. In the Object field, enter FIAA and in the Sub
object field enter 006 and run the report. In the posting run for APC values, RAPERB2000, you can
check in the log at any time to see which line items were posted successfully in direct posting mode.

Notes on Deleting a Depreciation Area
You can also delete depreciation areas. The area you want to delete must meet the following requirements:
- It cannot be the master depreciation area (01).

- The area cannot be a reference area for another area (for APC values or depreciation terms).
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- The area cannot be used in the calculation formula for a derived depreciation area. In this case, you
need to change the calculation formula for the derived depreciation area.

- The area cannot be defined for automatic posting of APC values to the general ledger.

- If the depreciation area is one used for investment support, then you first have to delete all investment
support keys that reference this depreciation area.

The system then deletes the selected depreciation area in the chart of depreciation and in the valuation
specifications for all affected assets and asset classes.

Specify Transfer of APC Values

The standard system copies the asset balance sheet values from depreciation area 01 to all other
depreciation areas during posting. (The only exceptions to this rule are areas for revaluation and for
investment support, as well as derived depreciation areas.) Therefore, you only need to carry out this step
if you want to copy posting values from a different depreciation area, not depreciation area 01.

In this step, you define transfer rules for the posting values of depreciation areas. These transfer rules let
you ensure that certain depreciation areas have identical asset values.

Example

Depreciation areas for showing asset values in a foreign currency have to use the same values as a basis as
the local currency. You therefore define the foreign currency depreciation areas for mandatory transfer of
posting values from depreciation area 01 (book depreciation).

Requirements

You have to have created at least one chart of depreciation of your own.

Standard settings

The standard depreciation areas of the country-specific standard charts of depreciation are defined with the
normally required transfer rules.
Activities

1. For the dependent depreciation areas, specify the depreciation area from which the posting values are
to be transferred.

2. Determine whether this transfer is mandatory or optional.
If you define optional transfer, you can enter the posting values for that depreciation area during
posting.

Further notes

SAP Library FI-AA: Transactions -> Updating Values in the Depreciation Area
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Specify Transfer of Depreciation Terms

In this step, you define transfer rules for the depreciation terms of the depreciation areas. Using these
transfer rules, you can determine that depreciation areas copy the depreciation terms from other areas.
(Optional or mandatory takeover). You then do not have to/cannot maintain depreciation terms for the
copying depreciation areas in the asset master record. In this way, you can ensure that certain depreciation
areas are uniformly depreciated.

Example

Depreciation areas which should show the local asset valuation in a foreign currency must be defined so
that they are depreciated uniformly to the book depreciation area, the only difference being the currency.

Requirements

You must have created at least one chart of depreciation of your own.

Standard settings

The standard depreciation areas of the country-specific standard chart of depreciation are defined with
corresponding transfer rules.

Activities

1.  Specify the depreciation area from which the depreciation terms should be copied for the dependent
depreciation areas.

2. Determine whether this copying is mandatory or optional.

If you specify optional copying, then the proposed depreciation terms in the dependent areas can be
changed in the asset master record.

Set up Areas for Parallel Valuation

Use

Use this activity, if you want to set up parallel valuation (for example, for IAS) in a parallel new general
ledger. You can also make the settings for the area manually, rather than using the wizard.

Requirements

The master depreciation area for local valuation and the real depreciation for accepting the values for
parallel valuation have to be defined already.

Standard settings

SAP does not provide any standard settings here.

Activities
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Assign the master depreciation area and the real depreciation area for parallel valuation each to a ledger
group. The ledger group of the master depreciation area has to contain the leading ledger. The ledger group
of the area for parallel valuation is not allowed to contain the leading ledger. Updating values to CO is
possible only for values of the leading ledger, but not for values of the parallel ledger.

The system automatically creates a derived depreciation area that is used for updating the APC differences
in the ledger group of parallel valuation. Or you could use an existing derived depreciation area. Posting
control in the derived depreciation area is set so that you can post either "APC only" or "only APC directly,”
while the real depreciation area for parallel valuation posts only depreciation.

Both areas use the accounts of the master depreciation area. You do not need to adjust the account
determination. If the accounts of the master depreciation area are entered as cost elements, then this also
applies to parallel valuation, although there is no update to CO in this general ledger. Here you might have
to make appropriate settings in CO Customizing.

Example

The master depreciation area 01 valuates according to your local accounting principles, whereas
depreciation area 30 uses valuation according to 1AS. You now create a new depreciation area 32 that
contains the difference between area 30 and area 01. Using area 32, you post the APC differences to the
ledger group that is to be used for 1AS valuation. Area 30 posts depreciation to the same ledger group.

Landerspezifische Einstellungen

CIS
Define Fiscal Period Length for Base Value Calculation

Use

In this IMG activity you can define the length of the fiscal period for depreciation calculation. The base
value for depreciation calculation is determined at the beginning of each fiscal period. The standard settings
only allow you to calculate depreciation on a yearly base. This IMG activity allows you to modify this
setting.

Example

SAP recommends the following settings for the country versions below:

Russia

ChDepAr. Month FP
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1RU 10 1
In this case the length of the fiscal period for depreciation calculation is 1 month.

Ukraine

ChDepAr. Month FP

1UA 10 3
In this case the length of the fiscal period for depreciation calculation is 3 months (a quarter).

Kazakhstan

ChDepArr. Month FP

1KZ 10 1

Determine Depreciation Areas in the Asset Class

Generally, the assets in an asset class use the same depreciation terms (depreciation key, useful life).
Therefore, you do not have to maintain the depreciation terms in the asset master record. Instead, they can
be default values from the asset class.

In this step, you determine the depreciation terms that are to be used in your asset classes. Depending on
the definition in the screen layout control used, these depreciation terms are offered either as optional or
mandatory defaults when you create an asset.

For each asset class, you can maintain as many charts of depreciation with their depreciation areas as you
need. This allows you to use the asset class in all countries belonging to the client.

Requirements

You must have created asset classes.

Standard settings

SAP provides predefined asset classes (1-8).
Activities

1.  Select a chart of depreciation.
2. Enter the asset class you want to maintain.
3. Set the depreciation areas to inactive that are not needed in this asset class.

4. In the area specifications of your asset class, enter depreciation key, useful life, and screen layout
rule. You can define screen layout rules for the area specifications in the step Define master data.

Remember, there is a detail screen for each depreciation area.
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Note

Changes to the asset class only affect assets that are created after the change is made. For assets that
already existed in the system, and are affected by the changes made at the asset class level, you have to
use mass change procedures (see the System Administration Guide: Master Data Maintenance and
Reorganization). When changes are made to depreciation terms, the system automatically recalculates
depreciation for the assets concerned.

Deactivate Asset Class for Chart of Depreciation

Use

In this step, you can lock asset classes for entire charts of depreciation. In this way, you can prevent an
asset class from being used inadvertently in a chart of depreciation for which it is not intended.

Standard settings

No limitations of asset classes on charts of depreciation.
Amount Specifications (Company Code/Depreciation Area)

In the following step, make the following entries for the calculation of depreciation and/or net book value
per company code/depreciation area:

- rules for rounding
- memo value

- changeover amount

Specify Max. Amount for Low-Value Assets + Asset Classes

In this step, you determine the maximum amount for low-value assets (LVAS). You enter a maximum
amount per company code or per depreciation area. The system checks this maximum amount during every
acquisition posting, providing the corresponding LV A indicator is set in the asset class.

Requirements

You must have made the necessary entries for company codes for Asset Accounting.

Standard settings

SAP supplies low-value asset maximum amounts for most countries.
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The standard asset classes provided by SAP include one asset class for low-value assets managed
collectively and one asset class for low-value assets managed individually.

Activities

1. Enter a maximum amount for each company code/depreciation area
- for acquisition postings

- for purchase orders (maximum LVA amount)

The maximum LVA amount for purchase orders will generally be a little higher than that for
acquisition postings, since the value of ordered goods may possibly be reduced by a cash discount.

2. Specify how you want the system to carry out the LVA maximum amount check for the asset class.
Should the check be?

- a quantity check (when low-value assets are managed collectively on a single asset master
record)

- individual check (when low-value assets are managed individually)

During a quantity check, the system determines if the value of the collective low-value asset divided
by the quantity entered in the asset exceeds the LVA maximum amount for the company code or
depreciation area.

Further notes

SAP library FI-AA: Organizational Elements -> Asset Types

Specify Rounding of Net Book Value and/or Depreciation

In this step, you define rounding specifications for net book values at the end of the year, and for
automatically determined depreciation. These specifications are for each depreciation area and company
code.

It is only possible to round decimal places.

Standard settings
The standard system rounds net book values to whole currency units by means of depreciation.
Activities

1. Determine the depreciation areas in which net book values or depreciation, and/or replacement values
are to be rounded to whole currency units.

2. Determine whether the system should always round up, round down, or round up or down to the
nearest whole number (up to 9 - down, over up).
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Specify Changeover Amount

In this step, you enter the amount at which the system should change the calculation of depreciation to the
changeover key specified in the depreciation key. You enter the amount per depreciation area. The
changeover takes place as soon as the net book value of the asset goes below the changeover amount.

This changeover only takes place if you are using a depreciation key defined with changeover method 3
(changeover as soon as the remaining value is less than the changeover amount). This changeover amount
is ignored by other changeover methods.

Requirements

- You must have created a chart of depreciation.

- You must have defined your company codes for Asset Accounting.

Standard settings

In the standard system, the changeover amount is not recognized.
Activities
Specify a changeover amount, if needed, for each company code/depreciation area.

Further notes

SAP library FI-AA: Fixed Asset Depreciation -> Changeover Key

Specify Memo Value

In this step, you define a memo value for each depreciation area/ company code. This memo value is the
amount that is not depreciated, in order to have a memo posting for an asset, which has already exceeded
its useful life. The system reduces the planned annual depreciation in the acquisition year for the asset by
the amount of the memo value.

You can activate or deactivate the memo value by means of an indicator in the asset class, although it has
been defined on depreciation area/company code level (this is applies especially to asset classes for low
value assets).

Recommendation

The memo value function is provided in the system in order to allow for managing memo values from a
previous system in FI-AA. When you specify a memo value, it is mandatory that all of the affected assets
have a book value at least equal to the memo value at all times. Generally, you do not need to manage
memo values. The system always considers gross values (that is, acquisition values and value adjustments),
and not just remaining book value. This fact ensures that fully depreciated assets with a book value of zero
are also shown in all legally required reports.
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Requirements

You must have worked through the Asset Accounting requirements of the Company code.

Standard settings

The standard SAP depreciation areas do not take memo values into consideration.
Activities

1. Enter a memo value in the definitions of the depreciation areas concerned.

2. Specify the asset classes, for which this memo value should not apply (such as, asset classes for low
value assets).

Fiscal Year

In this section, you make entries for the fiscal year in Asset Accounting. In particular, you can define the
FI (General Ledger) fiscal year with different periods for calculating depreciation in Asset Accounting.

Further notes

SAP library FI-AA: Calculation of Asset Values (General) -> Fiscal Years and Periods for Asset
Accounting

Fiscal Year Variants

The fiscal year variant defines the number and relation to the calendar of the depreciation periods in the
fiscal year in Asset Accounting. Asset Accounting generally uses the same fiscal year variant as Financial
Accounting (general ledger). In that case, the depreciation periods of Asset Accounting correspond to the
posting periods of Financial Accounting (without special periods). The system therefore automatically
defaults the fiscal year variant of FI-GL when you define the FI-AA system settings for a company code.
You do not need to make any system settings in this section if your depreciation periods and G/L posting
periods are identical.

In some cases, however, the G/L posting periods are not suitable for determining depreciation in Asset
Accounting. In that case, you need FI-AA-specific fiscal year variants.

You can specify your own fiscal year variant in the following implementation activities
- In the FI-AA definition of the company code

- Below the company code for each FI-AA depreciation area

Note

You cannot define fiscal year variants in this step. You enter the actual definitions of the fiscal year variants
and their relationship to the calendar in the general section of FI Customizing.
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Caution

- However, a different fiscal year variant can only be used in Asset Accounting if the start and end
dates of the variants in Asset Accounting and Financial Accounting are the same. This also applies to
depreciation areas that do not post automatically to the general ledger (when you have fiscal year
variants that are specifically for given depreciation areas).

- You can only change the fiscal year variant in Asset Accounting as long as the company code does
not have production status.

Example

If a fiscal year variant with 13 (normal) posting periods is used in the general ledger, then you normally
Need a different fiscal year variant to represent a number of FI-AA period controls (for example, first-year
convention). The reason is that the depreciation calculation only works with full periods, but the middle of
the year in this example is 6 posting periods.

Specify Other Versions on Company Code Level

In this step, you specify a fiscal year version for Asset Accounting on company code level that is different
from the one in FI General Ledger.

Recommendation

Usually you do not need a different fiscal year version for Asset Accounting. If this is the case, you do not
need to make any system settings here.

Requirements
You must have already defined the needed fiscal year version.
Standard settings

The company codes delivered in the standard system do not use an FI-AA-specific fiscal year version.
They use the fiscal year version of the FI general ledger.

Activities

Enter an appropriate fiscal year version for the company codes that are to use a fiscal year version that is
different from the one in the general ledger.
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Specify Other Versions on Depreciation Area Level

In this step, you specify a fiscal year variant for Asset Accounting on depreciation area level that is different
to the one for the FI General Ledger.

Example

You would like to work with 13 normal periods (plant calendar) for book depreciation, and 12 periods for
tax depreciation, because you need half periods (see Using Half Periods). In this case, it is possible to use
a different fiscal year version in the tax depreciation area than in the book depreciation area.

Recommendation

Usually you do not need a different fiscal year variant for Asset Accounting. In that case, you do not need
to make any system settings here.
Requirements

You must have already defined an appropriate fiscal year variant.

Standard settings

The depreciation areas in the standard system do not use an FI-AA-specific fiscal year variant. They use
the fiscal year variant of the FI General Ledger.

Activities

Enter an appropriate fiscal year variant in the depreciation areas that are to use a different fiscal year variant
from the general ledger.

Shortened Fiscal Years

In this section, you define the system settings for shortened fiscal years.

You do not need to define any system settings here unless one of the following applies to your enterprise:
You are currently using a shortened fiscal year, or you have used a shortened fiscal year in the past, for
which you want the SAP system to recalculate depreciation within the framework of the asset data transfer.

Further notes

SAP library FI-AA: Calculation of Asset Values (General) -> Fiscal Years and Periods for Asset
Accounting

Define Reduction Rules for Shortened Fiscal Years

In a shortened fiscal year, it is generally necessary to reduce depreciation in proportion to the reduction in
the length of the fiscal year. In this step, you can therefore determine for each depreciation area and
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depreciation type (ordinary depreciation, special depreciation and so on) whether the system should reduce
the planned annual depreciation values accordingly, or whether the complete annual depreciation should
be calculated.

Requirements

You must have defined your company codes for Asset Accounting.

Standard settings

The company codes provided in the standard system do not work with a shortened fiscal year.
Activities

Determine the depreciation reduction rules for the shortened fiscal year.

Maintain Depreciation Key

You only need to carry out the following step if you use special reduction rules in your depreciation keys.

In some circumstances, legal requirements make it necessary to have unreduced depreciation at all times,
even during a shortened fiscal year, when using certain depreciation methods (for example, fixed
percentage rate per year). Therefore, you can use an indicator in the depreciation key to specify that the
depreciation with these keys remains unreduced despite a reduction rule on company code level.

Standard settings

The depreciation keys provided in the standard system reduce the depreciation in shortened fiscal years in
accordance with the setting on company code/depreciation area level.

Activities

For certain depreciation keys, specify that depreciation is not reduced for a shortened fiscal year (despite
the possible existence of other system settings on company code/depreciation area level). Make this
specification by setting the "no reduction in short year" indicator in the definition of the depreciation key.

Use of Half Months in the Company Code

In this step, you determine the company codes in which you want to use half periods. In this way, you can
calculate depreciation in these company codes on the basis of half months or half periods. Using this
method, you can work with 24 periods in Asset Accounting, although the fiscal year version in Financial
Accounting has only 12 normal periods (without using a different fiscal year version for Asset
Accounting).

You should be aware, however, that the specifications for periods in the transactions in Asset Accounting
(such as, useful life) have to be based on whole periods (12).
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Example

Half periods are, for example, necessary to represent the "mid quarter/month rule”. This is a version widely
used in the U.S.A. With this rule, it is important for the determination of depreciation whether an
acquisition takes place in the first or the second half of a period.

Caution

- When you specify the use of half periods in the definition of an asset company code, half periods are
automatically specified in all other company codes that use this fiscal year version.
- You cannot use half periods with non-calendar fiscal months.

- You cannot take back the use of half periods once the specification has been made. It is noted
internally by the system in the asset master records.

Requirements

The number of the posting periods in the fiscal year version used must correspond to the number of calendar
months (12).

Activities

1. Specify the use of half periods by entering the date (for example, the th) for the middle of the period
for the company codes.

2. If you have defined period controls yourself (see Period Control), you must provide for the use of
half periods in their assignment rules. For monthly and quarterly periods, corresponding period
controls have already been created as standard in the system.

Define Weighting of Periods

In this step, you define the weighting of the distribution of the planned annual depreciation to the individual
periods in the fiscal year. You can enter a relative weight for each fiscal year version and each fiscal year.
The posting period receives a depreciation amount based on its relative weight in relation to the total of all
the weights. This makes it possible to distribute according to the number of days or weeks per period. The
weighted distribution affects the periodic posting of depreciation, as well as the determination of
proportional value adjustments for retirements and transfers.

Recommendation

Generally, it is not necessary to distribute annual depreciation in weighted form to the individual posting
periods in a fiscal year. In most cases, it is sufficient to distribute annual depreciation uniformly to the
individual periods. You do not need to do anything in this step in that instance. However, there is
sometimes depreciation legislation which requires you to post the planned annual depreciation weighted
differently to different periods (for example, for the 4-4-5 rule).

Standard settings

In the standard system, annual depreciation is distributed uniformly to the individual periods in the fiscal
year (that is, the system calculates the same depreciation amount for each period.)
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Activities
Weight the individual fiscal year periods according to the portion of annual depreciation that should be
posted in them. For each entry, make the following specifications:
- fiscal year version

- fiscal year, up to which the entry should be valid (for example, 9999)
- posting period

- relative weight of the posting period

Currencies

In this section, you define system settings which allow

- the valuation of fixed assets on the level of Asset Accounting in separate depreciation areas with
foreign currencies

- management of parallel currencies at the general ledger level from the point of view of assets

Further notes

SAP library FI-AA: Calculation of Asset Values (General) -> Company Code-Related Features

Define Depreciation Areas for Foreign Currencies

Depreciation areas can be managed in any currency in the FI-AA module. The values from these areas can
then be used for group consolidation, or for other analyses.

In this step, you define depreciation areas that manage asset values in a foreign currency, per company
code. For acquisitions, the translation into the foreign currency takes place at the exchange rate current on
the posting date (for more information, see the Implementation Guide: Global Settings). The daily
exchange rate is maintained in the productive system in the FI module (general ledger) under (Current
settings). Depreciation and proportional value adjustments for asset retirements are calculated directly in
the foreign currency.

Example

For example, it may be necessary to manage depreciation areas in the currency of the corporate group for
legal consolidation. It is also advisable to set up separate depreciation areas in the group currency for the
historical management of values. This is particularly recommended when the valuation of assets at the
group level is different from the local valuation.

Note
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The component FI-LC (Legal Consolidation) provides special functions for group consolidation. In
addition to the decentralized historical translation of currency described here, this component offers many
other options for conversion. For more information, see "Preparations for Consolidation" in the SAP
library.

Requirements

You must have carried out the step Create chart of depreciation.
Standard settings

In the country-specific reference chart of depreciation, SAP supplies depreciation areas for legal
consolidation in a foreign currency.

Activities

1. Select a company code.

2. Assign a foreign currency to your selected depreciation areas.

You cannot change the currency in the master area (01). It always has to be the same as the local
currency of the respective company code.

Specify the Use of Parallel Currencies

For the legal consolidation of your fixed assets, you might only need foreign currency amounts, but not
need to use a different basis for valuation (APC/depreciation terms) than is used in the local currency. In
this case, you can use the following FI general ledger function:

The Financial Accounting (FI) component provides you with the option to manage all the values of a
company code in up to three currencies on the same accounts in parallel. You can define three local
currencies for every company code for this in FI Customizing. A local currency is defined by the following
specifications:

- Currency type in accordance with the function of the currency (for example group currency)
- Type of exchange rate for the conversion

- Base currency for the conversion and

- Date (for example document date) for the conversion

Even the values that are posted within Asset Accounting can be updated in several currencies and in the
same FI document in parallel with the posted amount in local currency in financial accounting. For this,
you need to manage a depreciation area with the following features for each currency:

- Currency type and currency of the depreciation area are identical to the corresponding parallel
currency in the company code in question.

- The depreciation area must manage depreciation terms and acquisition values identical to the book
depreciation area.

The system then automatically supplies the corresponding posting documents with the additional values
from these depreciation areas. The areas in the foreign currency do not need to be explicitly posted to the
general ledger (according to the posting settings in the definition of the depreciation area).

WHATSAPP +255738656506



[BECOME A MASTER OF SAP S/4 FINANCIAL ACCOUNTING
{8 CUSTOMIZING]

Note

The system also supports parallel currencies in depreciation areas that do not post online, but which are
posted during periodic posting to the general ledger.

When you use parallel currencies to show group valuation and profit centre valuation, you should
Consider the following:

The key that is used in Asset Accounting for the parallel currencies is made up of the combination of the
keys for currency type and valuation view that are entered in FI under "Define Additional Local
Currencies."

Example

You defined the following additional local currency in FI:

Currency type 30 (group valuation), valuation type 2 (profit centre valuation). If you want to enter this
currency in Asset Accounting as a parallel currency for a depreciation area, do not enter 30 as the key.
Instead choose key 32 (sum of keys for currency type and valuation type).

Requirements

You must have defined your depreciation areas Defining depreciation areas.

Standard settings

The depreciation areas delivered in the standard system do not support any parallel currencies in the general
ledger.

Activities

Assign a currency type to the depreciation areas that corresponds to the given parallel currency.

Group Assets

As a general rule, the system calculates depreciation at the level of individual assets. Certain types of
calculation needs or tax requirements (such as in the U.S.A.) make it necessary, however, to calculate
depreciation at a higher level. For this purpose, you can group assets in the FI-AA system together into
so-called group assets. You can group assets together per depreciation area to form group assets.

You make the necessary system settings for group assets in the following step.

Further notes

SAP library FI-AA: Master Data -> Group Assets
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Specify Depreciation Areas for Group Assets

In this step, you determine the depreciation areas that you also want to manage on group asset level. In
these depreciation areas, it is then possible to make an assignment to a group asset. You make this
assignment in the specifications for the depreciation area in the asset master record. When you post an
acquisition to this kind of asset, the system duplicates the line items from this depreciation area on the
given group asset.

Standard settings

In the standard system, no depreciation areas are provided for managing values on group asset level.
Requirements

You must have created at least one chart of depreciation of your own.
Activities

Indicate the depreciation areas for which values are to be managed not only on the level of the individual
assets but also summarized according to group asset.

Specify Asset Classes for Group Assets

It is basically possible to use all asset classes for creating group assets. However, under certain
circumstances, you need to set aside particular asset classes for use in conjunction with group assets. These
asset classes are then reserved solely for group assets, and are not allowed to be used for normal assets.

Requirements

You must have created asset classes.
Standard settings

SAP does not supply asset classes to be used solely for group assets.
Activities

Determine the asset classes that you want to reserve exclusively for group assets.

Depreciation

In the following section, you make system settings for fixed asset depreciation.
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Ordinary Depreciation

In this section, you define system settings for determining and posting ordinary depreciation.

Determine Depreciation Areas

In this step, you determine the depreciation areas in which you want to manage ordinary depreciation. This
specification means that this value type is allowed in the depreciation area (that is, the system does not
issue an error message when you enter corresponding depreciation terms in the asset master record).

In the detail screen for each area, you can also determine which sign (+ or -) the ordinary depreciation is
allowed to have in the respective area.

Example

If, for example, you want to calculate the negative depreciation of positive APC (this is the normal
procedure) in an area, you must set the indicator "Negative values (incl. zero)". The system then ensures
that only negative depreciation amounts are allowed in this area.

Requirements
You must have created at least one chart of depreciation of your own.
Standard settings

The country-specific charts of depreciation (for example OUS for the U.S.) contain fully defined standard
depreciation areas.

Activities

Set the indicator "management of ordinary depreciation™ in the affected depreciation areas.

Assign Accounts

Use

In this activity, you specify the G/L accounts for ordinary depreciation.

Note
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The screen layout of accounts that are posted using mass posting are not allowed to require entries in fields
that are not provided with values during background processing.

Example:

The value adjustment accounts cannot require the mandatory entry of a posting text, since the
Depreciation posting program does not create a posting text.

Define Unit-of-Production Depreciation

To use the unit-of-production method of depreciation, you enter a total number of units for an asset and
(for each depreciation posting period) the actual quantity produced. You make these entries for the
depreciation key defined for unit-of-production depreciation. The system determines the amount of
depreciation based on these two values and the APC or the net book value. A depreciation key is based on
units of production if its base method uses a unit-of-production depreciation calculation method (either
"No. of units/Total no. of units" or "No. of units/remaining units").

In this section, you specify the number of units for the depreciation keys for unit-of-production
depreciation.

Note

During the transfer of legacy data, you have the option of having the system recalculate accumulated past
depreciation. If you use this option and also use depreciation keys for unit-of-production depreciation, you
have to enter the numbers of units for the time period beginning with the acquisition date of the oldest
asset, up to the time of the legacy data transfer.

Requirements

You must have defined Depreciation keys for unit-of-production depreciation (that is, either "No. of
units/Total no. of units” or "No. of units/remaining units" as the depreciation calculation method in the
base method used).

Caution

When you define a depreciation key for unit-of-production depreciation, be aware of the following: If you
use a base method that uses the "No. of units/remaining units" depreciation calculation method, you have
to use base value 27 (net book value with proportional value adjustments).

Standard settings

SAP supplies an appropriate depreciation key (STCK) as an example. This depreciation key uses a base
method with unit-of-production depreciation.

Activities

Define the unit specifications for your depreciation keys for unit-of-production depreciation:

- Total number of units with which the assets are to be depreciated
The total number of units can be changed in any period. The new total number of units then applies
for depreciation calculation starting with the period that was changed.
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- Number of units which was depreciated (output) in the individual periods
Further notes

SAP library FI-AA: Fixed Asset Depreciation -> Unit-of-Production Depreciation

Special Depreciation

In this section, you define system settings for determining and posting special depreciation.

Determine Depreciation Areas

In this step, you determine the depreciation areas in which you want to manage special depreciation. This
specification means that this value type is allowed in the depreciation area (that is, the system does not
issue an error message when you enter corresponding depreciation terms in the asset master record).

Requirements
You must have created at least one chart of depreciation of your own.

Standard settings

The country-specific charts of depreciation (for example OUS for the USA) contain fully defined standard
depreciation areas.

Activities

Set the indicator "Management of special depreciation™ in the depreciation areas for special depreciation.

Calculate Ordinary Depreciation before Special Depreciation

The system distinguishes the following types of depreciation:
- ordinary depreciation

- special depreciation

unplanned depreciation
- transferred reserves

The order in which the system determines the different types of depreciation is somewhat flexible. The
transfer of reserves is always determined first, and unplanned depreciation is always determined last.
However, you can decide the order in which ordinary depreciation and special depreciation should be
determined. In this step, you specify, per depreciation area, that the system should determine special
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depreciation before ordinary depreciation. The sequence in which depreciation is determined would then
be as follows:
1. transferred reserves

2. special depreciation
3. ordinary depreciation
4. unplanned depreciation

The rules for the remaining book value in this depreciation area (or in a derived depreciation area based on
this area) may require a reduction in depreciation. If this is the case, depreciation is reduced in exactly the
reverse order:

5. unpanned depreciation
6. ordinary depreciation
7. special depreciation

8. transferred reserves

Standard settings

In the standard system, ordinary depreciation is calculated before special depreciation. If a reduction in
depreciation is necessary, it takes place in reverse order.

Activities

Check the standard settings.

Assign Accounts

Use

In this activity, you specify the G/L accounts for special depreciation.

Note

The screen layout of accounts that are posted using mass posting are not allowed to require entries in fields
that are not provided with values during background processing.

Example:

The value adjustment accounts cannot require the mandatory entry of a posting text, since the depreciation
posting program does not create a posting text.
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Unplanned Depreciation

In this section, you define system settings for the manual planning of unplanned depreciation.

Determine Depreciation Areas

In this step, you determine the depreciation areas in which you want to manage unplanned depreciation.
This specification means that this value type is allowed in these depreciation areas (that is, the system does
not issue an error message when you enter the corresponding depreciation terms in the asset master record).

Requirements

You must have created at least one chart of depreciation of your own.

Standard settings

The country-specific charts of depreciation (for example OUS for the USA) contain fully defined standard
depreciation areas.

Activities

Set the indicator "management of unplanned depreciation" in the depreciation areas in question.

Assign Accounts

Use

In this activity, you specify the G/L accounts for unplanned depreciation.

Define Transaction Types for Unplanned Depreciation

Manual corrections to values, such as
- unplanned depreciation

- other manually planned depreciation (ordinary or special depreciation) and
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- write-ups

Are made by posting in Asset Accounting. In this step, you define the transaction types for the manual
value corrections. In addition, you can specify that certain transaction types propose only certain
depreciation areas for posting. The system then generates a popup window showing the depreciation that
can be posted in the posting transaction. If you want to specify that all depreciation areas should always
be posted, you do not need to carry out this step. The popup window then does not appear in the posting
transaction.

Transaction types classify the varying business transactions in Asset Accounting. Every transaction type
is assigned to a specific transaction type group. The transaction type groups are fixed in the system, and
cannot be expanded (or changed) by the user. You have to enter a transaction type for every posting
transaction that involves Asset Accounting. The posting transaction is controlled by the features of the
transaction type, and the respective transaction type group.

Requirements

You must have defined your own chart of depreciation.

Standard settings

SAP provides transaction types for manual depreciation.

Recommendation

You should use the standard transaction types. You do not have to do anything else here in that case.
However, if the scenario below applies to you, it may be necessary for you to define your own transaction
types:

You need transaction types

that only post to certain depreciation areas in your chart of depreciation and

There are no corresponding standard transaction types that have the limitations you need.
Activities

1. Create new transaction types according to your requirements. When you create the three-letter key
for the transaction type, use the letter X, Y or Z somewhere in the key. Using one of these letters (at
any position in the key) will prevent your key from being overwritten by future SAP updates.

2. Define the characteristics of the new transaction types in the detail screen.

3. Limit your transaction types, if necessary, to certain depreciation areas.
If you do not make any selections, then all depreciation areas will be posted at all times.

Further notes
Valuation Methods

Depreciation calculation in the FI-AA system is not hard-coded, but is instead based on a flexible method
of using keys to define the calculation. Therefore, it is possible to represent many different depreciation
terms using correspondingly defined calculation keys and calculation methods.

Calculation keys and calculation methods for the most common types of depreciation are supplied in the
system.
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In the following section, you define your own calculation keys and calculation methods for the automatic
calculation of depreciation.

Depreciation Key

Depreciation keys contain the calculation methods for depreciation calculation and parameters that control
- Ordinary depreciation

- Special depreciation

- Scrap value (cut-off value)

- Calculation of interest

You can enter a separate depreciation key for each depreciation area in the asset master record.

Requirements

You must have already created a chart of depreciation.
Standard settings
SAP supplies the country-specific depreciation keys required in each country, for example:

LINR = Straight-line depreciation from net book value to zero

DG30 = Declining-balance, 3 times straight-line rate
Activities
Define additional depreciation keys to meet your requirements.

Additional hints

SAP Library FI-AA: Depreciation -> Definition of the Depreciation Key
Further notes (Transport)

You can include the depreciation key in a transport request (Key -> Transport in the overview screen of
the transaction). Note that the definition of the depreciation key only applies in one client. Therefore,
transport is not only necessary between systems (such as, from a test system to a productive system), but
also in order to make the depreciation key available in other clients.

Calculation Methods

In this step, you define calculation methods that are assigned to a depreciation key.
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Chart-of-depreciation-independent calculation methods:
- Base methods

Chart-of-depreciation-dependent calculation methods:

- Declining-balance methods

- Maximum amount methods

- Multi-level methods

- Period control methods

Note

When you are maintaining chart-of-depreciation-dependent calculation methods, you get a display of the
existing calculation methods in accordance with the chart of depreciation that has been set.

Define Base Methods

In this step, you maintain base methods. Base methods are valid in all charts of depreciation. You assign
base methods to depreciation keys.

Recommendation
Normally the base methods supplied by SAP are sufficient.
Activities

1. Enter atechnical name and a description for the base method.

2. Maintain the base method. It is particularly important to enter a depreciation type and the depreciation
calculation method.

Define Declining-Balance Methods

In this step, you define declining-balance methods. You then assign them to depreciation keys.

Standard settings

SAP supplies commonly-used calculation methods.

Activities
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1.  Maintain declining-balance methods and their descriptions.

2. For each declining-balance method, specify:
- A multiplication factor for determining the depreciation percentage rate
- Anupper limit for the depreciation percentage rate

- Alower limit for the depreciation percentage rate

Further notes

SAP Library FI-AA: Depreciation -> Depreciation Methods -> Declining-Balance Method of Depreciation

Define Maximum Amount Methods

In this step, you define maximum amount methods. You then assign them to depreciation keys.

The calculation method contains a maximum depreciation amount that is not allowed to be exceeded before
a certain calendar date. If the depreciation calculated by the system exceeds this maximum amount, then
the system reduces depreciation to this maximum amount.

You can specify how the maximum amount applies within the time period specified for it. It can either
apply to each individual year in the specified time period, or to accumulated depreciation.

Activities
1. Maintain the maximum amount methods and their descriptions. Also specify if the maximum
Amount applies to annual depreciation or to accumulated depreciation.
2. For each maximum amount method, specify the:
- Maximum amount

- Currency for this amount

Date up to which the maximum amount is valid
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Define Multi-Level Methods

In this step, you define multi-level methods. You then assign them to depreciation keys. Each level
represents a validity period for a given percentage rate.

Activities
1. Maintain the multi-level methods and their descriptions.
2.  Enter the characteristics of the multi-level methods.

Further notes

SAP Library FI-AA:
- Depreciation -> Depreciation Methods -> Declining Multi-Phase Depreciation

- Depreciation -> Calculation Methods -> Multi-Level Method

Maintain Period Control Methods

In this step, you maintain period control methods. You then assign them to depreciation keys.

Example

Using period control methods, you can specify that the depreciation start date for all acquisitions in the
year is set to the first day of the period.

Requirements

You must have already maintained the period controls.
Activities

1. Maintain the period control methods and their descriptions.
2. Assign period control keys to the period control methods for:

- Acquisition transactions - Subsequent acquisitions

- Retirements and transfers

- And so on

Further notes
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SAP Library FI-AA: Depreciation -> Calculation Methods -> Period Control Method.

Default Values

In this step, you maintain default values for depreciation keys:
- Atthe level of company codes and depreciation areas

- Atthe company code level

Propose Values for Depreciation Areas and Company Codes

In this step, you enter default values that are then valid for certain company codes and depreciation areas.
In this way, you can configure depreciation keys so that the system uses a different interest key or a special
treatment of the end of depreciation, for example, in certain specific company codes and depreciation areas.

The system uses these default values only if you explicitly set "default values™ in the base method or in the
depreciation key.

The system uses this default interest key if there is no interest method entered in the depreciation key.
(This applies only to depreciation areas that manage interest.)

Example

If you want the system to recognize the default values that were entered here for the treatment of the end
of depreciation, then you have to set "default value from company code and depreciation area" in the base
method for the appropriate fields.

Activities

Maintain the company-code-specific and depreciation-area-specific parameters according to your
requirements.

Propose Acquisition Only in Capitalization Year for Company Codes

In this step, you set as a default for certain company codes that acquisitions in this company code are only
allowed in the year in which depreciation started. This setting may be necessary for technical reasons, for
example, if you use sum-of-the-years-digits depreciation. It is also possible to use this function for
organizational purposes.

The system takes this indicator into account for company codes only if you chose "default value from
company code" in the depreciation key under "acquisition allowed only in capitalization year."
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Activities

Set the indicator for the company codes for which you need this function.

Maintain Depreciation Key

In this step, you maintain depreciation keys by assigning calculation methods to them. You can divide the
duration of depreciation into several phases. When you enter a changeover method for one of these phases,
the system changes over to the next phase as soon as the event specified in the changeover method has
occurred. The system then uses the depreciation calculation that is specified in the calculation method for
this phase.

Activities

1. Maintain additional depreciation keys and their descriptions in accordance with your requirements.
2. Assign calculation methods to the depreciation keys. Maintain any other necessary parameters.

3.  Set the status of the depreciation keys to "active".

Further notes

Depreciation keys

SAP Library FI-AA: Depreciation -> Definition of the Depreciation Key

Period Control

In this step, you define the time periods that are to be used for determining the start and end of depreciation
for acquisitions and retirements (period control)...

Note

SAP provides the most commonly used period controls (such as the first year convention). In general, you
do not need to make any settings in this step.

Further notes

SAP library FI-AA: Fixed Asset Depreciation -> Period Control

Maintain Period Control

The system determines the start or end of depreciation based on the asset value date of a transaction (of the
acquisition or retirement) using the period control. The period control is therefore an important part of the
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depreciation key. You can enter a separate period control for each period control method of the depreciation
key for the following transaction types:

Acquisitions
Subsequent acquisitions in later years
Retirements

Transfers

In this step you can define new rules if the standard period controls are not sufficient for your installation.
You define the calendar assignment for newly defined or copied period controls in a further step.

Standard settings

SAP supplies the most commonly used period controls:

Pro rata at the start of the period

The depreciation start/end date is always set to the beginning of the period in which the asset value
date for the acquisition/retirement lies.

Pro rata at the start of the period, up to the middle of the period

The depreciation start/end date is set to the beginning of the period for transactions in the first half of
the period. For transactions in the second half, it is set to the beginning of the next period.

Pro rata in the middle of the period

This rule is the same as the first rule, however it is intended for the calculation of depreciation based
on half-periods.

First year convention of a half-year

Beginning of year / middle of year / end of year

For transactions on the first day of a fiscal year, complete depreciation for the year is calculated; for
transactions in the first half, depreciation is calculated for a half year; for transactions in the second
half, no depreciation is calculated.

At the beginning of the year
In the middle of the period
At the end of the period (beginning in the subsequent year)

In the middle of the quarter
(See the "Pro rata at the middle of the period" rule)

In the second quarter

In the following quarter/month

Requirements

You must have processed the fiscal year variants for your company codes in Financial Accounting.
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Activities
1. Define a new rule or copy a period control rule that is already defined. The key of your period control
should begin with "9".
2. Enter the following for this rule:

- Key

Description

Define Calendar Assignments

The system uses the assignment rules in the period control to establish the connection between the asset
value date of an asset acquisition or retirement and depreciation periods or fiscal year periods. The
assignment rules determine the relationship between posting intervals and periods in the given fiscal year
version. These entries have to be changed in the following cases:

- You use period control rules you defined yourself.

- You change the definition of the periods in the fiscal year version in Financial Accounting.

Example (first year convention of a half year)

Posting up to 06/30 depreciation start/end in period 000
Posting up to 12/31 depreciation start/end in period 006

Caution

The system interprets period 000 as the start of the first period, that is, for depreciation calculation to start
at the start of the fiscal year, enter period 000 (or BLANK).

Standard settings

There are standard period controls supplied by SAP. The system automatically sets up the relationship to
the calendar for these standard period controls when the fiscal year version is assigned to the asset company
code. Itisalso possible to generate this assignment to a fiscal year manually (application menu: Periodic
processing -> Settings) for a given fiscal year.

Recommendation

If the two points outlined above do not apply to your enterprise, take over the entries determined by the
SAP system without changing or adding to them.

Preconditions
- You must have defined period controls.
- You must have defined fiscal year versions in Financial Accounting.

Actions

1.  Assign depreciation periods to calendar dates in your fiscal year. Define posting intervals based on
calendar intervals. For acquisitions, determine the starting depreciation period. For retirement,
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determine the period up to which depreciation should be calculated. You define the posting intervals
by entering the last calendar date in the given time period.

Make sure that the beginning and end date of the defined posting intervals are the same as the start
and end date of the fiscal year version in the company code.

2. You can also calculate depreciation on the basis of half periods (for example, the mid-quarter
convention in U.S.A.). In this case, you also have the set the indicator for 'depreciation as of mid-
period' in each assignment rule.

Define Time-Dependent Period Controls

In this step, you define the period controls that are dependent on company code or fiscal year, for
depreciation keys with period control by fiscal years.

Standard settings

SAP does not supply any standard depreciation keys with period control by fiscal years.

Recommendation

Normally period control is not dependent on the fiscal year. This function is only intended for those
countries where this type of period control is a legal requirement.

Activities
1.  Define your own depreciation key (in the customer name range: Zxxx) and set the indicator "Period
control according to fiscal years".
2. Create separate period controls for the depreciation key per

- company code
- fiscal

year and

- transaction
type
Enter these under Create.

Generate Period Controls

Only perform this step if you use a year-dependent fiscal year variant.

When you assign fiscal year variants to company codes, the system generates the calendar assignment for
the standard period control once for each company code.

If use a year-dependent fiscal year variant in Financial accounting, you need to redefine the relevant
calendar assignment for the period control before the start of a new calendar year.
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Activities

Generate the calendar assignment for the period control.

Further Settings

Below you various settings for
- Cut-off value key

- Maximum base value

- Asset-specific base value percentage rates

Define the Cut-off Value Key

For certain types of valuation, it makes sense, or is legally required, that you end depreciation when a
certain value is reached. You can enter an absolute scrap value in the asset master record. Or you can enter
a percentage scrap value (cut-off value) in the calculation key.

In this step, you define the calculation key for automatically determining scrap values. For each calculation
key, you can specify

- the percentage of the depreciation base that should be used as the cut-off value percentage

- whether the cut-off value percentage should be deducted at the start or the end of the calculation of
depreciation

- atwhat point in time the system should start calculating the validity period

You can enter several cut-off percentages for each scrap value key. You can define the cut-off
percentages/levels per acquisition year, and the validity period can be of any length.

Example

Start of the validity period: Capitalization date

Validity  period: 5  years
Percentage: 5%

=> For assets, that are no more than 5 years old based on their capitalization date, the cut-off percentage
rate of 5% is valid.

Be aware that you have to enter the validity period of the individual percentages or levels of a scrap value
key in cumulative form (level 1: 1 year, level 2: 2 years => levels 1 and 2 each last one year).

Standard settings

SAP supplies standard scrap value keys. You have to revise the time specifications of the scrap value keys
delivered by SAP.

Activities
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1.  Define your own cut-off value key or scrap value key.

- Specify whether the cut-off value/scrap value should be deducted from the base value for
depreciation at the start of depreciation calculation, or if depreciation should stop when the scrap
value is reached.

- Specify the start of calculation of the validity time periods.

- Define the validity periods and the percentage rates for the cut-off value/scrap value.
2. Enter your cut-off value key in the definitions of the depreciation keys concerned.

Further notes

SAP library FI-AA: Depreciation -> Cut-off Value

Further notes (Transport)

You can include the scrap value key in a transport request in the overview screen of the transaction under
Key -> Transport. Note that the definition of the scrap value key applies in all clients. Therefore, you
only need to transport if you need transports between systems (for example, from a test system to a
production system).

Define Maximum Base Value

In this step, you define limited acquisition values as base values for the calculation of depreciation. This
limited acquisition value can be stored as a key (05) in the multi-level method of the depreciation key, in
the same way as all the other base values.

"Limited acquisition value" means that the system uses a specified maximum amount as the base value for
depreciation. If the acquisition value of the asset is under this maximum amount, the system uses the actual
acquisition value as the basis for depreciation. However, if the acquisition value of the asset exceeds this
maximum amount, depreciation is based on this maximum amount. You can specify the maximum base
amount for each depreciation area and asset class in each company code.

Note

All the other base values delivered as standard do not need to be edited within Asset Accounting
Customizing. You do not need to carry out this step if you do not require the limited acquisition value as
a base value for your depreciation calculation.

Requirements

You must have already created asset classes.

Standard settings

SAP does not deliver any predefined, limited base values.
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Activities

1. Define your own limited base values. You can limit the validity according to:
- Company code
- Assetclass

- Depreciation area
- Capitalization date (valid to)

2. Specify the APC percentage rate that is to be used by the depreciation keys with base value 05 for
each limitation.

Specify Asset-Specific Base Value Percentages

In this step, you enter asset-specific percentage rates for the base value for depreciation.

Recommendation

This step meets country-specific requirements in Japan. In most other countries, you do not need this
function.

Activities

1.  Select the company code.

2. Enterthe affected assets. Assign a base value percentage to each asset, per depreciation area and fiscal
year.

The fiscal year entry you make is the "to" fiscal year. This means that the base value is valid until
this fiscal year. After this fiscal year, the system uses 100% of the base value that is in the depreciation
key.

Note

The percentage rates you enter are only effective when the assets use a depreciation key (in the depreciation
area specifications in the asset master record) that uses base value 28 (asset-specific reduction).

Enhancements

Various positions in the programming of the FI-AA component have been set up to allow you to call your
own user-modified function modules for realizing functions that are not part of the standard system. In the
sections below, you can create enhancement projects.

For an overview of the customer enhancements in Asset Accounting, refer to the SAP Library under
"Customer Enhancements (Customer EXxits)".

For general information on customer enhancements, refer to the documentation for transaction CMOD (the
"Information" pushbutton).
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Develop Enhancement for Determining Base Value

In this step, you use a prepared customer enhancement project to define your own base values for
Depreciation calculation. You can store these base values in the definition of the affected multi-level
methods for depreciation keys.

Note

Enhancement projects function on the basis of certain positions in standard SAP programming code that
have been prepared by SAP to allow the call of function modules programmed by the user to meet his/her
specific requirements. Therefore, it is possible to implement enhancement projects only if you have
knowledge of the ABAP/4 programming language.

Standard settings

SAP supplies all common base values (APC, net book value and so on) as part of the standard system.

Recommendation

You should review your needs carefully. Generally, you should not need to use enhancement projects,
since all common requirements are already met by the standard system functions.

Activities

1. Modify function module EXIT_SAPLAFAR_001 and the include program in it to your requirements.

2. Activate a customer modification project (any key) with SAP enhancement AFAR0001.

Further notes
For more information, refer to the documentation for customer enhancement AFAR0001 (transaction
SMOD).

For an overview of the customer enhancements in Asset Accounting, refer to the SAP Library under
"Customer Enhancements (Customer Exits)".

For general information on customer enhancements, refer to the documentation for transaction CMOD (the
"Information" pushbutton).

Develop Enhancement for Depreciation Method

In this step, you use a prepared customer enhancement project to define individual calculation methods for
the depreciation calculation. You can store these user-defined methods of depreciation in the definition of
the base methods for depreciation keys.

Standard settings
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SAP supplies all the common calculation methods as part of the standard system.
Note

Enhancement projects function on the basis of certain positions in standard SAP programming code that
have been prepared by SAP to allow the call of function modules programmed by the user to meet his/her
specific requirements. Therefore, it is possible to implement enhancement projects only if you have
knowledge of the ABAP/4 programming language.

Recommendation

You should review your needs carefully. Generally, you should not need to use enhancement projects,
since all common requirements are already met by the standard system functions.

Activities

1.  Modify function module EXIT_SAPLAFAR 002 and the program included in it to your
requirements.

2. Activate a customer enhancement project (any key) with the SAP enhancement AFAR0002. Further

notes

For more information, see the documentation for customer enhancement ARAR0002 (transaction
SMOD).

For an overview of the customer enhancements in Asset Accounting, refer to the SAP Library under
"Customer Enhancements (Customer Exits)".

For general information on customer enhancements, refer to the documentation for transaction CMOD (the
"Information" pushbutton).

Develop Enhancement for Changeover Method

In this step, you use a prepared customer enhancement project to define your own changeover methods for
depreciation calculation. You can store these changeover methods in the definition of the affected
depreciation keys.

Standard settings

SAP supplies all common changeover methods as part of the standard system.

Note

Enhancement projects function on the basis of certain positions in standard SAP programming code that
have been prepared by SAP to allow the call of function modules programmed by the user to meet his/her
specific requirements. Therefore, it is possible to implement enhancement projects only if you have
knowledge of the ABAP/4 programming language.

Recommendation
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You should review your needs carefully. Generally, you should not need to use enhancement projects,
since all common requirements are already met by the standard system functions.

Activities
1. Modify function module EXIT_SAPLAFAR_003 and the include program to your requirements.
2. Activate a customer enhancement project (any key) with SAP enhancement AFAR0003.

Further notes

For more information, refer to the documentation for customer enhancement AFAR0003 (transaction
SMOD).

For an overview of the customer enhancements in Asset Accounting, refer to the SAP Library under
"Customer Enhancements (Customer Exits)".

For general information on customer enhancements, refer to the documentation for transaction CMOD (the
"Information" pushbutton).

Develop Enhancement for Calculating Proportional Values

In this step, you set up an enhancement project that you can use to influence the calculation of proportional
values during an asset retirement.

Note

Enhancement projects function on the basis of certain positions in standard SAP programming code that
have been prepared by SAP to allow the call of function modules programmed by the user to meet his/her
specific requirements. Therefore, it is possible to implement enhancement projects only if you have
knowledge of the ABAP/4 programming language.

Recommendation

You should review your needs carefully. Generally, you should not need to use enhancement projects,
since all common requirements are already met by the standard system functions.

Activities

1.  Modify function module EXIT_SAPLAFAR_004 to meet your requirements.

2. Activate a customer enhancement project (any key) with SAP enhancement AFAR0004.

Further notes
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For more information on customer enhancement AFAR0004, see its documentation.

For an overview of the customer enhancements in Asset Accounting, refer to the SAP Library under
"Customer Enhancements (Customer Exits)".

For general information on customer enhancements, refer to the documentation for transaction CMOD (the
"Information” pushbutton).

Program Enhancement for New Depreciation Calculation

Create Implementations for AddIn for Calculation Bases

Use

This BAdI enables you to influence the calculation of replacement values, depreciation, and interest in
accordance with your specific needs. Using the methods defined for these purposes, you can:

- Change the sequence of the calculation

- Change the calculation parameters

- Specify the length of the period intervals

- Specify the changeover year, and if applicable, the changeover period

- Change the rounding definitions

Requirements

For specifying the changeover year and changeover period, the changeover method of the depreciation key
must be intended for a customer enhancement (changeover methods X, Y or Z).

Example

Examples are stored directly in BAdlI FAA DC CUSTOMER. Start the BAdI Builder (transaction SE18)
for Business Add-In FAA DC_CUSTOMER, and choose the Display function. From the menu, choose
Go to -> Sample Code -> Display to access individual example implementations of the given method.

As another option, you can access the example implementations directly using the class
CL EXM IM FAA DC CUSTOMER.

See also

For more information on using this enhancement, see SAP Note 1131960.
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Create Implementations for Add-In for Depreciation Calculation

Use

This SAP enhancement enables you to influence the calculation of revaluation, depreciation, and interest
within the depreciation calculation in accordance with your specific needs. Using the methods defined for
these purposes, you can:

1. Specify your own base value for multilevel depreciation methods in the depreciation calculation
2. Specify your own depreciation amount and depreciation percentage for the depreciation calculation

3. Define your own cut-off values for derived depreciation areas

Requirements

- The base value in the multilevel method of the depreciation key must be intended for customer
enhancements (base values ZA, ZB, and so on).

- Or the depreciation method within the base method of the depreciation key must be intended for
customer enhancements (depreciation methods X, Y or Z).

Example

Examples are stored directly in BADI FAA_EE_CUSTOMER. Start the BAdI Builder (transaction SE18)
for Business Add-In (BAdl) FAA_EE_CUSTOMER. Choose Display. From the menu, choose Go to ->
Sample Code -> Display to access individual example implementations of the given method.

Or you can access the example implementations directly using the class
CL_EXM_IM_FAA_EE_CUSTOMER.

For more information on using this enhancement, see SAP Note 1131960.

Special Valuation

In the following section, you define system settings for
- special value adjustments to assets (investment support, special depreciation reserves)

- And for special valuation purposes (for example, cost-accounting replacement values, interest,
revaluation for the balance sheet).
Note

You cannot create any depreciation areas in this step. You create depreciation areas in the step
"Valuation" under Define depreciation areas
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Reserves for Special Depreciation

In this section, you make system settings for determining and posting reserves for special depreciation.

Specify Gross or Net Procedure

In this step, you determine whether the system should balance the amounts from the allocation and writing
off of special reserves on the same asset in the same posting run against each other.

Example
Ord. dep.,Spec. dep.
Area 01 7500 0
Area 02 2500 40,000
- Gross

The system posts an allocation for this asset to special reserves for -40,000 (= 0 - 40,000) and a write-
off of 5000 (= 7500 - 2500).

- Net
The system balances the 5000 with the -40,000 and posts an allocation in the amount of 35,000.

Recommendation

SAP recommends that you post allocation amounts and write-off amounts for the same asset offset against
each other (net posting). This procedure is in line with the legal requirements in most countries.

Activities

Indicate the depreciation areas in which net posting of allocation or writing off of special reserves is to
take place.

Assign Accounts

In this step, you determine the general ledger accounts for the write-off or allocation of special reserves.
Note

If you enter gain/loss accounts for this depreciation area, the system does not post any revenue from the
write-off of special items for reserve. Instead, the system includes any revenue from the write-off of special
items for reserve, resulting from an asset sale, in the calculation of gain/loss itself. The system balances
loss in the book depreciation area against an offsetting posting, and posts the total or the difference between
the write-off of special items for reserve and the book loss to these accounts.

Transferred Reserves (Deferred Gain)

In the following section, you define the system settings that are necessary for transfer of reserves (also
called undisclosed reserves, deferred gain, and balancing charges) to newly acquired fixed assets.
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The tax legislation of many countries allows the entire undisclosed reserves, created by the sale of assets,
or a part thereof, to be transferred to replacement acquisitions. The gain on the sale then reduces the
depreciation base of the newly acquired assets. If such undisclosed reserves are not transferred in the year
they are formed because there are no suitable new acquisitions, a reserve can be set up in the year in
question to prevent the gain on the sale from having an influence on profit. These reserves have to be
transferred in the next few years to assets acquired during this time period.

Further notes

SAP library FI-AA: Special Valuations of Fixed Assets -> Undisclosed Reserves (Deferred Gain,
Balancing Charges)

Determine Depreciation Areas

In this step, you determine the depreciation areas into which you want to transfer reserves for fixed assets.
This specification means that this value type is allowed in the depreciation area (that is, the system does
not issue an error message when you enter corresponding depreciation terms in the asset master record).

Requirements

You must have created at least one chart of depreciation of your own.

Standard settings

The country-specific charts of depreciation (for example OUS for the U.S.A.) contain fully defined standard
depreciation areas.

Activities

Set the indicator "management of transferred reserves" in the depreciation areas in question.
Assign Accounts

Use

In this activity, you specify the G/L accounts for the transfer of reserves.
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Define Transaction Types for Transfer of Reserves

You carry out the transfer of reserves in Asset Accounting using manual posting. In this step, you define
the transaction types for the transfer of reserves. In addition, you can specify that certain transaction types
only propose certain depreciation areas for posting. The system then generates a popup window in the
posting transaction. The window shows the depreciation areas that are available for posting. If you specify
that all areas should be posted at all times, this popup window is suppressed.

Requirements

You must have defined a separate chart of depreciation.

Standard settings

SAP provides transaction types for the transfer of reserves (680 - 692)

Recommendation
You should use the standard transaction types. You do not have to do anything else here in that case.
However, you may need to define your own transaction types if the following applies to your enterprise:
You need transaction types
- that post only to certain specific depreciation areas in your chart of depreciation and

- there are no standard transaction types that have these limitations
Activities

1. Create new transaction types according to your requirements. When you create the three-letter key
for the transaction type, use the letter X, Y or Z somewhere in the key. Using one of these letters (at
any position in the key) will prevent your key from being overwritten by future SAP updates.

2.  Define the characteristics of the new transaction types in the detail screen.
Further notes

SAP library FI-AA: Transactions -> Transaction Types/Updating Values in the Depreciation Area

Investment Support

In some countries the state provides grants under certain circumstances for investments made. These
investment support amounts are normally displayed and depreciated separately from the asset acquisition
costs. In this step

- you define the investment support measures (for example, validity period)

- you make particular specifications for depreciation areas and account assignment with respect to the
investment support

- you specify plausibility’s for the entry of investment support in the asset master record

Further notes
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SAP library FI-AA: Special Valuations of Fixed Assets -> Investment Support

Determine Depreciation Areas

In this step, you specify the depreciation areas for managing investment support. This specification means
that this value type is allowed in the depreciation area (that is, the system does not issue an error message
when an investment measure is planned).

If you want to manage investment support on the liabilities side, or if you want to manage more than one
support measure for certain assets separately, you need "special" depreciation areas for managing the
support measures only.

Standard settings

SAP supplies predefined depreciation areas in the reference chart of depreciation.
Activities

1. Identify the depreciation areas
- in which you want to use the support to reduce the APC of the asset
- which are intended solely for managing investment support measures

2. If you need a new depreciation area for managing investment support, copy an already existing
depreciation area of this type.

Define Investment Support Measures

In this step, you define the investment support measures, which you want to claim and manage in Asset
Accounting. In the definition you must decide whether the measure:

- Is managed on the liabilities side
- Reduces the acquisition value on the assets side

If you plan to have the investment support reduce the acquisition value, you have to manage the investment
support in the book depreciation area. If you plan to manage the support on the liabilities side, you have to
manage it in a "special" depreciation area (not in the book depreciation area).

In both cases, you can also manage the investment support measure additionally in other depreciation areas
for reporting purposes.

You can enter the keys of several investment support measures in the asset master record. In this way, it is
possible to:

- Generate an investment support claim form list, showing all the assets eligible for investment support

- Subsequently claim the investment support using collective posting
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Specify plausibility checks for your investment support measures. You can define each investment support
measure so that it is proposed and checked during master data maintenance, dependent on the
organizational units (plant, cost centre, asset class).

Note: The system only carries out these plausibility checks if you set the check indicator in the definition
of the investment support measures.

Recommendation

Check whether the investment support you claim has to be handled as revenue. If this is the case, you are
not required to manage the support in Asset Accounting. You can manage investment support directly in
the general ledger.

Requirements
You must have already processed the depreciation areas for investment support.
Activities

1. Call the "Set chart of depreciation” function, if the current chart of depreciation is not the one you
want.

2. Define the investment support according to your requirements:

Validity period

Maximum percentage rate / amount

Retention period

- Depreciation areas in which the measure is to be managed
3. Define several time intervals within the validity period with different percentage rates, if needed.

This enables you to claim the investment support in increments over a time period that you define.

4.  Enter the combination of organizational units for each investment measure that is plausible for that
measure. If you do not make an entry for a given organizational unit, then the measure cannot be
created in a master record in which that organizational unit is managed. If there is no entry at all in
the table, then the measure can be managed in all organizational units (no plausibility check). Set the
indicator for those measures that should be proposed during master data maintenance.

Further notes

SAP Library FI-AA: Special Valuations of Fixed Assets -> Investment Support -> Definition/Claiming of
Investment Support

Assign Accounts

In this step, you specify the general ledger accounts for investment support measures.

Requirements
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Account assignments must be defined.
Activities
Specify the necessary accounts - depending on the type of investment support measure.

Further notes

SAP library FI-AA: Special Valuations of Fixed Assets -> Investment Support

Check Transaction Types for Investment Support Measures

In this step, you can check and change the definition of the transaction types for claiming investment
support measures. This step is only required in exceptional cases.

Requirements

You must have defined at least one investment support measure.

Standard settings

In the standard system, the system automatically creates a transaction type (transaction type key = "I')

when you define an investment support measure. Usually, you can use this transaction type without making

any other modifications. You need to change it only if

- You want to assign the transactions belonging to it to an asset history group that is not standard, or to
a different consolidation transaction.

- You want to change the support measure in regard to the depreciation areas that are posted.

In addition, you can enter a default document type. However, note that this document type is only taken
into account during manual posting. When posting collectively (the usual case), you must enter the
document type when starting the processing.

Recommendation

You should work with the SAP standard. In this case, there are no activities to the carried out here.
Activities

Check the definition of the standard transaction types.
Further notes

SAP library FI-AA: Transactions -> Transaction Types/ Updating Values in the Depreciation Area
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Revaluation of Fixed Assets

In order to compensate for an inflation-related reduction in the value of currency or for changed
replacement values, it can be necessary to revalue fixed assets (either upward or downward) for one of
these reasons:

- For management accounting purposes
- Due to tax requirements
The system has the following functions available for revaluation:

- Using index series, APC and cumulative value adjustments can periodically be revalued according to
a price increase index.

- One-time or periodic revaluation of fixed assets due to legal requirements can be represented using
revaluation measures.

Note

Within one depreciation area, you are not allowed to enter different accounts for revaluation using index
series than for revaluation using revaluation measures.

Settings for Maps Fiscals Portugal

Use
The Mapas Fiscals are legally required revaluation areas in Portugal. In this activity, you maintain the
settings for determining the data and for printing the forms of Mapas Fiscals.

Activities

Define the following per company code:

- Revaluation areas

- Revaluation groups and exceptions
- Manual values for individual assets
- Currency revaluation coefficients

- Transaction types for retirements

- Selection of the validation key

- Tax deductible depreciation limit for vehicles with electric and non-electric energy

Further notes

For Mapas 34 and 34, you also have to maintain the index series that is used (Define Index Series).
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Maintain Accounts for Revaluation

Use

You do not need to carry out the following step unless you want to post revaluation of APC to G/L accounts,
or if you want to post revaluation of accumulated depreciation to G/L accounts (backlog calculation).

In this step, you specify the G/L accounts for changes to APC or accumulated depreciation due to
revaluation, for determining the replacement value.

Note

The screen layout of accounts that are posted using mass posting cannot contain any required entry fields
that cannot be supplied by batch input posting runs.

Example:
The depreciation accounts cannot require the entry of a posting text, since the depreciation posting program
does not generate any posting texts.

Indexed Replacement Values

In addition to historical APC, the replacement value can also be used as a depreciation base in the FI-AA
module. The system determines the replacement values using index series. With these index series, it is
possible to automatically take periodic value changes into account when posting depreciation asset-
specifically or class-specifically.

By transferring depreciation of the replacement value to controlling, you can take general price rate
increases into account, for example, when costing your own product prices.

In the following section, you define system settings for determining replacement values.

Further notes

SAP library FI-AA: Special Valuations of Fixed Assets -> Replacement Values

Determine Depreciation Areas

In this step, you determine the depreciation areas in which you want to manage replacement values.

Recommendation
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In most countries, you are only allowed to calculate replacement values for cost accounting purposes. In
this case, you should only allow for upward and downward revaluation in the cost accounting depreciation
area.

Requirements

You must have created at least one chart of depreciation of your own.

Standard settings

Depending on the country-specific standard chart of depreciation, SAP provides depreciation areas for
managing replacement values.

Activities

Set the indicator "management of revaluation” in the depreciation areas in question.

Define Index Series

In this step, you define the index series and the historical index figures for the index series. You need these
index figures if you want to calculate using replacement values. For these types of calculations, you need
to maintain the index figures beginning with the point in time that the oldest asset with an index series was
acquired, up to the time of the takeover of old assets data. The system needs these past index figures in
order to be able to correctly historically calculate the replacement values and insurable values for assets
transferred during the old assets data takeover.

Maintaining the current index figures is part of periodic processing in the application menu of the FI-AA
System.

Caution

It is absolutely necessary that you maintain your index series with the correct index figures before old
assets data is taken over. Index figures of years prior to the data takeover after the old assets data takeover
has taken place can only be changed with considerable effort.

If you do not have any index series at the time of the old assets data takeover, you can still calculate
replacement values for all assets in later fiscal years, even after the productive start of the system. However,
for previous acquisitions, you can then only use index series that provide for "historical calculation™ in
their index class. The current replacement value is calculated as follows with such index series:

Value (curr.year) = APC * index (curr.year) / index (acquis. year)

After calculating the replacement value in this way, you can change to a different index series in the
following year, which calculates on the basis of the replacement value from the previous year.

Activities

1. Assign a key to the index series.
You can specify this key in the asset master records.

2. Assign the index series to an index class. The index series specifies

- Whether the index series is age-dependent or year-dependent.
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Age-dependent index figures are based on the 'n'th year that the asset has belonged to the asset
portfolio. They show an annual rate of change from the time of the asset acquisition. The year
1 has the index figure 100. Year-dependent index figures relate to the fiscal year or the calendar
year, and show a rate of change in relation to a certain base year. The base year has the index
figure 100.

- Whether the calculation of indexed values should be based on historical APC or on the
replacement value from the previous year.

The difference between the historical calculation and calculation based on the replacement value
of the previous year (normal) becomes clear when looking at a subsequent acquisition to an
asset. When you use historical calculation, the replacement value is determined as if the
subsequent acquisition took place in the capitalization year. Therefore, it makes sense only to
use the historical method if you do not have access to replacement values from the previous
year for the assets taken over from your previous system.

3. Specify the rate of increase (for example, 103% = annual increase of 3%) for the simulation of the

replacement value in future fiscal years.

Via this percentage, you can also calculate replacement values in the current fiscal year, even if the
respective index figures have not yet been determined.

4.  Enter a description of your choice.

5. Enter the index figures for the individual fiscal years (months, days). For example, 103 means an
increase of 3%.

a) Select the index series to be processed on the list screen.

b)  Select the function Index figures.

Note

Bear in mind that at the present time the index figures in the system always relate to fiscal years
and not to calendar years. If you have a non-calendar fiscal year, you therefore have to
accordingly adapt the time frame of the index figures depending on the calendar year before
entering data into the system.

Enter Index Series in the Asset Classes

In this step, you determine the index series that your asset classes are to use. Depending on the definition
in the screen layout control that is used, these index series are proposed or are mandatory defaults when
you create a fixed asset.

Requirements

You must have created asset classes.

Standard settings

SAP supplies predefined asset classes (1-8).
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Activities

Enter index series in the depreciation area specifications of your asset class.

Note: you can only specify index series for depreciation areas that have definitions that allow for index
series (see Determine depreciation areas).

Revaluation for the Balance Sheet

In this section, you make system settings for carrying out revaluation measures.

Using balance sheet revaluation measures, you can reflect tax laws that require you to revalue all assets at
long intervals (every few years) in order to represent the effects of inflation.
The system offers two options for carrying out this kind of revaluation for the balance sheet.

- For a one-time revaluation, follow the steps below without carrying out the transaction in the
"Inflation” IMG node. By doing so, you can offset the effects of inflation by a one-time revaluation
of your total fixed assets.

To carry out one-time revaluation, in the Asset Accounting application menu, choose Periodic
processing -> Balance sheet revaluation -> Post revaluation.

- For periodic revaluation, follow the steps under the "Inflation" node, in addition to the steps above.
These settings are needed in order for you to be able to take the effects of inflation into account on a
regular basis.

To carry out periodic revaluation, in the Asset Accounting application menu, choose Periodic
processing -> Balance sheet revaluation -> Post inflation.

Further notes

SAP library FI-AA: Special Valuation

Determine Depreciation Areas

In this step, you determine the depreciation areas in which you want to manage revaluation.

Requirements

You must have created at least one chart of depreciation of your own.

Standard settings

Depending on the country-specific standard chart of depreciation, SAP supplies depreciation areas for
managing revaluation.

Activities

Set the indicator "Manage revaluation™ in all the depreciation areas in which revaluation is to be managed
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Define Revaluation Measures

In this step, you define the revaluation measures (key, description, depreciation areas and posting data).
You need a special depreciation area for each revaluation.

You have to create the calculation rule for the revaluation using a user exit (see the System

Administration Guide: Individual User Modifications). In order to carry out the revaluation, you have to
use the report RAAUFWOL1.
Requirements

You must have set aside a depreciation area for revaluation.
Activities

1. Call up the function "Set chart of depreciation," if the currently allocated chart of depreciation is not
the one you want.
2. Make the following specifications for your revaluation:

- posting date or asset value date of the revaluation

depreciation area, in which the revaluation is to be managed separately

depreciation areas, in which the revaluation is also to be posted

- base area for calculating revaluation

Further notes (Transport)

You can include the revaluation measure in a transport request in the overview screen of the transaction
under Object -> Transport. Note that the definition of the revaluation applies only in specific clients.
Therefore, you need to transport not only if you need transports between systems (for example, from a test
system to a productive system), but also in order to make the revaluation measure available in other clients.

Develop Enhancement for Revaluation

In this step, you use a prepared customer enhancement project to define the calculation of a revaluation
measure.

Standard settings
SAP does not provide any standard revaluations.

Note

Enhancement projects function on the basis of certain positions in standard SAP programming code that
have been prepared by SAP to allow the call of function modules programmed by the user to meet his/her
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specific requirements. Therefore, it is possible to implement enhancement projects only if you have
knowledge of the ABAP/4 programming language.

Recommendation

You should review your needs carefully. Generally, you should not need to use enhancement projects,
since all common requirements are already met by the standard system functions.

Activities

1.  Modify function module EXIT_RAAUFWO01_001 and the include program in it to your requirements.

2. Activate a customer enhancement project (any key) with SAP enhancement ARVLO0001.

Further notes
For more information, refer to the documentation for customer enhancement ARVL0001 (transaction
SMOD).

For an overview of the customer enhancements in Asset Accounting, refer to the SAP Library under
"Customer Enhancements (Customer EXits)".

For general information on customer enhancements, refer to the documentation for transaction CMOD (the
"Information™ pushbutton).

Implementations for Add-In for Revaluation and New Valuation

Use

This Business Add-In (BAdI) is used in the Asset Accounting (FI-AA) component. Using this BAdI you
can calculate revaluation amounts or depreciation adjustment amounts for assets within the framework of
the Revaluation and New Valuation of Assets Report (RAAUFWO02, transaction AR29N).

Standard settings

This BAdI has a default implementation. It can be used for new valuation based both on indexes and on
values. In addition, it can be used to calculate adjustments to depreciation, but only under the premise that
there is no splitting of previous-year acquisitions and current-year acquisitions, if the adjustment amount
is more than the given amount available.

The default implementation is only a guideline. For specific cases, such as parallel currencies, you have to

modify the code to meet your requirements. It is extremely important that you also read the information
on limitations of the Default- implementation.

Activities

If the functions of the default implementation are not sufficient, change them to make your own customer
implementation. If you want to use the standard revaluation function, then you have to create your own
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implementation, or copy the code of user exit "EXIT_RAAUFWO01_001" and modify it as an
implementation.

After you call the IMG activity, the system displays a dialog box where you enter a name for the
implementation.

If implementations of this Business Add-In have already been created, the system displays them in a dialog
box. You then choose one of them by choosing Create, and continue as follows:

1. Inthe dialog box, enter a name for the implementation of the Add-In and choose Create. The system
displays the initial screen for creating Business Add-In implementations.

2. On this screen, enter a short description for your implementation in the Implementation Short Text
field.

3. If you choose the Interface tab, you will notice that the system has populated the Name of the
Implementing Class field automatically, by assigning a class name based on the name of your
implementation.

4.  Save your entries and assign the Add-In to a package.
5. To edit a method, double-click its name.

6. Enter your implementation code between the methods <Interface Name>~<Name of
Method>. And end method. Statements.

7. Save and activate your code. Navigate back to the Change Implementation screen. Note: You can
also create an implementation for an Add-In and not activate it until later. If you want to do this, do
not perform the following step:

8.  Choose Activate.
When the application program is executed, the code you created is run through.

Example

Refer to the documentation of the CALCULATE_ASSET method.
See also
Methods:

Calculate Amounts for an Asset

Define Transaction Types for Revaluation

In this step, you define transaction types for posting revaluation.
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Inflation Accounting

Maintain Inflation Indexes

Use

In this IMG activity, you maintain the inflation indexes that you want to use to revaluate your assets.
Unlike in Inflation Accounting for Financial Accounting (FI), where you enter one inflation index in the
inflation method to represent the general inflation index, in Inflation Accounting for Asset Accounting
(FI-AA), you have to assign an inflation index to each asset separately.

Standard settings

The system comes complete with sample inflation indexes for a number of country versions. You can use
these indexes themselves or you can use them as the basis for creating new inflation indexes.

Activities

For each inflation index:
1.  Enter the header information, including the index ID, short text, and format.
2. Create a version for the index and enter the version number in the header data.

3. Maintain the index values as follows:

When you first customize the Inflation Accounting solution, enter the index value for the first
interval that you want to adjust your accounts for and the value for the previous interval. For example,
if you start using the solution at the beginning of 20X2 and you are required to revaluate your assets
every month, enter the values for January 31, 20X2 and for December 31, 20X1. The system needs
this information in order to be able to calculate the net inflation rate for January. Then, as the
government publishes the inflation index values, enter them in the inflation index. The system
automatically displays this value in the other formats.

Composite Inflation Indexes

To define a composite inflation index:
1.  Define the indexes that it is composed of as described above.

2. Create a header for the composite inflation index.
As well as the usual header information, select Comp. Ind. (Composite index).

3. Select the composite index header and double-click Composite Indexes.

4.  Specify which indexes the composite index is composed of and, in the Factor field, how each of these
component indexes is weighted.
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Maintain Posting Variants

Use

In this IMG activity, you maintain posting variants.

Activities

If all your assets are to be revaluated on the same dates, create only one posting variant. If, however, some
assets are to be revaluated at different intervals from others, create a separate posting variant for each case:
for example, if you revaluate some of your assets once a month and others once a quarter, create two
posting variants, one for each group of assets.

To create a posting variant:

1.  Enter the header data (posting variant ID and short text).

2.  Enter the dates on which you are allowed to revaluate assets.
Once you have defined the posting variants you need, assign one to:

- Each revaluation key
This controls how often each individual asset can be revaluated.

- The inflation method

This controls how often you can execute the Asset Revaluation (Inflation) program, so you must use
a posting variant that applies to all of your assets.

If, as in the above example, you revaluate some assets monthly and others quarterly, you would need
to assign the monthly posting variant to the inflation method. If you assigned the quarterly variant to
it instead, you would not be able to revaluate the first group of assets monthly.

Maintain Time Base and Exposure to Inflation Variants

Use

In this IMG activity, you maintain time base and exposure to inflation variants (TBE variants).

In Inflation Accounting for Asset Accounting (FI-AA), the TBE variants have two different purposes.
You assign them to either of the following:

- Period control methods

These TBE variants control, ultimately, how the Asset Revaluation (Inflation) program handles asset
transactions that are posted partway through an interval.

- Revaluation keys

You assign one TBE variant to each revaluation key. This TBE variant instructs the Asset
Revaluation (Inflation) program which inflation index date's value to use to revaluate the asset.
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Standard settings

The standard system includes TBE variants for asset revaluation at intervals of one day, one month, six
months, and one year. If they match your requirements, you can use them or copies of them.

Activities
If you need to create a TBE variant of your own, proceed as follows:

1.  Create the header data, including the TBE variant ID, short text, and posting variant.

2.  Create an entry for each interval.

For example, if you want to create a TBE variant for inflation adjustment at monthly intervals,
create one entry for each month (see example below). For each interval, enter two dates:

- On the left-hand side of the table, enter the last day of the interval.
In the example, an entry has been made for the last day of each month.

- On the right-hand side of the table, enter the inflation index date that is to be applied to this
interval.

Typically, you use the index published for the last day of the interval, in which case, enter the
same date as on the left-hand side. In some cases, however, you are required to use an inflation
index from a previous interval.

Once you have created the TBE variants, enter one in each revaluation key.

Example

For the purposes of this example, assume that:
- Your fiscal year runs concurrently to the calendar year
- You are required to revaluate your assets at the end of every month

In this case, you make twelve entries in this table (see below), one for each interval. Because the intervals
are the same each year, you can enter the year as 9999, which denotes a recurring interval.

Year Month Day Post Month Day Prev. year
9999 1 31 1 31
9999 2 28 2 28
9999 3 31 3 31
9999 4 30 4 30
9999 5 31 5 31
9999 6 30 6 30
9999 7 31 7 31
9999 8 31 8 31
9999 9 30 9 30
9999 10 31 10 31
9999 11 30 11 30
9999 12 31 12 31

WHATSAPP +255738656506



[BECOME A MASTER OF SAP S/4 FINANCIAL ACCOUNTING
{8 CUSTOMIZING]

Maintain Period Control Methods

Use

In this IMG activity, you maintain period control methods.

Requirements

Before you can do so, you must have maintained the time base and exposure to inflation variants (TBE
variants) that you need. The period control method is a grouping of four separate TBE variants, one for
each of the following transaction types:

- Acquisitions

Retirements

Transfers

Acquisitions in subsequent years

Activities
Maintain a separate period control method for each group of assets that has to be adjusted the same way.

For each method, enter an ID and short text, and a TBE variant for each of the transaction types.

Once you have maintained the period control methods, assign one to each revaluation key.

Revaluation Areas

Maintain Revaluation Areas

Use
In these IMG activities, you set up the revaluation areas. How many you need depends on a number of
factors:

- Do local accounting regulations require you to keep revaluation amounts separate from all other
general ledger postings?

If so, create two depreciation areas:
- Avrevaluation area, where the system records only the revaluation amounts

- Aderived depreciation area, which will show the adjusted asset values by adding together the values
from the book depreciation area and the revaluation area
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If you are allowed to record revaluation amounts in the book depreciation area itself, you need not
Create any other revaluation areas.

- Do you need to create different sets of inflation-adjusted financial statements?

If your company prepares more than one set of inflation-adjusted financial statements, for example,
one for tax purposes and one for controlling purposes, create a separate revaluation area and derived
depreciation area for each.

- Does your company code work with parallel currencies?

If so, you must create a copy, for each parallel currency, of each revaluation area that posts to the
general ledger. Customize theses parallel currency areas identically to their local currency areas, but
do not mark them for posting to the general ledger.

Activities
In this IMG activity, you carry out two steps. First you define the depreciation areas that you want to use
as revaluation areas, then you specify that they are revaluation areas.
Defining Revaluation Areas

Proceed as follows, depending on whether the area is a revaluation area, a derived depreciation area, or a
parallel currency area.

Revaluation Areas

1. Select Real dep. area.

2. Set Posting to G/L to 1 (Post assets to general ledger real-time)

This means that when you post a transaction such as an asset retirement and the system has to
calculate the gain or loss on the asset, it takes into account the postings made in this revaluation area
and therefore allows for inflation when calculating the gain or loss.

It does not mean that the system automatically transfers the revaluation amounts from this revaluation
area to the general ledger. That only happens when you execute a depreciation run.

3. Inthe Management of values group box, select:
- Positive net book value

- Negative net book value

Derived Depreciation Areas

1. Deselect Real dep. area.
2. Set Posting to G/L to O (No values are posted in general ledger)
3. Inthe Management of values group box, select:

- Acquisition and production costs

- Positive net book value

- Negative net book value

4. Inthe Entries for derived depreciation area group box, enter:
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- The book depreciation area

- The revaluation area

In order for the system to add the two together, enter + and 1 in the Area Sign and Proportion fields
respectively.

Parallel Currency Areas
Proceed as for real areas, but set Posting to G/L to 0 (No values are posted in general ledger).

Specifying Area Types

In this IMG activity, enter 17 (Depreciation area for handling inflation (hard currency)) in each of the
depreciation areas you want to use as a revaluation area.

Define What Revaluation Amounts to Record

Use

In this IMG activity, you specify what sort of revaluation amounts each revaluation area is to be used to
record.

In each area, you can record either or both:
- Revaluations of acquisition and production costs

- Revaluations of depreciation

Maintain Posting Rules

Use

In this IMG activity, you specify whether, and if so, how often, the system is to post the revaluation
amounts from any given revaluation area to the general ledger.

The revaluation amounts are transferred to the general ledger along with the depreciation amounts when

Activities

you execute a depreciation run.
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For each real revaluation area from which postings are to be made to the general ledger:
1. Specify how often the revaluation amounts are to be posted.
2. Select Post revaluation.

For information about the other settings, see Specify Intervals and Posting Rules.

Maintain Rules for Transfer of APC Values

Use

In this IMG activity, you specify which acquisition and production cost (APC) values are to be transferred
to the revaluation areas.

Assuming that you want to keep revaluation amounts separate from APC, in revaluation areas of their own,
no APC is to be transferred.

Activities

In the case of revaluation areas, the system will not allow you to transfer APC.

For parallel currency revaluation areas, however, you must enter the revaluation area as the reference area
and specify that the values must be identical.

Maintain Rules for Transfer of Depreciation Terms

Use

In this IMG activity, you ensure that for any given asset, its revaluation amounts are depreciated on exactly
the same terms as its acquisition and production costs (APC).

You do this by specifying that the system is to depreciate the revaluation amounts in the revaluation area
using exactly the same terms that it uses to depreciate the APC in the base depreciation area.

Activities
For each real revaluation area:

1. Inthe TTr field (Depreciation terms transfer), enter the base depreciation area.

2. Do not select Identical; although the terms must be identical, the system will not allow you to create
a revaluation method if you select this indicator.
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Maintain Revaluation Areas

Use

In this IMG activity, you specify:
- Which depreciation area's values are to be revaluated

- Which revaluation area the revaluation amounts are to be recorded in

Maintain Revaluation Measures

Use

In this IMG activity, you create revaluation measures. These are system objects that show which
revaluation area is linked to which depreciation area.

The revaluation measure controls which revaluation area the system takes the revaluation amounts from
when you dispose of an asset: during this procedure, the system calculates any gain or loss on the asset
disposal on the basis of the revaluated asset value.

Activities

Create one revaluation measure for each real revaluation area. Enter data as follows:

- Date: The date on which you first revaluated the assets, so as to ensure that the system takes into
account all of the asset values
- Base Area: The asset's book depreciation area

- Revaluation Area: The asset's revaluation area
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Revaluation Keys

Maintain Revaluation Keys

Use

In these IMG activities, you make the settings that control how each asset is to be revaluated as follows:
1.  Maintain the revaluation keys.

2. Assign a revaluation key to each asset master record.

When you come to run the Asset Revaluation (Inflation) program, it revaluates each asset using the
revaluation key that you have assigned to it.

Activities

In this IMG activity, maintain a separate revaluation key for every group of assets that has to be revaluated
exactly the same way (for example, at different intervals or using different inflation indexes).

If you have assets that must not be revaluated, maintain a revaluation key that results in zero revaluation
amounts each time.

Assign Revolution Keys to Asset Classes

Use

In this IMG activity, you specify the default revaluation key for each asset class with assets that are to be
revaluated.

When you come to create an asset master record, the system automatically assigns it this revaluation key.
You can, however, overwrite it.
Activities

For each asset class, enter a default revaluation key for each revaluation area.

Assign Revaluation Key to Asset Master Record

Use

In this IMG activity, you assign a revaluation key to each asset master record.
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For every asset master record, assign one revaluation key to each revaluation area. For example, if you
have one revaluation area for tax purposes and another for controlling purposes, assign a revaluation key
to each.

This applies to every asset master record, including assets that do not have to be revaluated. These you
must assign a revaluation key that results in zero revaluation amounts.

Activities
Enter the revaluation key in the asset master record maintenance transactions Create Asset Master Record
or Change Asset Master Record as follows:
1. Onthe Deprec. Areas tab, double-click the revaluation area.
2. Choose Data for revaluation.

3. Enter the revaluation key.

Account Determination

Specify Accounts for Revaluation of APC

Use

In this IMG activity, you specify which G/L accounts the system posts revaluation of acquisition and
production costs to.

Revaluation amounts are only recorded in revaluation areas, so you can only carry out this activity for these
areas.
Activities

For each account determination, specify:
- A balance sheet account for the revaluation amounts

- Aninflation gain or loss account

Specify Accounts for Revaluation of Current Year's Depreciation

Use
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In this IMG activity, you specify which G/L accounts the system posts revaluation of the current year's
depreciation amounts to. That includes all of the depreciation amounts up to and including the current
month (but see Split Revaluation of Depreciation below).

Activities

For each account determination, specify:
- Which expense account to debit the inflation gain or loss to
- Which balance sheet account to credit the revaluation amounts to

Technically speaking, instead of revaluating the depreciation amounts, the system calculates the
depreciation on the revaluation amounts. This is reflected in the names of the G/L accounts on the account
assignment screen. The result is, however, the same.

Example

Split Revaluation of Depreciation

If you have activated the split revaluation of depreciation function in the inflation method, the system:
- Debits the revaluation of the current month's depreciation to this balance sheet account (as above)

- Debits the revaluation of depreciation from the previous months in the current year to the same
inflation gain or loss account used for the revaluation of the depreciation from previous years (this is

the effect of the split)
- Credits both to the same balance sheet account (as above)

Specify Accounts for Revaluation of Previous Years' Depreciation

Use

In this IMG activity, you specify which G/L accounts the system posts revaluation of previous year's
depreciation amounts to.

Activities

For each account determination, specify:
- Which expense account to debit the inflation gain or loss to

- Which balance sheet account to credit the revaluation amounts to
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Technically speaking, instead of revaluating the depreciation amounts, the system calculates the
depreciation on the revaluation amounts. This is reflected in the names of the G/L accounts on the account
assignment screen. The result is, however, the same.

Transaction Types
Maintain Transaction Types for Revaluation Amounts

Use
In these IMG activities, you maintain the transaction types that you want the report to use to post
revaluation amounts.

You can also specify that asset transactions you have posted using other transaction types be excluded from
any revaluation, if you need to.

Standard settings

The standard system comes complete with the four transaction types, which you should not need to change.
They are:
Transaction type Description

850 Revaluation of APC in the current year etc. (debit)
855  Revaluation of APC in the current year etc. (credit)
851 Revaluation of APC from previous years etc. (debit)
856  Revaluation of APC from previous years etc. (credit)

Activities
This IMG activity consists of two steps, creating the transaction types and assigning them to the
appropriate revaluation areas.

Creating Transaction Types

If the standard transaction types do not meet your requirements, you can create your own. In that case,
create a total of four transaction types:

- One credit transaction type and one debit transaction type for revaluating acquisition and production
costs (APC) posted in the current year; and the current month's depreciation Use transaction type
group 82 for these two transaction types.
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- One credit transaction type and one debit transaction type for revaluation of APC posted in previous
years and revaluation of all depreciation already posted (in previous years and in the current year)
For both of these transaction types, use transaction group 81.

Assigning Transaction Types to Revaluation Areas

Once you have defined the transaction types, specify which revaluation areas (including parallel currency
areas) the transaction types are valid for. For every area, select Display for selection and deselect Always
post.

Maintain Additional Settings for Inflation Transaction Types

Use

In this IMG activity, you can prevent the system from revaluating values posted with any given transaction
type.

Inflation Methods

Maintain Inflation Methods

Use

In these IMG activities, you:
1. Maintain the inflation methods that you want to use.
2. Assign an inflation method to each company code.

You can assign an inflation method to more than one company code, if they share the same requirements
with regard to inflation.

Standard settings

The system comes complete with sample inflation methods for each country version, which you can use
as the basis for your own inflation methods.

Activities

The inflation method consists of three parts, one each for the different components affected by inflation.
Activate the Inflation Accounting solution for Asset Accounting (FI-AA) and enter other data as
required.
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Assign Inflation Methods to Company Codes

Use
In this IMG activity, you assign an inflation method to each company code that works with the Inflation
Accounting solution.

By doing so, you specify in effect the default settings for the Inflation Accounting programs for the
company code.
Country-Specific Functions

Great Britain

Activate SORP/MHCA Functions

Use

In this IMG activity, you enable the system to:

- Post depreciation write-back with the correct signs in accordance with the requirements of
the
Statement of Recommended Practice (SORP)

- Automatically post revaluations in the capitalization year of the asset in accordance with the
requirements of the Modified Historic Cost Accounting (MHCA) in the UK You can activate
this function by company code.

See also

SAP Library -> SAP ERP Central Component -> Financials -> Country Versions -> Europe and Africa -
> United Kingdom -> Financial Accounting (FI) -> Asset Accounting (FI-AA) -> Revaluation Posting in
Compliance with SORP and MHCA Requirements

Interest
In this section, you define system settings for the automatic calculation of interest on capital tied up in
fixed assets.

The calculation and posting of the interest is carried out in the same way as for automatically determined
depreciation. In this case, account assignment is to the general ledger accounts that are specified for interest
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in the respective account determination/depreciation area. In addition, an additional assignment to the cost
centre of the respective asset is also possible (as it is for depreciation - see Determining period type/account
assignment rules).

Further notes
SAP library FI-AA: Special Valuations of Fixed Assets -> Interest
Determine Depreciation Areas

In this step, you determine the depreciation areas in which you want to calculate interest. This specification
means that this value type is allowed in the depreciation area (that is, the system does not issue an error
message when you enter corresponding depreciation terms in the asset master record).

Recommendation

In most countries, interest calculation on assets is only allowed for cost accounting. If this applies to you,
only allow the calculation of interest in the cost accounting depreciation area.

Requirements

You must have created at least one chart of depreciation of your own.

Standard settings

Depending on the country-specific chart of depreciation, SAP provides depreciation areas for interest
calculation.

Activities

Set the indicator "management of interest™ in the depreciation areas in question.

Assign Accounts

Use

In this activity, you specify the G/L accounts for interest on fixed assets.

Note

The screen layout of accounts that are posted using mass posting are not allowed to require entries in fields
that are not provided with values during background processing.
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Example:

The value adjustment accounts cannot require the mandatory entry of a posting text, since the depreciation
posting program does not create a posting text.

Maintain Depreciation Key

In this step, you define depreciation keys for calculating interest.

The system calculates interest, in the same way as depreciation, using calculation methods. These
calculation methods have to be assigned to the respective depreciation keys as interest calculation keys.

Requirements

You must have created at least one chart of depreciation of your own.

Standard settings

SAP provides standard depreciation keys with interest calculation in each country-specific chart of
depreciation.

Activities
Assign an interest calculation key to depreciation keys.

Further notes (Transport)

You can include the depreciation key in a transport request (Key -> Transport in the overview screen of
the transaction). Note that the definition of the depreciation key only applies in one client. Therefore,
transport is not only necessary between systems (such as, from a test system to a productive system), but
also in order to make the depreciation key available in other clients.

Net worth Tax

In this step, you define the system settings for the valuation of your assets in accordance with net worth
tax requirements. You can manage net worth values in the system in two ways:

- in a depreciation area

- Asavalue you enter manually in the asset master record.

Further notes

SAP library FI-AA: Special Valuations of Fixed Assets -> Net worth Tax
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Specify Depreciation Area

In this step, you indicate the depreciation area that is to be used for net worth tax valuation in each company
code. The standard report for determining the net worth tax burden then accesses this depreciation area.
Standard settings

SAP provides a separate depreciation area for net worth tax that is dependent on the country-specific chart
of depreciation.

Recommendation

If net worth tax valuation in your country is based on normal tax valuations, then you do not need a separate
depreciation area for net worth tax. You can then use the tax valuation depreciation area for net worth tax.

Activities

Enter a depreciation area for net worth tax for each company code.

Create Property Classification Key

In this step, you define allowed values for the property classification key. You can structure the standard
report for net worth tax values using the property classification key, by including it in the corresponding
sort version.

Standard settings

SAP provides property classification keys for various countries.

The first two characters of these property classification keys are the country key. They are provided only
in SAP client 000.

If you want to copy the property classification keys, you can transport the entries with the relevant country
keys from client 000.

Activities

1.  Create the keys that you require.

2. Store these keys in the appropriate asset master records and in the asset class.

Create Property Indicator

In this step, you define allowed entries for the property indicator. Using this indicator, you can divide your
fixed assets into different property types (for example, leased or owned).

If you have different forms of property and want to see them in reporting (for example, for net worth tax),
you can enter this indicator in the sort version.
Activities

1. Create allowed entries for the indicator that meet your requirements.
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2. Enter these in the appropriate asset master records.

Create Reasons for Manual Depreciation

There are several reasons why you might want to set the asset value manually instead of allowing the
system to determine the value automatically. You can specify the reasons using a key. You can store this
key in the asset master record and use it as a sort criterion in reporting.

In this step, you specify the allowed characteristics of this key.
Activities

1. Create the characteristics of the key according to your requirements.

2.  Store these keys in the master records affected.

Define Sort Versions for Net worth Reports

In the same way as for other Asset Accounting standard reports, the formation of groups and totals in the
net worth tax list can also be individually structured and sorted with the help of sort versions.

In this processing step you define sort versions. Sort versions determine the sort keys and summation
criteria for your asset reports.

Standard settings

SAP delivers the following sort versions which you can take over or use as a reference for further versions:

classification for transaction data reports

book depreciation classification

cost-accounting classification

net worth tax classification

classification for insurance values

Actions

1.  Adapt the standard versions to your requirements.

2. Create new sort versions according to your requirements using Edit --> New entries. The key should
begin with X, Y or Z.

3. Specify the sort hierarchy of the sort version via the sequence of field names in the field string
proposed by the system (from top to bottom). You can also specify length and offset for the individual

fields.
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4. When you set the total indicator, the system subtotals at the specified sort level.
5. Additional indicators allow for

- displaying totals per main asset number (with accumulated values of all sub-
numbers)

- Sorting the sub-numbers per main asset number in descending order in this
way, the system displays the most recently created sub-number first.

Further notes

SAP library: Information System -> Sort Versions

Depreciation Key

In this section, you define depreciation keys for the net worth tax valuation of assets in a separate
depreciation area.

Define the Cut-off Value Key

For certain types of valuation, it makes sense, or is legally required, that you end depreciation when a
certain value is reached. You can enter an absolute scrap value in the asset master record. Or you can enter
a percentage scrap value (cut-off value) in the calculation key.

In this step, you define the calculation key for automatically determining scrap values. For each calculation
key, you can specify

- the percentage of the depreciation base that should be used as the cut-off value percentage

- whether the cut-off value percentage should be deducted at the start or the end of the calculation of
depreciation

- atwhat point in time the system should start calculating the validity period

You can enter several cut-off percentages for each scrap value key. You can define the cut-off
percentages/levels per acquisition year, and the validity period can be of any length.

Example

Start of the validity period: Capitalization date

Validity  period: 5  years
Percentage: 5%

=> For assets, that are no more than 5 years old based on their capitalization date, the cut-off percentage
rate of 5% is valid.

Be aware that you have to enter the validity period of the individual percentages or levels of a scrap value
key in cumulative form (level 1: 1 year, level 2: 2 years => levels 1 and 2 each last one year).

Standard settings
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SAP supplies standard scrap value keys. You have to revise the time specifications of the scrap value keys
delivered by SAP.

Activities

1.  Define your own cut-off value key or scrap value key.

- Specify whether the cut-off value/scrap value should be deducted from the base value for
depreciation at the start of depreciation calculation, or if depreciation should stop when the scrap
value is reached.

- Specify the start of calculation of the validity time periods.
- Define the validity periods and the percentage rates for the cut-off value/scrap value.

2.  Enter your cut-off value key in the definitions of the depreciation keys concerned.

Further notes

SAP library FI-AA: Depreciation -> Cut-off Value

Further notes (Transport)

You can include the scrap value key in a transport request in the overview screen of the transaction under
Key -> Transport. Note that the definition of the scrap value key applies in all clients. Therefore, you
only need to transport if you need transports between systems (for example, from a test system to a
production system).

Define Depreciation Keys

In this step, you define depreciation keys for the net worth tax valuation of your complex fixed assets.
Depreciation keys contain the calculation methods for depreciation calculation and parameters that control
- Ordinary depreciation

- Special depreciation

- Scrap value (cut-off value)

- Calculation of interest

You can enter a separate depreciation key for each depreciation area in the asset master record.

Requirements

You must have already created a chart of depreciation.
Standard settings

SAP supplies the country-specific depreciation keys required in each country, for example:
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LINR = Straight-line depreciation from net book value to zero

DG30 = Declining-balance, 3 times straight-line rate
Activities
Define additional depreciation keys to meet your requirements.

Additional hints

SAP Library FI-AA: Depreciation -> Definition of the Depreciation Key
Further notes (Transport)

You can include the depreciation key in a transport request (Key -> Transport in the overview screen of
the transaction). Note that the definition of the depreciation key only applies in one client. Therefore,
transport is not only necessary between systems (such as, from a test system to a productive system), but
also in order to make the depreciation key available in other clients.

Maintain Index Series

The depreciation area for the net worth tax valuation can be indexed (revalued/devalued) the same as all
the other areas using index series.

In this step, you define the index series and the historical index figures for the index series. You need these
index figures if you want to calculate using replacement values. For these types of calculations, you need
to maintain the index figures beginning with the point in time that the oldest asset with an index series was
acquired, up to the time of the takeover of old assets data. The system needs these past index figures in
order to be able to correctly historically calculate the replacement values and insurable values for assets
transferred during the old assets data takeover.

Maintaining the current index figures is part of periodic processing in the application menu of the FI-AA
System.

Caution

It is absolutely necessary that you maintain your index series with the correct index figures before old
assets data is taken over. Index figures of years prior to the data takeover after the old assets data takeover
has taken place can only be changed with considerable effort.

If you do not have any index series at the time of the old assets data takeover, you can still calculate
replacement values for all assets in later fiscal years, even after the productive start of the system. However,
for previous acquisitions, you can then only use index series that provide for "historical calculation™ in
their index class. The current replacement value is calculated as follows with such index series:

Value (curr.year) = APC * index (curr.year) / index (acquis. year)

After calculating the replacement value in this way, you can change to a different index series in the
following year, which calculates on the basis of the replacement value from the previous year.

Activities

1.  Assign a key to the index series.
You can specify this key in the asset master records.
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2. Assign the index series to an index class. The index series specifies

- Whether the index series is age-dependent or year-dependent.
Age-dependent index figures are based on the 'n'th year that the asset has belonged to the asset
portfolio. They show an annual rate of change from the time of the asset acquisition. The year
1 has the index figure 100. Year-dependent index figures relate to the fiscal year or the calendar
year, and show a rate of change in relation to a certain base year. The base year has the index
figure 100.

- Whether the calculation of indexed values should be based on historical APC or on the
replacement value from the previous year.

The difference between the historical calculation and calculation based on the replacement value
of the previous year (normal) becomes clear when looking at a subsequent acquisition to an
asset. When you use historical calculation, the replacement value is determined as if the
subsequent acquisition took place in the capitalization year. Therefore, it makes sense only to
use the historical method if you do not have access to replacement values from the previous
year for the assets taken over from your previous system.

3. Specify the rate of increase (for example, 103% = annual increase of 3%) for the simulation of the
replacement value in future fiscal years.

Via this percentage, you can also calculate replacement values in the current fiscal year, even if the
respective index figures have not yet been determined.

4.  Enter a description of your choice.

5.  Enter the index figures for the individual fiscal years (months, days). For example, 103 means an
increase of 3%.

a) Select the index series to be processed on the list screen.

b)  Select the function Index figures.

Note

Bear in mind that at the present time the index figures in the system always relate to fiscal years
and not to calendar years. If you have a non-calendar fiscal year, you therefore have to
accordingly adapt the time frame of the index figures depending on the calendar year before
entering data into the system.

Define Screen Layout

In this step, you define the screen layout for the part of the asset master record relevant to net worth tax.

In this step, you define the screen layout control for asset master data. The screen layout control contains
the specifications for the field groups in the asset master record. You enter the screen layout control in the
asset class. This method allows you to structure the master record individually for each asset class.

Note

This step must be carried out exactly to guarantee optimal master data maintenance.

Standard settings
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SAP delivers some sample definitions which you can use as references when formulating a more detailed
structure for the asset master.

Activities
1. Create the screen layout control according to your requirements. (You may already have carried out
this step in the "Organizational Structures" section of the FI-AA Implementation Guide.)
2.  Define for the individual field groups

- the characteristics of the master record screen (whether fields are required, optional, display fields or
should be suppressed)

- the maintenance level

whether it can be copied (when creating a new master record using a reference master record)

Caution

The only field that can be suppressed are initial fields (that is, they have no contents). Fields that have
contents are always displayed, regardless of the screen layout. Fields might have contents, despite the
screen layout, for example if

- the screen layout is changed
- the asset data transfer supplies values to suppressed fields

If you want to suppress fields that have contents, you have to define them first as modifiable, and then
delete their contents.

Further notes

SAP Library FI-AA: Master Data Maintenance -> Screen Layout and Tab Layout for Master Data

Further notes

SAP library FI-AA: Master Data -> Screen Layout and Maintenance Level

Modify Asset Classes

In this step, you store default values for net worth tax in your asset classes for asset master data
maintenance.

Requirements

You must have created your asset classes.

Standard settings

SAP provides predefined asset classes (1-8) as examples.

Activities
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1. Store default values for the property indicator and the property classification key for every asset class.

0 Make Chart-of-Deprec.-Specific Entries in Asset Classes

The default values in the asset class generally apply in all clients (that is, regardless of the chart of
depreciation). Therefore, it is sufficient to specify the property classification key once for each asset class.

You need to carry out the following step only if you need country-specific property classification keys (for
each chart of depreciation), as opposed to the much more common situation described above. When you
carry out this step, the system interprets your entries for the property classification key dependent upon the
chart of depreciation in the company code you are in. The system then ignores the property classification
keys that are independent of the chart of depreciation.

Standard settings

The asset classes supplied by SAP do not contain any property classification keys that are country-specific
(and chart-of-depreciation-specific)

Recommendation

In most cases, it is not necessary to enter country-specific property classification keys.
Activities

Enter your country-specific (chart-of-depreciation-specific) property classification keys in your asset
classes.
Further notes

SAP library FI-AA: Organizational Elements -> Functions of the Asset Class

Insurance

In this step, you define the system settings for the valuation and management of your assets in regard to
insurance policies. For this purpose, you can define various information in the asset master record for
insurance policies and insurable values. It is also possible to manage insurable values in their own
depreciation area.

Itis particularly useful to manage insurance data and insurable values in the master record in the following
instances:

- You need certain insurance data for informational reasons (such as liability or collision insurance for
vehicles).

- The valuation methods in the existing depreciation areas (APC, indexed APC, or net book value) do
not meet the needs of valuation for insurance purposes. (Example: fire insurance, electronics

insurance)
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In this step you define the following:
- theinsurance types which you want to use (for example, fire insurance)
- varied master record information for insurance specifications (such as, the insurance company)

- Specifications for the valuation of assets within the framework of insurance policies.
Additional information

SAP library FI-AA: Special Valuations of Fixed Assets -> Insurance Values

Define Insurance Types

In this step, you define the different insurance types that you need for your fixed assets. You can store
these insurance types in the asset master record.

The insurance type contains varied control parameters for determining insurable values (for example, value
as new insurance or current market value insurance.

Activities
If you want to manage insurance data in the master record, you must create insurance types and maintain
them according to your requirements.

Create Insurance Companies

In this step, you define the insurance companies with which your assets are insured. You can store the data
on these insurance companies in the asset master record and use them as a sort criterion for reports (in the
sort version). See also Define sort versions for insurance evaluations.

Activities

1.  Enter your insurance companies in the system.

2. Enter a key and a description for each insurance company.

Create Insurance Rates

In this chapter you define the different insurance premiums for your assets' insurance. You can store these
premiums in the asset master record and use it in the appropriate sort version as a sort criterion for reports
(see also Define sort versions for insurance evaluations).

Activities

1. Specify your insurance premiums.

2. Enter a premium key and a text description for each insurance premium.

WHATSAPP +255738656506



[BECOME A MASTER OF SAP S/4 FINANCIAL ACCOUNTING
{8 CUSTOMIZING]

Define Sort Versions for Insurance Reports

In the same way as for other standard reports in Asset Accounting, you can also individually structure and
sort the group and totals formation in the insurance list with the help of sort versions.

In this processing step you define sort versions. Sort versions determine the sort keys and summation
criteria for your asset reports.

Standard settings

SAP delivers the following sort versions which you can take over or use as a reference for further versions:

classification for transaction data reports
- book depreciation classification

- cost-accounting classification

- net worth tax classification

- classification for insurance values
Actions

1.  Adapt the standard versions to your requirements.

2. Create new sort versions according to your requirements using Edit --> New entries. The key should
begin with X, Y or Z.

3. Specify the sort hierarchy of the sort version via the sequence of field names in the field string
proposed by the system (from top to bottom). You can also specify length and offset for the individual
fields.

4. When you set the total indicator, the system subtotals at the specified sort level.
5. Additional indicators allow for

- displaying totals per main asset number (with accumulated values of all sub-
numbers)

- Sorting the sub-numbers per main asset number in descending order in this
way, the system displays the most recently created sub-number first.

Further notes

SAP library: Information System -> Sort Versions

Maintain Depreciation Key

You only need to perform the following step if you require your own valuation bases for insurance
valuation, and therefore manage a separate depreciation area for insurance.
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In this step, you define depreciation keys for the valuation of your fixed assets in relation to insurance
policies.

Depreciation keys contain the calculation methods for depreciation calculation and parameters that control
- Ordinary depreciation

- Special depreciation

- Scrap value (cut-off value)

- Calculation of interest

You can enter a separate depreciation key for each depreciation area in the asset master record.

Requirements

You must have already created a chart of depreciation.

Standard settings

SAP supplies the country-specific depreciation keys required in each country, for example:

LINR = Straight-line depreciation from net book value to zero
DG30 = Declining-balance, 3 times straight-line rate

Activities
Define additional depreciation keys to meet your requirements.

Additional hints

SAP Library FI-AA: Depreciation -> Definition of the Depreciation Key
Further notes (Transport)

You can include the depreciation key in a transport request (Key -> Transport in the overview screen of
the transaction). Note that the definition of the depreciation key only applies in one client. Therefore,
transport is not only necessary between systems (such as, from a test system to a productive system), but
also in order to make the depreciation key available in other clients.

Maintain Index Series

The depreciation area for valuation for insurance purposes can be indexed (revalued/devalued) the same
as all the other areas using index series. It is also possible to index an insurable value that was manually
stored in the asset master record or the base insurable value.

In this step, you define the index series and the historical index figures for the index series. You need these
index figures if you want to calculate using replacement values. For these types of calculations, you need
to maintain the index figures beginning with the point in time that the oldest asset with an index series was
acquired, up to the time of the takeover of old assets data. The system needs these past index figures in
order to be able to correctly historically calculate the replacement values and insurable values for assets
transferred during the old assets data takeover.
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Maintaining the current index figures is part of periodic processing in the application menu of the FI-AA
System.

Caution

It is absolutely necessary that you maintain your index series with the correct index figures before old
assets data is taken over. Index figures of years prior to the data takeover after the old assets data takeover
has taken place can only be changed with considerable effort.

If you do not have any index series at the time of the old assets data takeover, you can still calculate
replacement values for all assets in later fiscal years, even after the productive start of the system. However,
for previous acquisitions, you can then only use index series that provide for "historical calculation" in
their index class. The current replacement value is calculated as follows with such index series:

Value (curr.year) = APC * index (curr.year) / index (acquis. year)

After calculating the replacement value in this way, you can change to a different index series in the
following year, which calculates on the basis of the replacement value from the previous year.
Activities

1. Assign a key to the index series.
You can specify this key in the asset master records.

2. Assign the index series to an index class. The index series specifies

- Whether the index series is age-dependent or year-dependent.

Age-dependent index figures are based on the 'n'th year that the asset has belonged to the asset
portfolio. They show an annual rate of change from the time of the asset acquisition. The year
1 has the index figure 100. Year-dependent index figures relate to the fiscal year or the calendar
year, and show a rate of change in relation to a certain base year. The base year has the index
figure 100.

- Whether the calculation of indexed values should be based on historical APC or on the
replacement value from the previous year.

The difference between the historical calculation and calculation based on the replacement value
of the previous year (normal) becomes clear when looking at a subsequent acquisition to an
asset. When you use historical calculation, the replacement value is determined as if the
subsequent acquisition took place in the capitalization year. Therefore, it makes sense only to
use the historical method if you do not have access to replacement values from the previous
year for the assets taken over from your previous system.

3. Specify the rate of increase (for example, 103% = annual increase of 3%) for the simulation of the
replacement value in future fiscal years.

Via this percentage, you can also calculate replacement values in the current fiscal year, even if the
respective index figures have not yet been determined.

4.  Enter a description of your choice.

5. Enter the index figures for the individual fiscal years (months, days). For example, 103 means an
increase of 3%.

a) Select the index series to be processed on the list screen.
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b)  Select the function Index figures.

Note

Bear in mind that at the present time the index figures in the system always relate to fiscal years
and not to calendar years. If you have a non-calendar fiscal year, you therefore have to
accordingly adapt the time frame of the index figures depending on the calendar year before
entering data into the system.

Define Screen Layout

In this step, you define screen layout for the part of the asset master record related to insurance.

In this step, you define the screen layout control for asset master data. The screen layout control contains
the specifications for the field groups in the asset master record. You enter the screen layout control in the
asset class. This method allows you to structure the master record individually for each asset class.

Note

This step must be carried out exactly to guarantee optimal master data maintenance.

Standard settings

SAP delivers some sample definitions which you can use as references when formulating a more detailed
structure for the asset master.

Activities
1. Create the screen layout control according to your requirements. (You may already have carried out
this step in the "Organizational Structures"” section of the FI-AA Implementation Guide.)
2.  Define for the individual field groups

- the characteristics of the master record screen (whether fields are required, optional, display fields or
should be suppressed)

- the maintenance level

whether it can be copied (when creating a new master record using a reference master record)

Caution

The only field that can be suppressed are initial fields (that is, they have no contents). Fields that have
contents are always displayed, regardless of the screen layout. Fields might have contents, despite the
screen layout, for example if

- the screen layout is changed
- the asset data transfer supplies values to suppressed fields

If you want to suppress fields that have contents, you have to define them first as modifiable, and then
delete their contents.

Further notes
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SAP Library FI-AA: Master Data Maintenance -> Screen Layout and Tab Layout for Master Data

Further notes

SAP library: Master Data -> Screen Layout and Maintenance Level

Modify Asset Classes

In this step, you store insurance-specific default values in your asset classes for asset master data
maintenance.
Requirements

You must have created your asset classes.

Standard settings

SAP provides predefined asset classes (1-8) as examples.
Activities

Specify default values for the insurance type, insurance company and so on, for every asset class.

Make Chart-of-Deprec.-Specific Entries in Asset Classes

The default values in the asset class generally apply in all clients (that is, regardless of the chart of
depreciation). Therefore, it is sufficient to specify the insurance type/index series once for each asset class.

You need to carry out the following step only if you need country-specific insurance types/index series
(for each chart of depreciation), as opposed to the much more common situation described above. When
you carry out this step, the system interprets your entries for the insurance type/index series dependent
upon the chart of depreciation in the company code you are in. The system then ignores the insurance
types/index series that are independent of the chart of depreciation.

Standard settings

The asset classes supplied by SAP do not contain any insurance types/ index series that are country-specific
(and chart-of-depreciation-specific)

Recommendation

In most cases, it is not necessary to enter country-specific insurance types/index series.

Activities
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Enter your country-specific (chart-of-depreciation-specific) insurance types/index series in your asset
classes.

Further notes

SAP library FI-AA: Organizational Elements -> Functions of the Asset Class

Preparations for Consolidation

In the following section, you make system settings which allow you to easily carry out legal
Consolidation, from the asset accounting side, based on FI-AA data.

Note

These settings mostly concern the features of transaction types. You make the general definition of
transaction types in Transactions.

Further notes

SAP library FI-AA: Special Valuations of Fixed Assets -> Preparations for Consolidation

Specify Consolidation Transaction Types for APC Transactions

The detailed classification of accounting transactions using the transaction types in Asset Accounting is
not useful for legal consolidation. Usually, a more general classification is sufficient. Therefore, in this
activity, you can group FI-AA transaction types together for legal consolidation. You can make this
grouping by assigning a common transaction type to all FI-AA transaction types in a transaction category,
for consolidation purposes. This consolidation transaction type is generally the FI-AA transaction type
used for the corresponding transaction category.

Example

For example, all transaction types for external acquisitions can receive the same legal consolidation
transaction type 100 (purchase acquisition).

Standard settings
Corresponding consolidation transaction types are assigned to the standard transaction types of the system.
Activities

Assign the same consolidation transaction type to the FI-AA transaction types of a transaction category.

WHATSAPP +255738656506



[BECOME A MASTER OF SAP S/4 FINANCIAL ACCOUNTING
{8 CUSTOMIZING]

Specify Transaction Types for Proportional Value Adjustments

Use

For consolidation purposes, it is necessary to post the APC retirement and the retirement of proportional
value adjustments with different transaction types for a fixed asset retirement. This has the effect that these
two items remain separable for the legal consolidation, although they are posted to the same consolidated
item.

In this activity, you enter the transaction types that the system uses to post the retirement of proportional
value adjustments in each asset retirement transaction type.

Standard settings

Transaction types of this kind are assigned to the standard asset retirement transaction types in the system.
Activities

Assign transaction types for posting the retired proportional value adjustments to the transaction types for
fixed asset retirements for each depreciation type.

Specify Group Depreciation Areas

Use

Asset transfers between affiliated companies represent an acquisition or a retirement from the point of view
of the participating individual companies. From the point of view of the corporate group, it is a transfer.
The business transaction is posted as an acquisition or a retirement. Nevertheless, the business transaction
should appear as a transfer from a consolidation point of view.

In this activity, therefore, you can specify that the system represents transfers between affiliated companies
correctly as transfers in reports for the corporate group. You can make this specification per depreciation
area.

Standard settings

The standard depreciation areas for legal consolidation can be recognized by their names.

Activities
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Set the Transfer Gross indicator for the group depreciation areas. This has the effect that asset transfers
are not represented in these areas as acquisitions or retirements but as transfers (particularly in the asset
history sheet).

Leasing

In this section, you define system settings for the management of leased assets. In addition, you can define
sort versions for leasing reports.

Define Leasing Types

In the FI-AA system, leased assets can be -

managed as statistical assets (without values)

- Capitalized according to the capital lease method.

In this step, you define the leasing types for the valuation of leased assets which must be capitalized. You
specify the leasing type in the asset class or in the asset master record. You can classify your leased assets
with the leasing type. The leasing type also contains the essential parameters for posting the acquisition of
an asset that is to be capitalized using the capital lease procedure (such as, transaction type). The system
determines the accounts to be posted and the amount to be capitalized with the help of the following
relevant values:

- active depreciation areas in the respective asset class
- leasing conditions in the asset master record

In this way, you can capitalize leased assets according to the capital lease method using the present value
of future payments.

Note

This capitalization using the capital lease method is only possible at the present time (Release 3.0), if the
book depreciation area is included. If you want to capitalize a leased asset only in the cost accounting
depreciation area, then you have to do it manually. You have to use special transaction types, which only
post to the depreciation areas you want.

Default settings

SAP provides one leasing type as an example (leasing type 1).

Actions

Create your own leasing types according to your requirements.
Define the following for acquisition posting:
- transaction type

- document type
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input tax code

posting key

Further notes

SAP library: Special Valuations of Fixed Assets -> Valuation Methods for Leased Assets

Define Sort Versions for Leasing Reports

In the same way as all the other standard reports of Asset Accounting, the leasing evaluations can be
individually structured or sorted with the help of sort versions.

In this processing step you define sort versions. Sort versions determine the sort keys and summation
criteria for your asset reports.

Standard settings

SAP delivers the following sort versions which you can take over or use as a reference for further versions:

classification for transaction data reports
book depreciation classification
cost-accounting classification

net worth tax classification

classification for insurance values

Actions

Adapt the standard versions to your requirements.

Create new sort versions according to your requirements using Edit --> New entries. The key should
begin with X, Y or Z.

Specify the sort hierarchy of the sort version via the sequence of field names in the field string
proposed by the system (from top to bottom). You can also specify length and offset for the individual
fields.

When you set the total indicator, the system subtotals at the specified sort level.
Additional indicators allow for

- displaying totals per main asset number (with accumulated values of all sub-
numbers)

- Sorting the sub-numbers per main asset number in descending order in this
way, the system displays the most recently created sub-number first.

Further notes
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SAP library: Information System -> Sort Versions

Define Screen Layout

In this step, you define screen layout for the part of the asset master record that is related to leasing.

In this step, you define the screen layout control for asset master data. The screen layout control contains
the specifications for the field groups in the asset master record. You enter the screen layout control in the
asset class. This method allows you to structure the master record individually for each asset class.

Note

This step must be carried out exactly to guarantee optimal master data maintenance.

Standard settings

SAP delivers some sample definitions which you can use as references when formulating a more detailed
structure for the asset master.

Activities
1. Create the screen layout control according to your requirements. (You may already have carried out
this step in the "Organizational Structures” section of the FI-AA Implementation Guide.)
2.  Define for the individual field groups

- the characteristics of the master record screen (whether fields are required, optional, display fields or
should be suppressed)

- the maintenance level

whether it can be copied (when creating a new master record using a reference master record)

Caution

The only field that can be suppressed are initial fields (that is, they have no contents). Fields that have
contents are always displayed, regardless of the screen layout. Fields might have contents, despite the
screen layout, for example if

- the screen layout is changed
- the asset data transfer supplies values to suppressed fields

If you want to suppress fields that have contents, you have to define them first as modifiable, and then
delete their contents.

Further notes

SAP Library FI-AA: Master Data Maintenance -> Screen Layout and Tab Layout for Master Data
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Modify Asset Classes
In this step, you store leasing-specific default values in your asset classes for leased assets.
Requirements

You must have created your asset classes creating asset classes.
Standard settings

SAP provides predefined asset classes (1-8) as examples.
Activities

Store default values for the leasing partner, leasing period and so on, for every asset class.

Master Data

In the step "Master data”, you can make the necessary system settings related to master data maintenance
in the FI-AA System. In addition, you can define evaluation groups and your own match codes.

Screen Layout

In this section, you define the structure of your asset master records with the help of screen layout rules.
In these screen layout rules, you can assign features to the individual master record fields (for example, if
the fields can be changed, or if they are suppressed completely).

Further notes

SAP library FI-AA: Master Data -> Screen Layout and Maintenance Level

Define Screen Layout for Asset Master Data

In this step, you define the screen layout control for asset master data. The screen layout control contains
the specifications for the field groups in the asset master record. You enter the screen layout control in the
asset class. This method allows you to structure the master record individually for each asset class.

Note

This step must be carried out exactly to guarantee optimal master data maintenance.
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SAP delivers some sample definitions which you can use as references when formulating a more detailed
structure for the asset master.

Activities

1. Create the screen layout control according to your requirements. (You may already have carried out
this step in the "Organizational Structures" section of the FI-AA Implementation Guide.)
2.  Define for the individual field groups

- the characteristics of the master record screen (whether fields are required, optional, display
fields or should be suppressed)

- the maintenance level

- whether it can be copied (when creating a new master record using a reference master record)

Caution

The only field that can be suppressed are initial fields (that is, they have no contents). Fields that have
contents are always displayed, regardless of the screen layout. Fields might have contents, despite the
screen layout, for example if

- the screen layout is changed
- the asset data transfer supplies values to suppressed fields

If you want to suppress fields that have contents, you have to define them first as modifiable, and then
delete their contents.

Further notes

SAP Library FI-AA: Master Data Maintenance -> Screen Layout and Tab Layout for Master Data

Define Screen Layout for Asset Depreciation Areas

In this step you define the screen layout control for the depreciation terms (depreciation key, useful life,
and so on) in the asset master record. This screen layout control is similar to the one for the general master
data section of the asset master record. You can use it in a similar way to control the features of the
depreciation areas in the asset master record. It is possible to make different specifications in each
depreciation area.

Default settings
SAP delivers two standard versions:
- depreciation on main number level

- depreciation on sub-number level

You can take over these screen layout controls without changing them.

Activity
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1. Create your own screen layout controls, if needed. Copy one of the standard screen layout controls
for this.

For the individual field groups, define

- the characteristics of the master record screen (whether fields are required, optional, or should
be suppressed)
- the maintenance level

- And whether it can be copied (when using a master record as a reference for setting up another
master record).

2. Enter the screen layout control in the asset class (see Determine class valuation).

Specify Tab Layout for Asset Master Record

Because of the large number of fields that it can contain, the asset master record in the Asset Accounting
(FI-AA) component is divided up into several tab pages (that look like index cards). In this step, you define
the layout of these tab pages (the tab layout).

You can specify which tab pages are seen for each asset class (or if needed, by chart of depreciation within
the asset class). For each tab page, you can specify which field groups appear in which positions on the tab
page.

Note

Any field groups that contain required entry fields must appear on a tab page in the master record.

Requirements

You must have already created your asset
classes.

Standard settings

SAP supplies a tab layout rule containing all field groups.
Activities

1. Create tab layout rules.
- Enter keys and descriptions for the tab layout rules.

- Define the tab pages to be used in the layout rule (New entries) and specify the position and
the title of the tab page.

The maximum number of tab pages is eight.

- For each tab page, specify the field groups that should appear, and the positions in which they

should appear.
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- The maximum number of field groups allowed on a tab page is seven.
- Specify the positions of the tab pages.
2. Assign each of your asset classes’ one tab layout rule.

3. You can also make the layout rules dependent on the chart of depreciation. To do so, enter a different
layout rule within the asset class for each chart of depreciation.

If you do not make any chart-of-depreciation-dependent entries, the layout rule you enter applies to
The entire asset class.

Process Selection Criteria

In this step, you make specifications for the "My assets"” and "Assets on my cost centre™ Web transactions
(transactions for displaying and editing fixed assets in the Internet/Intranet). For each of these transactions,
you specify the selection criteria that are available for selecting assets when you call the transaction. In
addition, you specify the standard selection criteria that are presented when you start each of these
transactions.

Activate Country-Specific Data

Use

In this IMG activity, you activate tables containing asset master data fields that are required in individual
countries only.

After you activate the tables, you determine the appearance and set-up of the screen layout in which you
want to include the country-specific fields. For example, you add tab pages to store additional data.

Note: If required, create a country-specific asset class (see Define Asset Classes).

Standard settings

The standard system comes with additional tables for country-specific asset master data, for example, in
Russia and Japan. You cannot add any tables of your own.

Constraints
The following functions do not support the fields that you activate here:
- Creation of asset master records with reference to an existing asset
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- Substitutions and validations (see the IMG activities Define Validation and Define Substitution)

- Mass changes
Example

Assume that you are in Russia, and you want to create asset master data for vehicles. Since vehicles are
liable to transport tax, and since you are required to file detailed transport tax returns each year, you need
to store such details about each vehicle, such as the taxable horsepower, tax exemptions, and license plate
numbers.

First, in this IMG activity, you activate the tables with general data and transport tax data for Russia.

You then customize the asset classes and the screen layouts as follows:

Asset Classes

IMG Activity What to Do

Define Asset Classes Create a new asset class for vehicles.
Create Screen Layout Rules Create a new screen layout rule for vehicles in Russia.

Specify Chart-of-Dep.-Dependent Screen Layout/Acct Assignment Assign the new screen layout rule
to the new asset class.

Screen Layout

1. Inthe IMG activity Specify Tab Layout for Asset Master Record, sub activity Define Tab Layout
for Asset Master Data, copy the standard layout GIRU (Standard Layout for Russia). This
layout contains a tab page with the Russian data.

2. To assign your country-specific tab layout to country-specific asset classes, perform the following
steps in the sub activity Assign Tab Layouts to Asset Classes:

a) Select the asset class that you want to assign your new layout to and double-click General
Assignment of Layout.

b)  Assign the new tab layout to the appropriate transaction group, for example, Asset Accountant.
To perform this assignment, in the line for the required transaction group, select your tab layout
in the Tab Layout column.

3. To determine the status of the fields in the asset master record, create your own screen layout, by
choosing the sub activity Create Screen Layout Rules for Asset Master Record in the IMG activity
Define Screen Layout for Asset Master Data.

4. To determine which master data fields appear in your screen layout, and which are mandatory and
optional fields, call the sub activity Define Screen Layout for Asset Master Data in the IMG
activity Define Screen Layout for Asset Master Data, -> Define Screen Layout for Asset Master
Data.

a) Select the screen layout that you created in the IMG activity Create Screen Layout Rules for
Asset Master Record above, and double-click Logical Field Groups.

b) To determine which fields in your screen group are required and optional, select the required
logical fields groups (201 and 202 in this example), and double-click Field Group Rules.
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c) Set each of the field groups to require or Optional, and select Sub no (Entry allowed in asset
sub number).
See also

SAP Library -> SAP ERP Central Component -> Financials -> Country Versions -> Russia -> Financial
Accounting (FI) -> Asset Accounting (FI-AA) -> Customizing -> Customizing for Asset Master Data

User Fields

In this section, you define the allowed characteristics of

- asset master record fields which are provided for user-defined use (such as the evaluation groups and
asset super numbers)

- afield for indicating environmental protection measures
- a field for the reason for a capital investment

You can use these fields, just as any other master record fields, as selection criteria in reporting (under
Dynamic selections) You can also use user-defined fields when defining sort versions. See Define sort
versions).

Further notes

SAP library FI-AA: Master Data -> User Fields

Define 4-Character Evaluation Groups

The evaluation groups are another option for classifying assets for reports or user-defined match codes.
You can use five different evaluation groups (four with 4 characters, and one with 8 characters). You can
store the characteristics for these groups in the asset master record.

In this step, you define the characteristics of the 4- character evaluation groups.

Note

You can enter the valid entries for these evaluation groups in a check table, but you do not necessarily
have to define them there. The system uses the following logic:

If at least one entry is defined for an evaluation group in the check table, the system checks the values
entered in the asset master record against this table. If no entries are defined in the check table (table
empty), the system does not check the entries to see if they are valid. In this case you can enter any
evaluation group you like.

Activities

Create the characteristics for the individual evaluation groups (numbers 1 - 4).
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Define 8-Character Evaluation Groups

In this step, you define the characteristics for the eight-character evaluation group.

Note

You can enter the valid entries for these evaluation groups in a check table, but you do not necessarily
have to define them there. The system uses the following logic:

If at least one entry is defined for an evaluation group in the check table, the system checks the values
entered in the asset master record against this table. If no entries are defined in the check table (table
empty), the system does not check the entries to see if they are valid. In this case you can enter any
evaluation group you like.

Activities

Create the characteristics for the evaluation group.

Change Key Words in the Evaluation Groups

In this step, you can change the standard key words of the evaluation groups. In this way, you can assign
your own names to the individual evaluation groups. The system then replaces the standard key words
with your key words. Your names then appear in all screens, in reporting, and in the short text of the field
help.

Example

For example, you can replace the key word "Evaluation group 1” with the key word "Type of acquisition."
Then under the evaluation group you might have 0001 "Coin Interface”, 0002 "Manual," and so on.

Standard settings

In the standard system, the evaluation group has the key word "Evaluation group X" (X = 1 to 5) and the
corresponding abbreviations.

Activities

Change the key words of the evaluation groups which you want to have a specific meaning:
- for short, middle and long texts in screens
- for column headings

- for ashort description in the field help

Note
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It is essentially possible to change the key words of all data elements in the system (Transaction CMOD -
> Text enhancements). For more information, see the documentation in the chapter "Text extensions" in
the online manual for the transaction CMOD (under Help).

Define Reason for Investment

In this step, you define the allowed characteristic values for the master data field "investment reason."

The reason for investment allows you to classify asset investments according to their purpose (for example,
as a replacement acquisition as an addition). You can define as many investment reasons as needed. You
store the characteristic values for the investment reason

- in the asset master record ( FI-AA)
- or in the program positions ( IM-FA )

You can use them as sort keys for reporting.

Standard settings

The standard SAP system includes various reasons for investment (for example, “replacement
investment").

Activities

Define any additional reasons for investment which you require.

Define Environmental Protection Indicator

In this step, you define the environmental protection indicator.

The environmental protection indicator allows you to categorize investments that are used for
environmental protection according to your own individual criteria. You can define as many allowed
entries for the indicator as you need. You can then store them in the master records where they are needed.
These can be master records of:

- Assets (FI-AA component)
- Program positions (IM-FA component)
- Measures and appropriation requests (IM-FA component)

The environmental protection indicator can be evaluated in in standard reports.

Standard settings

SAP provides the following standard definitions for the environmental protection indicator:
- Waste management

- Water purity protection

- Noise reduction
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- Air purity protection

Nature conservation and landscape maintenance

- Soil detoxification
Activities

Define further entries if necessary.

Define Asset Super Number

Asset super numbers allow assets to be classified according to any criteria. You can define as many asset
super numbers as you want. You can store super number characteristics in the asset master record and use
them as sort criteria in reporting.

In this section you define the applicable characteristics for the master record field "Asset super number".

Note

If you do not define any asset super number characteristics in this step, you can enter any values in the
filed "Asset super number" in the asset master record. No check is run.

Standard settings

The standard SAP system does not contain asset super numbers.
Activities

Define applicable characteristics for the asset super number.

Further notes

SAP library FI-AA: Master Data -> Asset Super Number

Enter Your User Fields in Asset Class

In this step, you enter allowed values for your own user fields in your asset classes. Then depending on the
definition in the screen layout control, these allowed values can be used as defaults in master data
maintenance.

Requirements

You must have created asset classes.

Standard settings
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For example, SAP provides predefined asset classes (1-8).
Activities

1.  Store the allowed values of your user fields that the system is to use as default values when creating
fixed assets.

Enter Chart-of-Deprec.-Dependent User Fields in Asset Class

The default values in the asset class generally apply in all clients (that is, regardless of the chart of
depreciation). Therefore, it is sufficient to specify the evaluation groups (4 character) once for each asset
class.

You need to carry out the following step only if you need country-specific 4-character evaluation groups
(for each chart of depreciation), as opposed to the much more common situation described above. When
you carry out this step, the system interprets your entries for the evaluation group dependent upon the chart
of depreciation in the company code you are in. The system then ignores the evaluation groups that are
independent of the chart of depreciation.

Standard settings

The asset classes supplied by SAP do not contain any evaluation groups that are country-specific (and
chart-of-depreciation-specific)

Recommendation
In most cases, it is not necessary to enter country-specific evaluation groups.
Activities

Enter your country-specific (chart-of-depreciation-specific) 4-character evaluation groups in your asset
classes.

Further notes

SAP library FI-AA: Organizational Elements -> Functions of the Asset Class

Develop Enhancement for User Fields in Asset Master Record

In this step, you define your own user fields with the help of an enhancement project. You can add these
fields to the asset master record. You can include these user fields in reports in Asset Accounting. They
are then available both when you define sort versions, as well as for dynamic selections.

Note

Enhancement projects function on the basis of certain positions in standard SAP programming code that
have been prepared by SAP to allow the call of function modules programmed by the user to meet his/her
specific requirements. Therefore, it is possible to implement enhancement projects only if you have
knowledge of the ABAP/4 programming language.
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Recommendation

You should review your needs carefully. Generally, you should not need to use enhancement projects,
since all common requirements are already met by the standard system functions.

Activities
1. Modify function modules EXIT_SAPL1022_001, EXIT_SAPLAIST_002 and
EXIT_SAPLAIST_003 to meet your requirements.

2. Activate a customer enhancement project (with any key) using SAP enhancement AIST0002.

Further notes
For more information, refer to the documentation for customer enhancement AIST0002 (transaction
SMOD).

For an overview of the customer enhancements in Asset Accounting, refer to the SAP Library under
"Customer Enhancements (Customer EXits)".

For general information on customer enhancements, refer to the documentation for transaction CMOD (the
"Information™ pushbutton).

Automatic Creation of Equipment Master Records

In this step, you set up a process that supports the integration of the Asset Accounting (FI-AA) and Plant
Maintenance (PM) applications, so that the creation and changing of master data in both components are
linked.

Specify Conditions for Synchronization of Master Data

Use

In this IMG activity, you make specifications for the synchronization of asset master records and equipment
master records.

First you assign an equipment category and/or an object type (type of technical object) to an asset class.

This assignment determines the following when you later create an object (for example, an asset master
record):

- Whether a dependent object (for example, an equipment master record) should be created
automatically

- How this object is categorized (for example, which equipment category is used for the automatically

created equipment)
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Then you specify how the dependent object is to be created. Here there are two options. The object is
created:

- Immediately once the original object is saved (that is, by the system)

- With the extra check of a workflow event that is triggered when the original object is saved (that is,
after a workflow is executed by a user, giving opportunity for checks).

Possible Settings from the Perspective of Asset Accounting

From the perspective of Asset Accounting, you can choose one of the following settings for the creation
of equipment master records under Edit Asset Master Record:

- No synchronization

When you create the asset master record, the system does not propose an equipment. If you decide to
manually create equipment master records for the asset, then the system does not synchronize the
master data in any way.

- Direct synchronization after saving

When you create an asset master record, the system proposes an equipment. When you save the asset,
the system automatically creates the equipment master record for it, and establishes the link between
the two master records. Later changes to the asset master record can be reflected in the equipment
master record, as well as vice versa.

- Saving triggers a workflow

When you create an asset master record, the system proposes an equipment. When you save the asset,
the system triggers a given workflow event. The results depend on the specifications in the assigned
workflow. For example, it may require notification and approval of a responsible person. When the
workflow is executed, the system normally created the equipment master record for it, and establishes
the link between the two master records. Later changes to the asset master record can be reflected in
the equipment master record, as well as vice versa.

- Direct synchronization plus workflow

When you create an asset master record, the system proposes an equipment. When you save the asset,

the system automatically creates the equipment master record for it, and assigns the asset to it. At the

same time, a workflow event is triggered.
If the system now automatically creates an equipment master record when the asset is saved ( directly or
per workflow), then the system not only assigns the asset number in the equipment master record, but also
saves a synchronization mode, as long as one was entered in Customizing (under Edit Asset Master
Record for changing equipment master records). The synchronization mode specifies how and if future
changes to the asset master record are reflected in the equipment. You can also specify that the
synchronization mode can activate synchronization for already existing assignments between assets and
equipment.

Example
You assign asset class 3100 (Vehicles) to equipment category M (Machines) and choose, under Edit
Asset Master Record, for
- Create Equipment the setting Saving triggers a workflow
- Change Equipment the setting Direct synchronization after saving

When you create an asset in asset class 3100 with cost centre 1000, the system first starts a workflow
event, since you made the setting saving triggers a workflow for creating equipment. If you have set
up a suitable workflow, and this is executed, the system automatically creates an equipment master record
in category M (also with cost centre 1000). The system enters the number of the asset in the equipment
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master record. In addition, it enters the direct synchronization after saving setting as the
synchronization mode.

If you then later change the cost centre in the asset master record to 4110, the system directly synchronizes
the equipment master record, that is, the cost centre is changed there as well to 4110. (Since the
synchronization mode direct synchronization after saving was set.)

Notes

- You can also make the same settings from the perspective of Plant Maintenance (under Edit
Equipment Master Record).

- You specify which master data fields are considered during synchronization in the Assign Master
Data Fields of Assets and Equipment IMG activity.

- If you want to automatically generate equipment master records when creating asset master records,
you should assign an equipment category to the asset class, since the equipment category is mandatory
for creating equipment. Or you could use an enhancement project for Customer Exit AAPMO0001 that
allows you to specify the equipment category each time you create an asset master record.

Note that an asset class can be assigned at most to one combination of equipment category and object
type. On the other hand, more than one asset class can assigned to the same combination.

- If you later also want to be able to automatically create asset master records when you create
equipment master records, then you should ensure that the assignment is unique in both directions.
That is, you should not assign the same combination of equipment category and object type to more
than one asset class. Otherwise, when you create the equipment master record, direct synchronization
is not possible, since the system cannot uniquely determine the asset class.

- Also consider the fact that the asset master record allows you to enter certain time-dependent data,
such as the cost centre. You can make changes to time-dependent data that actually may not take
effect until a future date. In equipment master data, on the other hand, changes to master data are
immediately effective on the day the change is made. Changes effective in the future are not
supported.

For this reason, the synchronization reflects only data valid on the given day. For the time-dependent
data in the asset master record, this means that the system synchronizes only those fields that contain
the time period that includes today's date. Any planned changes are not taken into account. Not just
for this reason, you should consider if creating and changing asset master data from the equipment
master record would be better carried out using workflow.

- Remember that a direct synchronization means that each time there is a change to the assigned master
record, this results in the transfer of all attributes relevant to the synchronization. This can lead to
undesired changes in master data, especially when a direct synchronization was set up for existing
master records, specifically if there are differences in synchronization-relevant attributes.

- In the case of n: 1 assignments (more than one equipment master record assigned to the same asset
master record), you should consider the various possible constellations carefully before choosing
direct synchronization. It may be better here also to choose synchronization using Workflow (in both
directions) to allow for more checks.

- For more information, for example on sample workflows provided by SAP, refer to SAP Note 370884
(and related notes).
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Assign Master Data Fields of Assets and Equipment

Use
In this IMG activity, you assign fields from Asset Accounting (FI-AA) to fields in Plant Maintenance (PM)
for the synchronization of asset and equipment master data.

If you made appropriate settings in the Specify Conditions for Synchronization of Master Data IMG
activity, then for example, when you create an asset master record, the system automatically creates an
equipment master record, and synchronizes the fields of the equipment master record, based on the field
assignments.

On the other hand, the system can also (depending on the settings you make) automatically create an asset
master record when you create an equipment master record.

Example

You assign the cost centre field of Asset Accounting to the cost centre field of Plant Maintenance.

When you create an asset, the cost centre entered in the asset master record is automatically adopted in
The equipment master record, which is created automatically.

Standard settings

SAP provides certain standard assignments for master data fields.
Activities
1. Deactivate assignments that you do not need. You can re-activate them easily at a later point if you
need them, without having to set them up again.

2. You can make additional field assignments, by choosing additional fields from Asset Accounting and
assigning them to fields in Plant Maintenance. The available Asset Accounting fields are found in the
SAAPM1 DDIC structure, while fields for Plant Maintenance are found in the SAAPM2 DDIC
structure.

3. Activate the assignments, if you have made new ones.

If you want to make your own, even more specific assignments, you can create an enhancement project for
customer exit AAPMO0001. Using this project, you can add additional fields to the SAAPM1 and SAAPM?2
structures, for which you can then make your assignments.

Notes

- The system does not perform a check on the assignments you make. You have to check to ensure that
the assignments you make are logical.

- For more information, refer to SAP Note 370884 (and possibly related SAP Notes).
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Develop Enhancement for Field and Class Assignment

Use

In this IMG activity, you can change and expand the field assignments made in Customizing for the
synchronization of equipment and asset master records, using a customer enhancement project (for
customer exit AAPM0001). You can

- Program your own search logic for finding the asset class when an asset master record is created
automatically (from data in Plant Maintenance)

- Program your own search logic for finding the equipment category when an equipment master record
is created automatically (from data in Asset Accounting)

- Define your own fields and field assignments in Asset Accounting and Plant Maintenance for
synchronized creation and changing of master data and vice versa
Note

Enhancement projects function on the basis of certain positions in standard SAP programming code that
have been prepared by SAP to allow the call of function modules programmed by the user to meet his/her
specific requirements. Therefore, it is possible to implement enhancement projects only if you have
knowledge of the ABAP/4 programming language.

Standard settings

In Customizing, SAP provides certain assignments for master data fields.

Recommendation

You should review your needs carefully. Generally, you should not need to use enhancement projects,
since all common requirements are already met by the standard system functions.

Activities

If you really need to change and expand the existing assignments, then you have the following options:

- Implement function module EXIT_SALAAPM_001 in order to derive the asset class from data in
Plant Maintenance.

- Implement function module EXIT_SALAAPM_002 in order to derive the equipment category from
data of Asset Accounting.

- Enhance structures CI_SAAPM1 and CI_SAAPM2 so that you can make more comprehensive
changes to assignments for master data fields

Further notes
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For general information on customer enhancements in Asset Accounting, refer to the SAP Library
Accounting -> Financial Accounting -> Asset Accounting -> Customer Enhancements
(Customer EXxits).

For more information on user exit AAPMO0001, see the documentation on the enhancement (transaction
CMOD). Also refer to SAP Note 370884 and related Notes.

Specify Time-Independent Management of Organize. Units

In this step, you specify that the organizational assignments "business area” and "cost centre” are not
managed as time-dependent in the asset master record. This means that it is then not possible to define
time intervals for these fields for the assignment to different business areas or cost centres at different
times. Once you make this specification, then you can only enter one value for these fields, which is valid
in all time intervals.

You need to make this specification if the following applies: You want to be able to change the assignment
to a business area or cost centre using a simple master data transaction, although you create balance sheets
at the business area level or profit centre level. The system then automatically creates a transfer document
when you make this master data change to the business area or cost centre.

The cost centre is used here since the system uses the cost centre to indirectly determine the profit centre.

If you choose to manage these fields as time-dependent, then you cannot use this automatic transfer. Instead
you have to change the business area or cost centre (profit centre) by manually transferring the entire asset
to a new asset master record.

Standard settings
These fields are time-dependent in the standard system.

Recommendation

You should only change the standard setting when ALL of the following apply:

- You do not need a history of the time-dependent assignments of an asset to a business area or cost
centre.

- You create business area or profit centre balance sheets.

- You expect to make frequent changes to the assignments to business areas or cost centres.
Activities
Set the "time-independent organizational units” indicator for the appropriate company codes.

Further notes

SAP library FI-AA: "Master Data Maintenance -> Changes to Asset Master Record"

WHATSAPP +255738656506



[BECOME A MASTER OF SAP S/4 FINANCIAL ACCOUNTING
{8 CUSTOMIZING]

Specify Cost Centre Check across Company Codes

You only need to carry out this activity

- If your cost accounting extends across company codes (several company codes belong to one
controlling area) and

- You want account assignment of cost accounting depreciation from Asset Accounting to cost centres
that are in different company codes than the asset.

You can assign each asset to a cost centre in the asset master record. Account assignment then takes place
to this cost centre during depreciation posting. When you enter a cost centre in the asset master record, the
standard system checks if this cost centre exists in the same company code as the asset. You are not allowed
to enter a cost centre in a different company code.

In this step, you can make this check less strict. The system then only checks whether the cost centre
Exists in the given controlling area. This change means that you can then assign cost centres in different
company codes to assets.

Example

Asset: 10000

Company code of the asset: 0001

Cost centre in the asset: 369

Company code of cost centre 369: 0003

The system posts the cost-accounting depreciation to cost centre 369, although it does not belong to the
same company code as the asset.

Note

There is another consequence of making this system setting. It is then no longer possible to have account
assignment, neither online nor periodically, of revenue or expenses (such as gain/loss from asset sales)
from asset transactions to CO objects (cost centre, order).

Standard settings

The standard system checks whether cost centres for assets exist in the company code of the asset.
Activities

If required, specify that the system does not make this mandatory check that the cost centre is in the same

company code as the asset. You make this specification per company code.

You have to take additional steps if you want to have automatic statistical posting of asset acquisitions to
an investment order that is in a different company code than the asset.

1. In the Controlling IMG, choose Controlling -> General Controlling -> Change Message Control. A
dialog box appears.

2. Enter message class "KI" and choose Enter. A table appears.
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3. Choose "New entries."
4. Inthe Magnum field enter "100". In the Online and Batch fields enter either
a) "W"if you want to receive a warning during master data maintenance and posting

b) "-"if you do not want a message to be issued

Define Asset Search Help

In this processing step, you can revise or redefine existing match codes for assets.

Note

The maintenance of match codes requires technical knowledge of the ABAP4 Dictionary. Let your
System administrators handle the maintenance of match codes.

Using a large number of match codes can have a negative effect on the performance of the system. Check
which match codes you want to use for your area. You can deactivate match codes that you do not want
to use. Match codes apply across clients.

Default settings

SAP delivers the following match codes for the asset masters:
- ID: A = description and asset class

- ID: C = cost centre

- ID: | = inventory number

- ID: M = investment orders

- ID: P = investment projects

- ID: R = group asset
Actions
Revise or add to these definitions according to your requirements.

Further notes

SAP library: Master Data -> Match Code

For more information on maintaining match codes, see the SAP library under Basis - ABAP/4
Development Workbench - ABAP/4 Dictionary - Maintaining Match codes.

Specify Retention Periods for Archiving

In this step, you specify your own individual minimum retention period for asset objects (master data,
values, transactions). The minimum retention period determines how long fixed assets and their
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values/documents must stay in the system before they can be reorganized or archived. This minimum
retention period of asset objects results from adding the following components:

- In the system, a minimum retention period of one year is specified. This retention period starts

- for complete fixed assets (including master data), after the end of the fiscal year in which the
deactivation was carried out

- for values and documents, after closing of the fiscal year, in which the posting was made

- You can also define a user-specific retention period.

Example

Deactivated asset 3/1/YYYY
System retention period 1 year

Customer retention period 1 year
=> The asset can be reorganized in the fiscal year YYYY+3 at the earliest (3 = current year + system
retention period + user retention period).

Activities

Specify your additional, individual minimum retention period for asset objects.

Define Validation

In this step, you define validation conditions for master data maintenance. The validation adds to the
options provided in the master data maintenance in

- the ability to define the screen layout
- the maintenance level and
- the use of default value

During the validation, certain input values are checked against one or more conditions defined by the user.
The validation runs after the first screen change after the entry is made. If the condition is met, the system
accepts the entered values. If it is not, the system outputs an error message. This error message can also be
specified by the user in the validation condition.

Example

In this way, you can determine, for example, that only certain depreciation keys are allowed for fixed assets
of one asset class.

Activities

Define validation conditions for master data maintenance according to your requirements:

1. Choose function New entries
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2. Specify the company code and determine the check date by specifying

the master data section (general master data = A, depreciation areas = B)
the logical field group ( screen)

And the event description (1 = master data maintenance).

3. Specify the key of the validation rule to be used.

4.  If you did not define a validation rule, you can define new rules:

a)
b)
c)
d)
€)

Enter the company code and the key for your new validation rule.

Choose Go to -> Validation.

In the following screen, choose the function Create validation. Press ENTER.
Choose the function Insert entry.

Specify your validation rule by making the following specifications:
- Requirement under which the validation rule is to be checked.

- Check condition of the validation rule

- Error message to be output in case check condition is not met. You must create this
error message yourself (transaction: SE 61).

The creation of the requirement and the condition is supported by the function Fields for
require.

Please also consider the F1 field help for the definition of the Boolean rule. There you will find
notes on the required syntax.

Caution

You have to make entries for the fields "company code," "asset class," "asset main number/sub-

number" using leading zeros. The system shows the length of these fields when you use the
function Fields for require.

5.  Set the activation level in the definition of the validation condition.

Further notes

SAP Library FI-AA: Master Data -> Validations and Substitutions

Define Substitution

In this step, you define conditions for substitution for asset master data maintenance.

During substitution, certain entered values are checked against one or more condition(s) defined by the
user. If the condition is met, the system replaces the entered values with the values determined on the basis
of the conditions for substitution.

You can define substitution rules for the following points in time or activities:

- Creating assets

Note that these substitution rules only take effect when you create assets (not when you change them).
Assets that were created before the substitution rules were defined need to be changed later using a
mass change to master data, if the change is required.
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- Mass changes to master data

- Changing cost centres or business areas in the asset master record directly, with results as if an
automatic transfer were performed (refer to Time-Independent Management).

Here you can use the substitution to change the posting date of the automatically generated transfer
document.

Example

You can specify in the substitution that when you create an asset and enter a certain business area, that the
system automatically enters a certain plant.

Activities
Define substitution conditions for master data maintenance according to your requirements, and assign
Them to a company code:
1. Inorder to define new substitution rules, choose the Substitution function in the initial screen.
a) Enter a name for the substitution.
b) Choose Substitution -> Create in order to use an existing substitution rule as a reference.
c) Choose Insert entry.

d) Select the field for which an entry should be made automatically when the substitution condition
is fulfilled.

e)  Specify your substitution rule by making the following entries:

- Substitution when prerequisite is met (constant value, field-to-field assignment,
customer exit).

- Prerequisite under which the substitution rule is to be checked.

The Form Builder function supports the creation of prerequisites.
Set the substitution to active when defining substitution rules for creating assets.

2. Inorder to assign the substitution rules to a company code, choose new entries in the initial screen.
a) Enter the company code and a key for the substitution rule.

b)  For substitution rules for creating assets, you also have to enter the part of master data that is
affected (general data = A, depreciation areas = B) and the logical field group that is affected.

For substitution rules for creating assets and changing organizational assignments, you can create only one
substitution rule for each company code (logical field group affected). On the other hand, for substitution
rules for mass changes, you can create a number of substitution rules in each company code. You can
distinguish among these rules by their sequential number.

Further notes

SAP library FI-AA: Master Data -> Validation and Substitution
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0 Define Long Text Templates

In this step you define long text templates and allocate these templates to certain asset classes. By means
of these templates, the system then supports the long text entry when you create a fixed asset belonging to
the class. Per asset class, you can store one template for all long texts of an asset respectively (general
specifications, technical specifications and so on).

You can define the templates in the standard text transaction in the system (Main menu: Tools -> Word
processing -> Standard text). Use "FIAA" as text ID. Also consider the following when entering the
template in the SAP script editor:

- The system recognizes blank lines for the later entry of individual text passages by means of a "/ in
the tag column.

- The system recognizes entries which should not be later overwritten during long text maintenance
because they have a format other than /" entered in the tag column.
Requirements

You must have already created asset classes.

Standard settings

SAP delivers an example template (EXAMPLE_SAP).
Activities

1. Specify the asset classes to which you want to allocate templates.

2. Allocate a corresponding template to these asset classes per asset long text.

1 Enter Chart-of-Deprec.-Dependent User Fields in Asset Class

Generally, the attributes for the asset class apply throughout the client, that is, for all charts of depreciation.
It is therefore sufficient to make these specifications once per asset class.

However, you can define certain country-specific attributes of the asset class, in addition to those that are
not country-specific. This means that the country-specific attributes are dependent on the chart of
depreciation. These attributes are:

- Control specifications (screen layout rule and account determination)
- Allocations (evaluation groups)

- Net worth valuation (property classification key)

- Insurance entries

You only need to carry out this step, if, contrary to the usual case, you want these attributes to be country-
specific (that is, different depending on the chart of depreciation). The system then uses the entries you
make here depending on the chart of depreciation in the given company code. The system then ignores the
attributes in the asset class that are independent of the chart of depreciation.

Standard settings
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The asset classes supplied with the standard system do not have attributes that are specific to the chart of
depreciation.

Recommendation
In most cases, you do not need entries that are specific to the chart of depreciation.
Activities

Enter your chart-of-depreciation-specific attributes in the asset class, if needed.
Further notes

SAP library FI-AA: Organizational Elements -> Function of the Asset Class.

2 Develop Enhancement for Auto. Assign of Inventory Number

In this step, you define the automatic assignment of inventory numbers for fixed assets, using a prepared
customer enhancement project. The inventory number is a field in the asset master record. When you use
this enhancement, the system automatically completes this field when you create an asset. You have to
program the logic for the assignment of the inventory number using include ZXAISUOQ2 of function module
EXIT_SAPLAISA_001.

Note

Enhancement projects function on the basis of certain positions in standard SAP programming code that
have been prepared by SAP to allow the call of function modules programmed by the user to meet his/her
specific requirements. Therefore, it is possible to implement enhancement projects only if you have
knowledge of the ABAP/4 programming language.

Recommendation

You should review your needs carefully. Generally, you should not need to use enhancement projects,
since all common requirements are already met by the standard system functions.

Standard settings
In the standard system, you have to enter the inventory number manually.
Activities

1.  Modify function module EXIT_SAPLAISA_001 and program ZXAISUQ2, which is included in it,
to your requirements.

2. Activate a customer enhancement project (with any key) using SAP enhancement AISA0001.
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For more information, see the documentation for customer enhancement AISA0001 (transaction SMOD).

For an overview of the customer enhancements in Asset Accounting, refer to the SAP Library under
"Customer Enhancements (Customer Exits)".

For general information on customer enhancements, refer to the documentation for transaction CMOD (the
"Information” pushbutton).

Country-Specific Functions

Russia

Define Precious Materials for Asset Master Data Maintenance

Use

In this IMG activity, you define the precious materials that you use in your company.

For each precious material, you specify:

A code that you use in your company to identify the precious material
The unique description of the precious material

The OKP code of the material

Whether the precious material is countable

The quantity unit for countable precious materials

The weight unit for countable and uncountable precious materials

Transactions

In the step "Transactions™ you can make configurations for the posting of transactions in Asset Accounting.

It is especially important to define transaction types. You have to enter a transaction
type for each posting activity that is relevant to Asset Accounting. Transaction types
classify the different types of accounting transactions in Asset Accounting.

Each transaction type is assigned to a transaction type group. The transaction type groups are fixed in the
system, and the user cannot change (or add to) them. The system controls the posting activity using the
transaction type and the transaction type group.
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Acquisitions

In this section, you define system settings for posting asset acquisitions.

Define Transaction Types for Acquisitions

In this step, you define the transaction types for asset acquisitions. You can also specify that for certain
transaction types, only certain depreciation areas will be proposed for posting. The system then creates a
popup window in the posting transaction, showing the depreciation areas that can be posted. If you specify
that all depreciation areas should always be posted, the system suppresses the popup window.

Standard Settings

SAP provides transaction types for asset acquisitions. You can use these transaction types without making
any changes to them.

Most standard transaction types are not limited to specific depreciation areas. That is, they post to all
depreciation areas in a given chart of depreciation. Standard depreciation areas that ARE limited to certain
depreciation areas are indicated by a short text.

SAP Recommendation

You should use the SAP standard transaction types. In that case, you do not have to anything further here.
However, you may need to define your own transaction types after all, for one of the reasons listed below:

You need transaction types
- that post only to certain depreciation areas in your chart of depreciation
- For which there is no corresponding transaction type with the necessary limitations.

- You want to have certain types of acquisitions appear in different asset history sheet items. For this
situation, define acquisition transaction types and assign them to different history sheet groups (see
Define history sheet groups).

- You need acquisition transaction types that do not lead to the capitalization of the assets posted. In
this case, remove the indicator “capitalize asset."

- You want to monitor a budget using statistical orders/projects. In this case, set the indicator for
statistical updating of an order/project (see the Sys.Adm.Guide: "Posting Procedure -> Statistical
Posting of Assets under Construction™).

Activity

1. Create new transaction types to meet your specific needs. Use one of the letters X, Y, or Z, in one of
the three characters of the key, in order to protect your key from being overwritten during future
upgrades to your system.

2. Specify the features of your new transaction types in the detail screen.
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3. Limit the transaction types, if needed, to certain depreciation areas.

If you do not make any selection here, then the transaction type will always post to all depreciation
areas.

Define Account Assignment Category for Asset Purch. Orders

Asset acquisitions can be posted during the processing of purchase orders in the Materials Management
(MM) component. It is possible to post a purchase order or a purchase requisition with account assignment
to an asset. In order to make this assignment, however, the asset already has to have been created. Then
the asset is automatically capitalized when the goods receipt or invoice receipt is posted.

When you create a purchase order, you have to enter an account assignment category. Entering account
assignment category "A" tells the system that you are entering a purchase order for a fixed asset. It is also
specified in the account assignment category whether the goods receipt should be valuated or not. (If the
goods receipt is valuated, the asset is capitalized at the time of the goods receipt. If it is non-valuated, the
asset is capitalized at the time of the invoice receipt.)

Standard settings

In the standard system, account assignment category "A" is defined for valuated goods receipt.

Recommendation

In most countries, both commercial and tax laws require that the asset be capitalized at the time of the
goods receipt.

Activities
1. Check the definition of account assignment category "A".
2. Set the indicator "GR non-valuated", if you want to post non-valuated goods receipts.

Further notes

SAP library FI-AA: Transactions (Assets General) -> Processing Purchase Orders for Fixed Assets

Specify Asset Class for Creating Asset from Purchase Order

You can create an asset directly from the purchasing transaction for purchase orders. Using this method,
you can enter an asset purchase order, without creating an asset beforehand in Asset Accounting. This asset
will serve as the account assignment object for the purchase order.

In this step you specify the asset classes that the system should use as defaults when you create an asset
from within a purchase order. You have to specify the asset class in relationship to the material group.

Activities

Assign an asset class to each of your material groups for fixed assets.
Further notes

SAP library FI-AA: "Acquisitions -> Purchase Orders for Assets"
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Assign Accounts

In this activity, you define general ledger accounts for asset acquisitions.

Allow Down Payment Transaction Types in Asset Classes

In this step, you determine the asset classes for which postings are to be allowed with the transaction type
groups for down payments.

Activities

Determine the asset classes for which down payments made may be capitalized (particularly asset classes
for assets under construction).

Prevent Subsequent Capitalization of Discounts

Use

For an asset acquisition posting integrated with Accounts Payable, you can specify, by your choice of
document type, if the invoice should be posted gross (without deducting discount) or net ( with discount
deducted).

When you use a document type for net posting, the system automatically determines the cash discount to
be deducted on the basis of the payment terms. The system capitalizes the invoice amount, less tax and
cash discount, on the fixed asset.

If differences are found during the payment run (too much or too little discount was deducted), you can
correct the APC of the asset using a collective processing in the general ledger (General Ledger -> Periodic
Processing -> Closing -> Regroup -> Profit and Loss Adjustment).

Setting the Subsequent Capitalization of Discount Not Allowed indicator prevents these subsequent APC
adjustments from being made.

Standard settings

If the indicator is set for a company code, then discounts are not capitalized subsequently on fixed assets.

Define Validation

In this step you define validation conditions for asset-related postings and allocate these rules to the
corresponding transaction type groups. This way, you can determine that the system checks against the
respective condition for posting with these transaction type groups.
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Example

Itis possible to specify, for example, that certain transactions can only be posted to the asset classes stored
in a validation rule. Another possible use is a class-specific maximum amount check for acquisition
postings.

Activities

Define validation conditions for asset postings according to your requirements:
1.  Enter a validation rule for the transaction type groups.
2. Set the capitalization indicator for the validation rule.

Please refer to the step Define validation for information on the procedure for defining new validation
rules.

Further notes

SAP library FI-AA: Transactions -> Validation

Retirements

In this section, you define system settings for posting fixed asset retirements.

Define Transaction Types for Retirements

In this step, you define transaction types for posting fixed asset retirements. You can also specify that
certain transaction types should only be suggested for posting to certain depreciation areas. In the posting
transaction, the system generates a pop-up with the depreciation areas to be posted to. If you specify that
all areas should always be posted to, the pop-up does not appear.

Standard settings

SAP supplies transaction types for asset retirements. These are ready for you to use.

Most standard transaction types are not limited to certain depreciation areas, in other words they post to
All areas in each chart of depreciation. Standard transaction types which are limited to areas do not have a
corresponding short text.

Recommendation

If you work with the SAP standard delivery, you will not need to perform any activities. However, you
may still need to define your own transaction types for the following reasons:

- You require transaction types
- which only post to certain areas in your chart of depreciation, and
- For which there are no corresponding limited standard transaction types.

WHATSAPP +255738656506



[BECOME A MASTER OF SAP S/4 FINANCIAL ACCOUNTING
{8 CUSTOMIZING]

- You want certain retirements to flow into different asset history sheet items. If this is the case, define
retirement transaction types and assign them to any exceptional history sheet groups, (see also Define
history sheet groups).

- You require retirement transaction types which do not deactivate the assets which are posted to. If
this is the case, remove the "Deactivate asset" indicator.

- You require retirement transaction types which do not post any gain/loss as profit/loss, but instead
use other special posting variants. For more information, see the chapter Gain/loss posting for
bookkeeping.

- You want to monitor a budget using statistical orders/projects. If this is the case, use the indicator for
the statistical update of an order/project (see also System Administration Guide: Posting Procedure -
> Statistical posting...)

Activities

1. Add new transaction types as you require. To do this, use the letters X, Y or Z anywhere in your 3-
character key to protect it from being overwritten by standard delivery transactions.
2. Specify the characteristics of the new transaction types in the detail screen.

3. Ifrequired, limit the transaction types to certain depreciation areas.
If you do not make a selection, all depreciation areas will be posted to.

Further notes

SAP library FI-AA: Transactions -> Transaction Types

Gain/Loss Posting

Gain/loss from asset retirements can be handled differently in accounting depending on the laws in each
particular country. In the following section, you make the system settings that are necessary for this.

Determine Posting Variants

In this step, you define the bookkeeping processing of gain/loss for fixed asset retirements per depreciation
area:

- Variant 0: Post gain/loss to a P+L account
- Variant 1: Post gain/loss to the value adjustment account on the liabilities side
- Variant 2: Post the entire sales revenue (no gain/loss determination) on the liabilities side

- Variant 3: Post gain/loss to a special fixed asset

Note
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Variants 1 and 2 are, for example, necessary for group assets in accordance with American ADR
legislation.

Variant 3 is related to the indicator in the Definition of transaction type: if the indicator "post gain/loss to
asset" is set there, then this applies to all depreciation areas. You can change this setting in this step, by
changing the control of retirement.

Standard settings

The standard asset retirement transaction types use variant 0. This is the variant prescribed by
tax/commercial law in most countries.

Activities

Determine, for each depreciation area, which posting variants your asset retirement transaction types are
to use.

Define Transaction Types for Write-Up Due to Gain/Loss

You only need this step if you do not post gain/loss to P&L accounts, but instead want to collect gain/loss
on special assets (this is the third way of handling retirement - see Determine posting versions).

In this step, you define the transaction type for write-ups on the basis of gain/loss from asset retirements.
The system uses this transaction type to post gain/loss to specified assets as a write-up.

Note

Collecting gain/loss on specially defined assets in common only in certain countries, such as the USA.

Standard settings

SAP supplies a transaction type for gain/loss (770). You can use this transaction type without making any
changes to it.
Recommendation

You should use the SAP standard transaction type. Then you do not need to carry out any further activity
here.

Activity

1. Change transaction type 770 to meet your requirements.

2. Enter this transaction type as a default value (see Specify transaction types for internal transactions).

Determine Asset for Gain/Loss Posting per Class

You need to carry out this implementation step if you do not post gain/loss to profit and loss accounts, but
instead want to collect gain/loss on special assets (asset retirement variant 3 - for more information see
Determine posting variants).
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In this step, you enter the asset, to which the system should post gain/loss from asset retirement, for each
asset class.

Note

This practice of collecting gain/loss on specially defined assets is only used in certain countries, such as
the USA.

Activities

Enter the asset class and the assets belonging to it for gain/loss posting using new entries.

Determine Asset for Gain/Loss Individually (Substitution)

You need to carry out this implementation step if you do not post gain/loss to profit and loss accounts, but
instead want to collect gain/loss on special assets (asset retirement variant 3 - for more information see
Determine posting variants).

In this step you define the substitution rules for determining the assets, on which gain/loss should be posted.
Activities
Define the corresponding substitution rules.

Further notes

For information on the procedure used for the definition of substitution rules, see Define substitution.
Further notes (Transport)

In the overview screen of the transaction, you can include the substitution rules in a transport request (via
Table view -> Transport). Note that the definition of the substitution rule is specific to one client.
Therefore, a transport is not only necessary between two systems (such as, from a test system to a
production system), but also in order to make the substitution available in other clients.

Post Net Book Value Instead of Gain/Loss

In this Customizing activity, you specify for each company code if the system should post the net book
value of the asset at asset retirement instead of gain or loss.

Standard settings

The standard transaction types do not use this posting option.

Activities

NIXONTAGMAN@GMAIL.COM | Asset Accounting



Specify the company codes in which the system should post the net book value to a revenue clearing
account at asset retirement.

Note

If necessary, you can limit the posting of the net book value to certain depreciation areas. For more
information, see Post Net Book Value at Retirement.

Define Validation

In this step you define validation conditions for asset-related postings and allocate these rules to the
corresponding transaction type groups. This way, you can determine that the system checks against the
respective condition for posting with these transaction type groups.

Example

Itis possible to specify, for example, that certain transactions can only be posted to the asset classes stored
in a validation rule. Another possible use is a class-specific maximum amount check for acquisition
postings.

Activities
Define validation conditions for asset postings according to your requirements:
1.  Enter a validation rule for the transaction type groups.

2.  Setthe capitalization indicator for the validation rule.

Please refer to the step Define validation for information on the procedure for defining new validation
Rules.

Further notes

SAP library FI-AA: Transactions -> Validation

Assign Accounts

In this step, you determine the general ledger accounts for fixed asset retirements.

Note

The general ledger accounts can also be determined individually for fixed asset retirements. For this, see
the explanation in the step Define customer enhancement for account determination.
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Develop enhancement for account determination

In this step you define your own account determination using a prepared customer enhancement project.
In this way, the profit and loss accounts for asset retirement (not balance sheet accounts) can be determined
according to given parameters. The system dynamically exchanges the profit and loss accounts in the
"normal™ account determination with accounts determined using the customer enhancement at the time of
posting.

Example

In certain countries (such as the Czech Republic), this function is needed for gain/loss postings from asset
retirement. You use it to control the gain/loss posting to different accounts, depending on the transaction
type used.

Note

Enhancement projects function on the basis of certain positions in standard SAP programming code that
have been prepared by SAP to allow the call of function modules programmed by the user to meet his/her
specific requirements. Therefore, it is possible to implement enhancement projects only if you have
knowledge of the ABAP/4 programming language.

Standard settings

As standard, the system posts to the general ledger accounts specified in the "normal™ account
determination.

Recommendation

You should review your needs carefully. Generally, you should not need to use enhancement projects,
since all common requirements are already met by the standard system functions.

Activities
1. Change the function module EXIT_SAPLANLG_001 and its program ZXINTUO2 to meet your
requirements.

2. Activate a customer enhancement project (any key) with the SAP enhancement AINT0002.

Further notes

For more information, see the documentation for customer enhancement AINT0002 (transaction SMOD).

For an overview of the customer enhancements in Asset Accounting, refer to the SAP Library under
"Customer Enhancements (Customer Exits)".

For general information on customer enhancements, refer to the documentation for transaction CMOD (the

"Information” pushbutton).
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Transfers

In this section, you define system settings for asset transfers.

Define Transaction Types for Transfers

In this step, you define transaction types for posting transfers. The system requires 2 transaction types for
transfers between assets.

- atransaction type for retirement from the sending asset,
- Atransaction type for addition to the receiving asset.

The posting transaction is performed from the point of view of the sending asset.

Standard settings

SAP supplies transaction types for common business transactions. These are ready for you to use.

Recommendation

If you work with the SAP standard delivery, you will not need to perform any activities.
Activities

1.  Add new transaction types as you require. To do this, use the letters X, Y or Z anywhere in your 3-
character key to protect it from being overwritten by standard delivery transactions.

2. Specify the characteristics of the new transaction types in the detail screen.

3. Inthe retiring transfers transaction types, enter a transaction type for the corresponding transfer
Addition.
If you do not make a selection, all depreciation areas will be posted to.

Further notes

SAP library FI-AA: Transactions -> Transaction Types

Specify Posting Variant for Retirement Transfers

In this step, you define the way retirement transfers are treated, per depreciation area:
- Transfer of APC and proportional value adjustments

- Transfer of APC without proportional value adjustment account

Note

The second option is required for group assets in accordance with ADR legislation in the United States.
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Standard settings

The standard retirement transaction types supplied by SAP use the first option. This is the posting variant
that is required in most countries to comply with tax and balance sheet regulations.

Activities

For each of your retirement transaction types, specify the posting variant you want to use in each
depreciation area.

Define Validation

In this step you define validation conditions for asset-related postings and allocate these rules to the
corresponding transaction type groups. This way, you can determine that the system checks against the
respective condition for posting with these transaction type groups.

Example

It is possible to specify, for example, that certain transactions can only be posted to the asset classes stored
in a validation rule. Another possible use is a class-specific maximum amount check for acquisition
postings.

Activities

Define validation conditions for asset postings according to your requirements:

1.  Enter a validation rule for the transaction type groups.
2.  Setthe capitalization indicator for the validation rule.

Please refer to the step Define validation for information on the procedure for defining new validation
rules.

Further notes

SAP library FI-AA: Transactions -> Validation

Intercompany Asset Transfers

In this step, you define the control parameters for intercompany asset transfer. There are two ways of
posting intercompany transfers:

- Acquisition and retirement in one step (automatic intercompany transfer)

Acquisition and retirement in two separate steps (manual intercompany transfer)

Further notes
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SAP library FI-AA: Transactions -> Intercompany Asset Transfers

Automatic Intercompany Asset Transfers

In this step, you define the control parameters for automatic intercompany asset transfers;
- Cross-system depreciation areas

- Transfer variants

Further notes

SAP library FI-AA: Transactions -> Intercompany Asset Transfers

Define Cross-System Depreciation Areas

In this step, you define cross-system depreciation areas. Using cross-system depreciation areas, you can
assign a meaning to the local depreciation areas that is then valid in all charts of depreciation throughout
your system. The cross-system depreciation area makes this possible, although the different depreciation
areas have different keys in different charts of depreciation.

For each cross-system depreciation area, you can specify its own transfer methods in a transfer variant.

Example

Depreciation area XX has the same function or meaning in chart of depreciation 1XX as depreciation area
YY does in chart of depreciation 1YY. You assign both of these depreciation areas to the key ZZ that is
valid throughout the system. You have now created the cross-system depreciation area ZZ.

Requirements

You must have defined charts of depreciation.

Recommendation

You do not need cross-system depreciation areas, if all company codes in your client use the same chart of
depreciation, or if the depreciation areas in your charts of depreciation that have the same purpose and
meaning across the system also have the same keys.

You only need global depreciation areas if:

- You use different charts of depreciation, but individual depreciation areas nonetheless have the same
meaning.

- A depreciation area is not intended to be transferred during intercompany transfer. In this case, do
not assign this depreciation area to a cross-company depreciation area.

- You have individual depreciation areas with the same name, but their meanings are different.

Standard settings
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SAP does not supply cross-system depreciation areas.
Activities
1. Define cross-system depreciation areas (key and description) for depreciation areas that have the same
meaning throughout the system.
2. Set the chart of depreciation that you want to work with.

3. Assign the local depreciation areas of your charts of depreciation to a cross-system depreciation area.

Define Transfer Variants

In this step, you define transfer variants. Transfer variants contain the following control parameters for
intercompany asset transfers:

- Transaction types for posting the transactions that belong to an intercompany transfer
(retirement/acquisition).

- the transfer method for the capitalization of the transferred assets in the target company code

In addition, you can specify in each transfer variant which master data fields should be copied from the
transferred asset to the target asset, if a new asset has to be created in the target company code.

Note

The definition of the retirement transaction type specifies whether the retirement affects current-year
acquisitions or prior-year acquisitions. For this reason, you need two different transfer variants (with
different transaction types, such as 230 and 275) for the transfer of prior-year acquisitions and current-year
acquisitions.

Standard settings

SAP provides sample transfer variants. These transfer variants use transaction types for the transfer of
prior-year acquisitions (not for current-year acquisitions).

Activities

1.Check the company code relationship of the company codes involved:

- ldentical company ID => single legal entity -

different company IDs => legally independent entities

2.  Define transfer variants:

- Specify the transfer method to be used.
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- Specify the retirement and acquisition transaction type for the intercompany asset transfer. You
can make your entries dependent on the relationship of the company codes and the cross-system
depreciation area.

If you do not have cross-system depreciation areas, you can enter "*' in that key field. The system
then uses this entry

- dependent on the specified company code relationship and
- for all depreciation areas that have a key that agrees with the company codes involved

3. Specify the field contents that should be copied to the target asset during intercompany transfer, for
- general master data fields

- Depreciation terms/cross-system depreciation area in the asset master record.

Further notes

For more information, particularly about restrictions due to the allowed transaction types, see the SAP
library FI-AA: Transactions -> System Settings for Intercompany Asset Transfers.

Develop Enhancement for Determining Company Code Relationship

In this step, you define your own method for determining the company code relationship type, using a
prepared customer enhancement project. The company code relationship type is the deciding factor for the
transfer method to be used when you conduct an intercompany asset transfer.

Standard settings

In the standard system, the system determines the company code relationship using the following logic:

- If the company codes belong to the same company (identical company ID), then they are a single
legal entity.

- If the company codes do not belong to the same company (their company IDs are different), then they
are legally independent entities.

Recommendation
Generally the standard setting does not need to be changed.
Activities

1. Maintain include ZXINTUO7 and enter the program code there for determining the company code
relationship.

2. Activate a customer enhancement project (any key) using SAP enhancement AMSP0002.

Further notes

For more information, refer to the documentation for customer enhancement AMSP0002 (transaction
SMOD).
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For an overview of the customer enhancements in Asset Accounting, refer to the SAP Library under
"Customer Enhancements (Customer Exits)".

For general information on customer enhancements, refer to the documentation for transaction CMOD (the
"Information™ pushbutton).

Specify Gross or Net Transfer Method for Manual Transfer

You only need to make the following system settings if you plan to post intercompany asset transfers
between systems or between clients.

These system settings are not required for intercompany transfers within one client, since you can post

These transfers using an automatic procedure (for more information, see
Automatic intercompany transfer).

Intercompany transfers between systems or clients are posted in two steps:
- retirement of the sending asset
- acquisition on the receiving asset

In this step, you define the features of the transaction types used in these manual asset transfers. In
particular, you can specify the following:

- You can designate that
- a sending or receiving company must always be specified for the postings belonging to a transfer
(posting with affiliated company), and

- that cumulative value adjustments can be entered along with the APC being acquired, when making
the acquisition posting ( gross posting )

- You can designate that the affiliated company can be specified in receiving transfers from affiliated
companies, but that the accounting transaction, however, is posted net in all areas (regardless of the
indicator in the area definition). (net posting with affiliated company)

Note
For automatic transfers within a client, you make these specifications in the transfer variant that you use.
Activities

1.  Select the acquisition transaction types for asset transfers between affiliated companies.
Set the indicators for "posting with/without affiliated company" and "net/gross" posting.

2. Follow the same procedure for the retirement transaction types.
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Asset Waybills (for South America)

For some transactions in Asset Accounting you have to create accompanying sheets for assets. In this
section you define the settings for creating these sheets.

Note

Please note that this function is used in South American countries only.

Requirements

Before you can define the accompanying sheets, you have to maintain the document class and the number
ranges for document number assignment. To enter these settings, choose "Financial Accounting ->
Financial Accounting Global Settings -> Company Code".

Further notes

SAP Library -> SAP ERP Central Component -> Financials -> Country Versions -> Americas -> Argentina

Official Document Class for Maintaining Asset Waybills

In this step you define the document class for the accompanying sheets required for assets.
Requirements

Before you can define the accompanying sheets, you have to maintain the document class and the number
ranges for document number assignment. To enter these settings, choose "Financial Accounting ->
Financial Accounting Global Settings -> Company Code".

Further notes

SAP Library -> SAP ERP Central Component -> Financials -> Country Versions -> Americas -> Argentina

Assign Forms for Asset Waybills

In this step you define the forms to be used for different asset transactions. There are four kinds of
transactions:

1. Physical transactions for changing the location of an asset

2. Transfer for accounting changes to the asset

3. Transfer with physical transactions for changing the location of an asset and changes in accounting
4.  Other for all other cases

The combination of forms for these transactions is referred to as a rule.

Requirements
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You have to define the forms first, or you can use the standard forms delivered. To define forms, use the
Form Painter.

Activities

Enter one or more rules for each company code and specify the appropriate forms for the different
transactions.

Further notes

SAP Library -> SAP ERP Central Component -> Financials -> Country Versions -> Americas -> Argentina

Capitalization of Assets under Construction

In the step "Assets under construction” you define customizing settings for the settlement (capitalization)
of assets under construction. You can use open item management of assets under construction in the FI-
AA System and settle the asset under construction to various receivers. Settlement is carried out with the
help of distribution rules that can be assigned to the line items of an asset under construction.

Settlement profiles contain parameters (for example, allowed receivers) for the settlement.

Further notes

SAP library FI-AA: Organizational Elements -> Asset Types

Define Transaction Types

In this step, you define transaction types for capitalizing assets under construction.

Allow Transfer Transaction Types for Asset Classes

In this step, you specify the asset classes, in which posting is allowed using the transaction type groups for
transfers from assets under construction to completed assets.

Activities

Specify the asset classes, in which transfers (AuC) to completed assets are allowed.
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Determine Cost Element for Settlement to CO Receiver

When you settle an asset with line item management, it is possible to settle debits to CO receivers
(particularly cost centres). This might be necessary if debits were capitalized to the asset under
construction by mistake. The system requires a cost element in order to make this settlement to CO
receivers.

In this step, you determine the cost element with which the line items of assets under construction are to
be settled to CO receivers.

Note

The IM (Investment Management) module also uses this cost element. It uses it when charges that have
been capitalized incorrectly on the asset under construction have to be settled to a cost centre. This usually
takes place at the final settlement of a capital investment measure.

Activities

Specify the account "Cost element AuC settlement to CO receiver".

Define/Assign Settlement Profiles

In this step, you define settlement profiles for settling assets under construction. You can store one profile
in the Customizing definition of each asset company code. The system then uses this key when there is an
asset under construction to be settled in that company code.

Standard settings

For the settlement of assets under construction, SAP delivers the settlement profile Al as a standard.
Activities

You can define individual settlement profiles, if required. To do this, you must set

- the allowed receivers (assets, possibly cost centres)

- the allowed settlement types (equivalence numbers, percentage rate)

- default values

- other parameters (document type)

1. Assign a settlement profile to each of your company codes.

Specify Capitalization of AUC/Down-Payment

In this step, you determine how the system will deal with down payments on AuCs and their closing invoice
during the settlement (capitalization) of the AuC. This system setting is particularly relevant for
representing down payments from previous years in the asset history sheet.
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Requirements

You must have worked through the specifications of the company codes for Asset Accounting.

Standard settings

The system capitalizes down payments as follows in the standard system:

If you capitalize a down payment from the previous year and the closing invoice from the current year
together, the amount of the down payment is transferred with the transaction type for asset data from
previous years, and only the difference between the closing invoice and the down payment is transferred
with the transaction type for current acquisitions.

Activities

If you want to change the default setting, you must set the indicator for the capitalization of assets under
construction without down payments. If this indicator is set, the system ignores down payments during
the line item settlement of assets under construction. The total amount of the closing invoice is always
transferred with the transaction type according to its posting year.

Maintain Number Ranges for Documents for Line Iltem Settimt

You only need to carry out this step if you plan to use line item settlement of assets under construction or
investment measures.

Every settlement in cost accounting has to be uniquely identified in the system. The system makes this
identification by storing a settlement document under a separate number for each settlement that takes
place. The system does this also for the line item settlement of an asset under construction or an investment
measure. It creates a CO settlement document in the controlling area to which the asset or the investment
measure belongs. The system determines the controlling area on the basis of the assignment of the company
code to a controlling area.

In this step, you define the number range intervals for the settlement documents in one or more controlling
areas. All controlling areas that use the same number range interval are called a number range group.

Recommendation

You should define separate number range intervals for settlement documents from different controlling
areas. This improves performance when you carry out settlements in different controlling areas in parallel
(for example, on the same day).

Activities

1.  Check which controlling area your company code belongs to. If necessary, assign your company code
to a controlling area.
2. Create a number range group (Group -> Maintain and Group -> Add).

3. Enter a name for the number range group.
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4. Enter an interval for the number range group. In case the interval becomes full, you can also enter
additional intervals.

5. Choose one or more controlling areas that are under the heading 'not assigned.'

6. Position the cursor on the number range group that you want to assign to the selected controlling
areas.

7. Assign the selected controlling areas to the number range group using Element/group and save your
entries.

Further notes

You transport number range objects as follows:
Choose Interval -> Transport in the accounting document Number Range screen.

All intervals for the selected number range object are deleted in the target system first. After the import, only
the intervals you export are present. The number statuses are imported with their values at the time of export.

Dependent tables are not transported or converted.

Define Validation
In this step you define validation conditions for asset-related postings and allocate these rules to the
corresponding transaction type groups. This way, you can determine that the system checks against the
respective condition for posting with these transaction type groups.

Example

It is possible to specify, for example, that certain transactions can only be posted to the asset classes stored
in a validation rule. Another possible use is a class-specific maximum amount check for acquisition
postings.

Activities
Define validation conditions for asset postings according to your requirements:
1. Enter a validation rule for the transaction type groups.

2. Set the capitalization indicator for the validation rule.

Please refer to the step Define validation for information on the procedure for defining new validation
rules.

Further notes

SAP library FI-AA: Transactions -> Validation
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Define Transaction Types for Post-Capitalization

In this step, you define transaction types for posting post-capitalization.

Define Transaction Types for Manual Depreciation

Manual corrections to values, such as

- unplanned depreciation

- other manually planned depreciation (ordinary or special depreciation) and
- write-ups

Are made by posting in Asset Accounting. In this step, you define the transaction types for the manual
value corrections. In addition, you can specify that certain transaction types propose only certain
depreciation areas for posting. The system then generates a popup window showing the depreciation that
can be posted in the posting transaction. If you want to specify that all depreciation areas should always
be posted, you do not need to carry out this step. The popup window then does not appear in the posting
transaction.

Transaction types classify the varying business transactions in Asset Accounting. Every transaction type
is assigned to a specific transaction type group. The transaction type groups are fixed in the system, and
cannot be expanded (or changed) by the user. You have to enter a transaction type for every posting
transaction that involves Asset Accounting. The posting transaction is controlled by the features of the
transaction type, and the respective transaction type group.

Requirements

You must have defined your own chart of depreciation.

Standard settings

SAP provides transaction types for manual depreciation.

Recommendation

You should use the standard transaction types. You do not have to do anything else here in that case.
However, if the scenario below applies to you, it may be necessary for you to define your own transaction
types:

You need transaction types
- that only post to certain depreciation areas in your chart of depreciation and

- There are no corresponding standard transaction types that have the limitations you need.

Activities
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1. Create new transaction types according to your requirements. When you create the three-letter key
for the transaction type, use the letter X, Y or Z somewhere in the key. Using one of these letters (at
any position in the key) will prevent your key from being overwritten by future SAP updates.

2. Define the characteristics of the new transaction types in the detail screen.

3. Limit your transaction types, if necessary, to certain depreciation areas.
If you do not make any selections, then all depreciation areas will be posted at all times.

Budget Monitoring with Statistical Orders/WBS Elements

You only need to carry out these steps if you want to monitor direct capitalizations to assets in cost
accounting with regard to budget values, available values and commitments. In the FI-AA (Asset
Accounting) component, you can do this kind of monitoring by posting asset acquisitions directly to assets,
while at the same time making a statistical automatic posting to an internal order or a WBS element. In
order for you to be able to makes this automatic statistical posting, all of the following must apply:

- The acquisition transaction types in Asset Accounting have to be designated as relevant to the budget.

- The APC asset balance sheet accounts have to be defined as statistical cost elements.

- The APC asset balance sheet accounts have to have a field status definition that allows additional
account assignment to orders or WBS elements.

You specify the internal order or the WBS element that receives the statistical posting. You enter it in the
origin data in the asset master record as investment account assignment. The system then automatically
makes a statistical account assignment to this order or WBS element when you post certain asset
transactions. Another option is to enter the additional account assignment directly in the posting
transaction.

In the budget profile of the given order or WBS element, you can specify that the system carries out an
availability control for each transaction with automatic statistical posting. The system checks availability
of funds in the budget for the order or WBS element.

For asset purchase orders, the system creates a statistical commitment on the order or WBS element
belonging to it. When you post the goods receipt or the invoice receipt, the system automatically reduces
this commitment.

Caution

Automatic statistical posting is not possible for down payments or for settlement of an order or WBS
element to an asset.

Further notes

SAP library FI-AA: Transactions -> Budget Monitoring

Create Statistical Cost Elements

In this step, you set up the asset balance sheet accounts as statistical cost elements for the account
assignment of asset transactions to an internal order or a WBS element.
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Requirements

- You must have maintained your account determinations.

- You must have defined the general entries for your controlling area. In particular, you should check
the assignment of the controlling area to the company code, since the chart of accounts concerned is
determined using this assignment. For more information, see the Implementation Guide step
"Controlling General."

Standard settings

The indicator for budget relevance is set in the definition of the appropriate standard transaction types.

The APC balance sheet accounts in the standard charts of accounts are not defined as cost elements.

Recommendation

This function is intended for simple budget monitoring of certain groups of assets in the form of a
plan/actual comparison (for example, lump sum budgets for fixtures and fittings). Use the Investment
Management (IM) component for managing individual, large-scale capital investments (see the SAP
library: Investment Management).

Activities

1.  Start the program for defining your asset balance sheet accounts as statistical cost elements. Enter
- the controlling area concerned

- the period of validity

The system then automatically creates statistical cost elements (cost element type 90) for all of the
APC balance sheet accounts belonging to your account determination in Asset Accounting
(depreciation area 01).

2. Transport these cost elements to your production clients. For more information, see the
Implementation Guide step "“Controlling General".

Change the Field Status of the Asset G/L Accounts

In the FI General Ledger system, you can control which fields are contained in the entry screens of posting
transactions. You can also specify whether these fields are required entry fields (setting the field status).
You need to make specifications of this type if you plan to use statistical automatic posting of asset
transactions to internal orders or WBS elements. You must make sure that the field "internal order" or
"WBS element" is defined as available for input for the field status group "asset accounts."

The field status is controlled by two settings:
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- You can assign a field status variant to each company code. In the field status variant, you specify the
status that certain fields should have in certain account groups (field status groups). You define the
account groups yourself.

You assign the G/L accounts to field status groups in the master records of the G/L accounts.

- In addition, you can define the field status as dependent on the posting key used for the given posting.

Standard settings

The field status variant 0001 is entered for company code 0001 in the SAP standard system. Field status
groups are already defined for this field status variant. The standard field status groups and company codes
for asset accounts and asset posting allow additional account assignment to orders and WBS elements.

Note

When you carry out the basic customizing for the FI system (Financial Accounting Global Settings), you
Assign a field status variant. Therefore, you should not change the assignment of the field status variant in
this step. Instead, you should only display the field status variant.

Activities

1. Check the field status variant that is used in your company code.

2.  Specify that the field status group "asset accounts" allow the field "WBS element™ or "CO order" as
additional account assignment in the field variant.

3. Specify that additional account assignment to WBS element or CO order is possible for the posting
key for asset acquisitions.

Specify Default Transaction Types

In this step, you determine the transaction types that the system sets as defaults for the standard posting
transactions of Asset Accounting.

Standard settings
The system sets the appropriate standard transaction type as a default for the posting transaction.
Activities

Change this default setting if you want to set user-defined transaction types or other standard transaction
types as a default.

0 Determine Transaction Types for Internal Transactions

In this step, you determine the transaction types that the system uses for postings

- which are initiated in other R/3 modules (for example, down payments)
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- that are initiated automatically (such as, depreciation)

Standard settings

SAP provides transaction types for all internal FI-AA postings. These transaction types are used for the
corresponding business transactions.

Activities

Only change the default setting here if you have defined your own transaction types for the business
transactions concerned.

Specify How Default Asset Value Date is Determined

In this step, you define which rules the system should use in each company code when determining the
default asset value date when posting asset transactions. You need this step only if you have special needs
in regard to the asset value date, since there are standard rules in the system that meet most needs for setting
the asset date.

The default asset value date is particularly important for transactions that are initiated in applications that
are integrated with Asset Accounting (such as acquisition from goods receipt). In that type of transaction,
the default asset value date is not displayed, and therefore cannot be changed manually when you post.

You specify the rules for determining the default asset value date in value date variants. You can assign
one value date variant to each company code.

You enter two rules in the value date variant for each accounting transaction:
- one primary rule

- One alternative rule, in case the fiscal year determined on the basis of the primary rule is not the same
as the fiscal year of the posting date.

In addition, you can define new rules in this step. You have to use the standard SAP enhancement
AMAV0001 to set up the program logic for new rules for determining the default asset value date.

Standard settings

SAP supplies the value date variant SAP_DEFAULT. This variant contains rules for determining the asset
value date for all Asset Accounting transactions.

The system uses the SAP_DEFAULT value date variant in all company codes to which you do not assign
a specific value date variant.

Recommendation
Adopt the standard settings.
Activities

1. Assign rules for automatically determining the asset value date to the Asset Accounting transactions.
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2. Define new rules if you need them:;
a) Choose Go to -> New rules.
b)  Enter the key and name of the new rule. Choose Back.
¢) Choose Go to -> Define customer enhancement.
d) Enter a key for your project.
e) Choose Project -> Create.

f)  Create a customer project using SAP enhancement AMAV0001.

For more information, see the long text for SAP enhancement AMAV0001.
Further notes

- SAP library FI-AA: Transactions -> Dates in Asset Accounting

- SAP library FI-AA: Individual User Modification (User EXits)

Enhancements

Various positions in various programs in the FI-AA component are set up so you can call your own
modified function modules in order to expand on the standard system functions.

In the following steps, you can create your own enhancement projects.

Further notes

For an overview of the customer enhancements in Asset Accounting, refer to the SAP Library under
"Customer Enhancements (Customer EXits)".

For general information on customer enhancements, refer to the documentation for transaction CMOD (the
"Information™ pushbutton).

Develop Enhancement for Changing Line Iltems

In this step, you define changes to line items using a prepared customer enhancement project. These
changes become effective during the posting of asset accounting transactions (except for: complete
retirement/complete transfer, write-up).

Example

In this way, it is possible, for example, to post only a percentage of the asset amount to a given depreciation
area.

Note

Enhancement projects function on the basis of certain positions in standard SAP programming code that
have been prepared by SAP to allow the call of function modules programmed by the user to meet his/her
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specific requirements. Therefore, it is possible to implement enhancement projects only if you have
knowledge of the ABAP/4 programming language.

Recommendation

INCLUDE ORFA_CUSTOMEREXIT_RECOM OBJECT DOKU ID TX

Standard settings

In the standard system, changes to line items are not possible.
Activities

1. Modify function module EXIT_SAPLANLG_003 and the include program ZXINTUO5 in it to meet
your requirements.

2. Activate a customer enhancement project (with any key) using SAP enhancement AINT0004.

Further notes

For more information, refer the documentation for customer enhancement AINT0004 (transaction
SMOD).

For an overview of the customer enhancements in Asset Accounting, refer to the SAP Library under
"Customer Enhancements (Customer EXits)".

For general information on customer enhancements, refer to the documentation for transaction CMOD (the
"Information™ pushbutton).

Develop Enhancement for Checks during Posting
In this step, you create an enhancement project for carrying out expanded checks during asset posting.

Note

Enhancement projects function on the basis of certain positions in standard SAP programming code that
have been prepared by SAP to allow the call of function modules programmed by the user to meet his/her
specific requirements. Therefore, it is possible to implement enhancement projects only if you have
knowledge of the ABAP/4 programming language.

Recommendation

You should review your needs carefully. Generally, you should not need to use enhancement projects,
since all common requirements are already met by the standard system functions.
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Activities
1. Modify function module EXIT_SAPLAPCF_003 to meet your requirements.
2. Activate a customer enhancement project (any key) using SAP enhancement AINT0001.

Further notes

For more information on customer enhancement AINT0001, refer to its documentation (transaction

SMOD).
For an overview of the customer enhancements in Asset Accounting, refer to the SAP Library under
"Customer Enhancements (Customer Exits)".

For general information on customer enhancements, refer to the documentation for transaction CMOD (the
"Information" pushbutton).

Develop Enhancement for Revenue Distribution for Mass Retirement

In this step, you create an enhancement project that you can use to define your own distribution of the total
revenue received during a mass retirement to the assets being retired.

Note

Enhancement projects function on the basis of certain positions in standard SAP programming code that
have been prepared by SAP to allow the call of function modules programmed by the user to meet his/her
specific requirements. Therefore, it is possible to implement enhancement projects only if you have
knowledge of the ABAP/4 programming language.

Recommendation

You should review your needs carefully. Generally, you should not need to use enhancement projects,
since all common requirements are already met by the standard system functions.

Activities
1.  Modify function module EXIT_RAWFOBO02_001 to meet your requirements.
2. Activate a customer enhancement project (any key) using SAP enhancement WFOBO0001.

Further notes

For more information, refer to the documentation for customer enhancement WFOBO0001.

For an overview of the customer enhancements in Asset Accounting, refer to the SAP Library under
"Customer Enhancements (Customer Exits)".
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For general information on customer enhancements, refer to the documentation for transaction CMOD (the
"Information™ pushbutton).

Develop Enhancement for Repayment Amount

In this step you set up an enhancement project that you can use to specify a repayment amount for an
investment support measure, when the asset is retired within the required period of retention.

Note

Enhancement projects function on the basis of certain positions in standard SAP programming code that
have been prepared by SAP to allow the call of function modules programmed by the user to meet his/her
specific requirements. Therefore, it is possible to implement enhancement projects only if you have
knowledge of the ABAP/4 programming language.

Recommendation

You should review your needs carefully. Generally, you should not need to use enhancement projects,
since all common requirements are already met by the standard system functions.

Activities
1. Modify function module EXIT_SAPLAPCF_004 to meet your requirements.
2. Activate a customer enhancement project (any key) using SAP enhancement AINT0003.

Further notes
For more information, refer to the documentation for customer enhancement AINT0003 (transaction
SMOD).

For an overview of the customer enhancements in Asset Accounting, refer to the SAP Library under
"Customer Enhancements (Customer Exits)".

For general information on customer enhancements, refer to the documentation for transaction CMOD (the
"Information” pushbutton).

Develop Enhancement for Asset Value Date

In this step, you create an enhancement project that you can use to specify how the default asset value date
should be determined for accounting transactions in Asset Accounting.
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Note

Enhancement projects function on the basis of certain positions in standard SAP programming code that
have been prepared by SAP to allow the call of function modules programmed by the user to meet his/her
specific requirements. Therefore, it is possible to implement enhancement projects only if you have
knowledge of the ABAP/4 programming language.

Standard settings

In Customizing for Asset Accounting, you can specify:

- The primary rule that is used to determine the asset value date from other dates (such as the document
date and posting date)

- The alternative rule that is used when the fiscal year of the date based on the primary rule is different
from the fiscal year of the posting date

Recommendation

You should review your needs carefully. Generally, you should not need to use enhancement projects,
since all common requirements are already met by the standard system functions.

Further notes
For more information, refer to the documentation for customer enhancement AMAV0001 (transaction
SMOD).

For an overview of the customer enhancements in Asset Accounting, refer to the SAP Library under
"Customer Enhancements (Customer Exits)".

For general information on customer enhancements, refer to the documentation for transaction CMOD (the
"Information" pushbutton).

Enhancement for Value Determination with Mass Impairment
Postings

Use

This Business Add-In (BAdI) is used in the Asset Accounting (FI-AA) component. You can use this BAdI
to influence the calculation of impairment amounts according to your needs.

You specify how the total amount of the impairment that you enter is distributed to the individual assets in
a work list. The BAdI is called for an impairment work list if you have specified that the system should
take your specifications into account when distributing the total amount of the impairment.

Warning
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Make sure that the total amount of the impairment agrees with the total of the impairment amounts for the
individual assets.

The distribution is made wusing the method Distribution of Impairment Amount
(DISTRIBUTE IMPAIRMENT). The method uses the following parameters:

- Import parameter I _DISTR CUST: Structure of the parameters that are relevant for the distribution
of the total amount to the assets in a work list. The structure is defined by the structure

FIAA_IMPAIR_DISTR_CUST.

- Return parameter CT IMPBTR: Table of the impairment amounts. The table is defined by the
structure FIAA_WF_IMPBTR and contains the impairment amounts of the individual assets in a
work list. The amounts for each asset are further divided into asset acquisitions from the prior year
and acquisitions from the current year.

Standard settings

For more information on the standard settings (filters, single or multiple use) see the Enh. Spot Element
Definitions tab page in the BAdI Builder (transaction SE18).

Activities

For information about implementing BAdIs as part of the Enhancement Concept, see SAP Library for SAP
NetWeaver under BAdIs - Embedding in the Enhancement Framework.

Business Add-Ins for Enhancements

BAdI: Control of Number Assignment for Mass Transfer

Use

This Business Add-In (BAdI) is used in the Asset Accounting (FI-AA) component.
You can use this BAdI to influence number assignment of new assets during a mass transfer.

Using the method KEEP_ MAIN NUMBER, you can set an indicator in order to keep the main asset number
when the new asset is created.

The method EXTERNAL SUBNUMBER is for external sub number assignment.

Requirements

Keeping the original main asset number is only possible when you are transferring within a company code.
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Standard settings

In the standard system, there is no active BAdl implementation. No methods are called.

Activities

After you call the IMG activity, the system displays a dialog box where you enter a name for the
implementation.

If implementations of this Business Add-In have already been created, the system displays them in a dialog
box. You then choose one of them by choosing Create, and continue as follows:

1.

In the dialog box, enter a name for the implementation of the Add-In and choose Create. The system
displays the initial screen for creating Business Add-In implementations.

On this screen, enter a short description for your implementation in the Implementation Short Text
field.

If you choose the Interface tab, you will notice that the system has populated the Name of the
Implementing Class field automatically, by assigning a class nhame based on the name of your
implementation.

Save your entries and assign the Add-In to a package.
To edit a method, double-click its name.

Enter your implementation code between the methods <Interface Name>~<Name of
Method>. And end method. Statements.

Save and activate your code. Navigate back to the Change Implementation screen. Note: You can
also create an implementation for an Add-In and not activate it until later. If you want to do this, do
not perform the following step:

Choose Activate.
When the application program is executed, the code you created is run through.

Maintain Message Types

Use

In this IMG step, you can set the message type for selected messages in the area of posting. The messages
are then sorted by application area, which you can recognize on the basis of the messages that appear.

Requirements

The message has to be set up as configurable. This includes the value range of the allowed message types,
as well as a standard message type.

Standard settings
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In the standard system there no default message types entered. The system adopts the standard message
type that is entered in table T100S.

Example

You can set up message AA 348, for example, so that it is only issued as a warning in dialog. To do so,
you would choose message class AA and then create entry 348 with the value: Online = ‘W".

Information System

In the step "Info system", you define

- the report selection in the Asset Accounting Info system
- sort versions for the asset reports

- the structure of the asset history sheet

- currency translation methods

- and other system configurations for reporting

Requirements

Before you can make settings in this step, you must do the following:
- Determine the structure of your asset history sheet.

- Determine the information requirements in your company that reporting should fulfil.

Further notes

SAP library FI-AA: Information System

Define Sort Versions for Asset Reports

In this processing step you define sort versions. Sort versions determine the sort keys and summation
criteria for your asset reports.

Standard settings

SAP delivers the following sort versions which you can take over or use as a reference for further versions:

- classification for transaction data reports

- book depreciation classification
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cost-accounting classification

net worth tax classification

classification for insurance values

Actions

1.  Adapt the standard versions to your requirements.

2. Create new sort versions according to your requirements using Edit --> New entries. The key should
begin with X, Y or Z.

3. Specify the sort hierarchy of the sort version via the sequence of field names in the field string
proposed by the system (from top to bottom). You can also specify length and offset for the individual
fields.

4. When you set the total indicator, the system subtotals at the specified sort level.
5. Additional indicators allow for

- displaying totals per main asset number (with accumulated values of all sub-
numbers)

- Sorting the sub-numbers per main asset number in descending order in this
way, the system displays the most recently created sub-number first.

Further notes

SAP library: Information System -> Sort Versions

Define Simulation Variants for Depreciation Reports

In the following step, you define the simulation versions for depreciation reports. You can enter a
simulation version when you start a standard depreciation list. The report is then executed with simulated
depreciation terms.

All depreciation lists that allow the use of simulation versions show the simulation version that was used
in the page header of the list. You can also request a list of all the replacement rules that were used in the
simulation (by pressing F2 = choose). You can also print this list.

Example

You can simulate how depreciation would look if you used declining-balance depreciation instead of
straight-line depreciation for your assets.

Standard settings

SAP provides simulation version Al as an example.
Activities
1. Define your simulation versions.

2. Enter the following for your simulation version:
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- The depreciation area, for which the simulation takes place

- The asset class for the simulation (you can make a generic entry from left to right using the "+"
symbol)

- The depreciation key for the simulation

- A valid-to date. The assets that are included in the simulation must have a capitalization date
before this date.

3. Define the following simulation parameters, depending on the purpose of the simulation;
- New depreciation key
- Change to the useful life as a percentage, for example 80% or 125 %

- Avalid-from date. The assets that are included in the simulation must have a capitalization date
after this date.

Define SAP Queries

The standard Asset Accounting reports are grouped together in a report selection tree. Some of these reports
are created using ABAP Query. In this step, you define new ABAP queries for Asset Accounting.

ABAP queries are either limited to a given client, or are not client-specific. Whether they are client-specific
or not depends on whether the queries are defined in the standard application area or in the global
application area. You have to transport client-specific queries, in order to make them available in other
clients (transaction SQ02).

Standard settings

SAP provides various standard queries for Asset Accounting (for example, the inventory list). You can use
these queries directly, or copy them and modify them to your requirements.

The following functional areas and queries are available:
AMO1 /01 Inventory lists

AMO2 / 02 Real estate and similar rights

AMO03 /03 Vehicles

AMO04 / 04 Leasing

AMO7 / 07 Depreciation

AMO7 / 11 Write-ups

AMO08 / 12 Revaluation and backlog

AMO09 / 13 Gain for transfer of reserves

AM11 /05 Address data for an asset

AM27 / 27 Depreciation posted, related to cost centres

All standard queries for Asset Accounting are provided in the global application area. As a result, they
Avre not client-specific, and you do not have to transport them.

Recommendation
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When you define your own queries, you can decide yourself if you want to create them in the global
application area (not client-specific) or in the standard application area (client-specific).

SAP recommends that you define your own queries in the global application area (not client-specific).
However, you should use your own user group. To create your own user group, copy the user group AM
with all of its queries. Name your user group using a name in the protected name range (with X, Y or Z).

Activities
1. Assign all SAP users, who need to use ABAP queries, to the user group /SAPQUERY/AM
(Environment -> User groups).
2.  Define queries to meet your needs.

a) Choose the application area in which you want to define your query (Environment ->
Application areas).

b) Copy and modify the standard queries of Asset Accounting. Under Environment -> User
groups, you can copy the user group AM with all of its standard queries.

c) If you want to copy the SAP standard queries from the global application area to the standard
application area, you have to use the transport transaction SQ02.

Further notes

SAP library: Basis -> ABAP Workbench

Asset History Sheet

In the section "Asset history sheet,” you define the individual history sheet versions. In addition, you
specify which history sheet groups are available for the various transaction types.

Further notes

SAP library FI-AA: Information System -> Definition of the Asset History Sheet

Define History Sheet Versions

Define the individual asset history sheet versions in this section.
A history sheet can be made up of the following columns:
- Column 00 : Initial values

- Column 99 : Final values
- Columns 01 to 06: Intermediate values

The asset history sheet versions are used in report "RAGITTO01".

Default settings
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SAP delivers the following asset history sheet versions, for example:
- total depreciation

- acquisition values

- asset history sheet in compliance with EC directives

- transferred reserves

- special reserves

You can use these versions without making changes.
Activity
Define your own versions according to your requirements. The key should begin with X, Y or Z.

Further notes (Transport)

You can include the history sheet version in a transport request in the overview screen of the transaction
under History sheet -> Transport. Note that the definition of the history sheet version applies only in
specific clients. Therefore, you need to transport not only if you need transports between systems (for
example, from a test system to a productive system), but also in order to make the history sheet version
available in other clients.

Define History Sheet Groups

You define the individual history sheet groups in this section. You classify transaction types for the
definition of history sheet groups by assigning them to a history sheet group.

Default settings

SAP delivers all the necessary history sheet groups for the standard version of the asset history sheet. In
the standard system, this means the transaction type groups that are relevant for the asset history sheet
(every transaction type group corresponds to a history sheet group). There are also three special history
sheet groups: YA (values at the beginning of the fiscal year), YY (values during the fiscal year) and YZ
(values at the end of the fiscal year).

Recommendation

You generally do not need to define your own asset history sheet groups. You should do this only if you
want transaction types from the same transaction type group to flow into different positions of the history
sheet. In this way, you can assign a newly defined transaction type to a special position in the asset history
sheet, without having to define an individual transaction type group for it.

Actions

1.  Define your own history sheet groups, if you need them.
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The keys of your self-defined history sheet groups should begin with X, Y, or Z.

2. Enter your self-defined history sheet groups in the definition of the concerned transaction types.

Define Asset Register for Italy

In this section, you define the output and sort sequence of your asset register. The asset register is a report
required by law in Italy. All transactions such as purchases, acquisitions, asset retirements, transfers,
depreciation and revaluations have to be listed there. The Italian asset register has to be printed according
to special sort terms (location, year, description, license plate number).

Actions

Define which fields are to occur in the asset register and are to be used as a sort key for each company
code, account allocation and asset class. The following fields are available:

- Location
- Text
- License plate number

- Acquisition year

Configure Asset Value Display

In this step,

- You specify the reports that can be called up directly from the asset value display transaction
(AWO01), from the menu Environment -> Evaluation. In order to do this, you link the function
codes of the transactions with the respective reports in a table.

- You specify the short texts the system displays for the value fields in the asset value display
transaction. You can specify particular value field texts for particular depreciation areas.

Standard settings

SAP supplies standard short texts for the asset value display transaction.

The following standard reports for asset values are contained in the standard system.
RO01: Asset history sheet

R002: Acquisitions

ROO03: Transfers

RO04: Property list
R005: Insurance list

RO06: Line items

RO07: Assets not posted

R008: Depreciation comparison
R009: Retirements

RO010: Insurance list
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RO11: Depreciation and interest
RO12: Depreciation
R013: Manual depreciation

RO14: Leasing liabilities RO:
List of origins

Recommendation

Usually, you do not have to make any changes to the standard settings unless

you have defined your own depreciation area(s) with a special meaning

you have developed your own report, and you want to link this report to the value display transaction
Activities

1.  Proceed as follows, if you have created your own reports for asset values and want to call them from
the value display transaction: Create your own entry, by
- writing over a standard entry

- Copying an existing entry and giving it a new number both
reports are then displayed in a pop-up window.

2. Change the short texts for the asset value display transaction, if necessary.

Define Currency Translation Methods

In this section, you define the currency translation methods for your asset reports. You can specify these
translation methods when starting the report. The system then determines the asset values for the report
according to the defined method and in the corresponding currency.

Note

Certain parameters are available for the definition of a translation method (see below). If these parameters
are insufficient, you can program individual translation methods by using a user modification.
See the SAP library FI-AA: "Individual User Modification (Customer EXxits)".

Default Settings

SAP delivers the following translation methods:
- Historical conversion at the capitalization date

- Key date translation

Actions

Define your translation methods. The following parameters are available:
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- Target currency
- Type of rate (for example, bank buying rate, bank selling rate or average exchange rate)

- Date of currency translation
You have the following alternatives for the date of currency translation:

- the date of capitalization
- a date that can be defined without restrictions in the translation method

- individual translation using a user modification

Define or Assignh Forms

In this step, you define layout sets (forms) for

- the evaluation "Asset history" (asset chart) in the Asset Accounting Info system and
- for printing labels with asset information (barcodes) using the inventory list

Layout sets determine the layout of the list printout of this report.

You can store a separate layout set in every asset class for the asset chart. The report then uses this layout
set for the fixed assets of this class and creates a corresponding asset chart. Note that the report evaluates
only fixed assets with an active history management (indicator in the asset master record).

You can enter the layout set for the inventory list when you start the report.

Standard settings

SAP supplies the layout set FIAA_F001 as a default for the asset chart and the layout set FIAA_0003 for
the inventory labels.

Recommendation

Use these standard layout sets, or copy them to define your own layout sets.
Activities

1.  Copy the standard layout set:
- Choose the function Layout set -> Change.

- Copy this form via Layout set -> Save as.
2. Modify the copied layout set according to your requirements:

- Choose Change layout set, with the option Side window.
- Select the main window (main) by double-clicking (or header or footer window).
- Choose the function Text elements.
- Change the layout set in the SAP script editor according to your requirements.
3. Assign a layout set for the asset history sheet in your asset classes.
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Further notes

- SAP library FI-AA: Information System -> Asset History (Asset Chart)
- SAP library FI-AA: Information System -> Asset Lists

- For a detailed description of SAP layout set maintenance, please refer to the hypertext STXD_SF.
You can call this hypertext up with the transaction SO70.

Enhancements

In the next steps, you develop customer enhancements for the FI-AA Information System. These
enhancements are based on customer exits.

Further notes

For an overview of the customer enhancements in Asset Accounting, refer to the SAP Library under
"Customer Enhancements (Customer Exits)".

For general information on customer enhancements, refer to the documentation for transaction CMOD (the
"Information" pushbutton).

Define Enhancement for Currency Translation Methods

In this step, you use a prepared customer enhancement project to define your own currency translation
methods for the output of foreign currencies in FI-AA reporting.

Standard settings

The standard translation methods are:
- Historical translation on the capitalization date

- Key date conversion

Recommendation

You should review your needs carefully. Generally, you should not need to use enhancement projects,
Since all common requirements are already met by the standard system functions.

Activities

1. Modify function module EXIT_SAPLAMGS_001 and the include program in it to your requirements.

Activate a customer enhancement project (any key) with SAP enhancement AMGS_001.
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Further notes

For more information, refer to the documentation for customer enhancement AMGS_001 (transaction
SMOD).

For an overview of the customer enhancements in Asset Accounting, refer to the SAP Library under
"Customer Enhancements (Customer Exits)".

For general information on customer enhancements, refer to the documentation for transaction CMOD (the
"Information™ pushbutton).

Define Enhancement for Output of Key Descriptions

In this step, you use a prepared customer enhancement project to define the output of key description texts
in the group totals lines of reports. This only affects key fields that are not in any of the standard sort
versions.

Note

Enhancement projects function on the basis of certain positions in standard SAP programming code that
have been prepared by SAP to allow the call of function modules programmed by the user to meet his/her
specific requirements. Therefore, it is possible to implement enhancement projects only if you have
knowledge of the ABAP/4 programming language.

Standard settings

All key fields that are contained in the standard sort versions are output with their description in reporting.

Recommendation

You should review your needs carefully. Generally, you should not need to use enhancement projects,
since all common requirements are already met by the standard system functions.

Activities
1.  Modify function module EXIT_SAPLANLR_001 and the include program in it to your requirements.
2. Activate a customer enhancement project (any key) with SAP enhancement ANLRO001.

Further notes
For more information, refer to the documentation for customer enhancement ANLROO0O1 (transaction
SMOD).

For an overview of the customer enhancements in Asset Accounting, refer to the SAP Library under
"Customer Enhancements (Customer EXxits)".

For general information on customer enhancements, refer to the documentation for transaction CMOD (the
"Information" pushbutton).

WHATSAPP +255738656506



[BECOME A MASTER OF SAP S/4 FINANCIAL ACCOUNTING
{8 CUSTOMIZING]

Define Enhancement for Output of the Asset Number

In this step, you use a prepared customer enhancement project to change the output of the asset number in
the standard reports of Asset Accounting. For example, the inventory number can be output instead of the
asset number.

Note

Enhancement projects function on the basis of certain positions in standard SAP programming code that
have been prepared by SAP to allow the call of function modules programmed by the user to meet his/her
specific requirements. Therefore, it is possible to implement enhancement projects only if you have
knowledge of the ABAP/4 programming language.

Standard settings

The asset number is output as the primary key in all standard reports in the standard system.

Recommendation

You should review your needs carefully. Generally, you should not need to use enhancement projects,
since all common requirements are already met by the standard system functions.

Activities
1.  Modify function module EXIT_SAPDBADA 002 and the included program in it to your
requirements.

2. Activate a customer enhancement project (any key) with SAP enhancement BADAO0O2.

Further notes
For more information, refer to the documentation for customer enhancement BADAO002 (transaction
SMOD).

For an overview of the customer enhancements in Asset Accounting, refer to the SAP Library under
"Customer Enhancements (Customer Exits)".

For general information on customer enhancements, refer to the documentation for transaction CMOD
(The "Information™ pushbutton).
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Country-Specific Functions
Serbia
Tax Depreciation

Define transaction types for acquisitions and retirements

Use
Using this IMG activity, you define the setting required by the Serbian Tax Depreciation Report.
Activities

Enter transaction types used in your company for acquisition and for retirements/sales of the assets. Only
entered transactions will be used by the Tax Depreciation report.

Example

CoCd TType TTY Class

RS01 100  Acquiring transaction
RS01 110  Acquiring transaction
RS01 210 Selling transaction
RS01 260 Selling transaction

Japan

Maintain Depreciation Areas for Field Group Mapping

Use

In this Customizing activity you maintain the mapping between field groups and depreciation areas for
Company Code and the Chart of Depreciation for impairment functionality.

You can maintain the mapping between the depreciation areas to the field group that you require for the
impairment functionality.

Requirements

You have maintained the following settings:
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- Company Code
- Chart of Depreciation to be used
- Depreciation Area to be used

- Field Group to be mapped

NOTE

Map a field group to only one depreciation area. Configure only the depreciation area field group mapping
for the depreciation areas you would require for impairment. A maximum of nine depreciation areas can
be mapped.

Property Tax Report
Make Settings for Property Tax Report

Use
In this and the following IMG activities, you make the settings required by the Property Tax Report.

The report is for use by companies in Japan.

Requirements

You have already created a depreciation area that you use solely for the purposes of the Property Tax
Report.

Activities

In this IMG activity, you make the basic settings for various features of the property tax report, for
example:

- Which depreciation area it uses

- Which asset transaction types you want to use for various transactions, so that the report can interpret
them correctly

- How asset transactions are to be categorized in the acquisition lists and retirement lists
Before you can run the report for the first time, you must also provide the system with various data. For
more information, see under "Effects on Existing Data" in the Release Note.
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See also
SAP Library -> SAP R/3 Enterprise Application Components -> Logistics -> Country Versions ->
Asia-Pacific -> Japan -> Financial Accounting (FI) -> Asset Accounting (FI-AA) -> Property Tax

SAP Service Marketplace at http://service.sap.com/erp -> my SAP ERP Financials -> Country

Information -> my SAP Financials Japan -> Documentation -> New Property Tax Report (only
available in Japanese)

Business Add-Ins

Add-In: Depreciation Rates

Use

This Business Add-In enables the Property Tax Report to get the data it needs to calculate (a) additional
depreciation and (b) apply any special rules.

The report calls the Add-In before it starts calculating depreciation.

Note

You do not need to implement this Add-In if you apply special rules that use fractions with no more than
three digits, for example, 3/10. However, you do need it if your fractions have four or more digits, for
example, 11/12. For more information, see SAP Library -> SAP R/3 Enterprise Application Components -
> Logistics -> Country Versions -> Asia-Pacific -> Japan -> Financial Accounting (FI) -> Asset
Accounting (FI-AA) -> Property Tax -> Property Tax Report -> Special Rules.

Standard settings

No standard implementation is provided. However, SAP Japan provides an implementation for this Add-
In. For more information, see SAP Note 616975.

Activities
Additional Depreciation

You can have different rates for different run types, for example, for provisional runs and final runs. For
budgeting runs, you can have different rates for the tax declaration year and the year afterwards.

1. Create a table with fields for additional depreciation rates for each run type in each tax declaration
year.

2. Following the instructions, create an implementation that reads the depreciation rates and other data
from your table and copies them into the Add-In structure.

Special Rules

Note that the following information applies to this Add-In only and is irrelevant if you use the alternative
solution described under "Use" above.
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When you run the Property Tax Report, it checks each asset to see whether you have filled out the
Manual Revaluation Reason field. If so, the Add-In implementation looks up the corresponding fraction
for special depreciation. For example, if an asset has the manual revaluation reason Al, the implementation
looks up the fraction for A1, which is 1/3.

For these purposes, you have to create a table for the fractions and an implementation that reads the
fractions, as follows:

3. Inthe IMG activity Create Reasons for Manual Revaluation, create a reason for each special rule
under which you can claim special depreciation, for example:

Reason Description
Al Improved combustion
A2 Improved sewage disposal
A3 Improved industrial waste disposal
4.  Create a table with fields for each manual revaluation reason and the corresponding depreciation rate,
for example:
Reason Ratio
B 1/3
C 2/3
D 1/3

5. Following the instructions, create an implementation that reads each asset's reason and looks up the
corresponding fraction.

6. Assign a reason to each asset that is covered by a special rule.

See also

Methods

Determine Other Depreciation Rates

Add-In: Additional Asset Master Data

Use

This Business Add-In enables you to display more data from asset master records in the output list of the
Property Tax Report. By default, the output list already shows the information from a number of fields
from the asset master records. You can use this Add-In to add more fields to the output list.

The report calls the Add-In after it has calculated the depreciation on the assets, and just before it saves the

data.
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Caution

This Add-In can have an adverse effect on the report's performance and memory consumption, so include
as few additional fields as possible.

Activities
1. Decide which additional fields you want from the asset master.

2. Add these fields to the structure CI_RESULT.

This structure is included in the report's results table, IDFIAA_JP_RESULT. When you run the
report, the Add-In reads the additional data from the asset master and stores it in the structure
CI_RESULT, and is thus shown in the final output list.

3. Following the instructions, create an implementation that reads the additional data from the asset
master records and saves it in the structure CI_RESULT.

See also

Methods

Read Additional Master Data

Add-In: Additional Evaluations

Use

This Business Add-In enables you to perform your own evaluations on the data that is available to the
Property Tax Report. For example, companies in the railway industry can implement this Add-In so that it
calculates the decided value using the method specific to their industry.

The report calls the Add-In after it calculates the depreciation on the assets and before it saves the data.
Any values that this Add-In determines overwrite any data that the report has already calculated.

Caution

This Add-In can have an adverse effect on the report's performance, because it accesses all of the records
simultaneously with the interface table.

Activities

Following the instructions, create an implementation that processes the data provided by the report and
copies it into the table provided.

See also
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Methods

Perform Additional Evaluations

Add-In: Custom Layouts

Use

This Business Add-In enables the Property Tax Report to format the output in the same layout as the
property tax declaration forms used by the municipal tax offices. You can then print the output list straight
from the system and submit it to the tax office.

The report calls the Add-In after it calculates the depreciation on the assets and saves the data.

Activities

Following the instructions, create an implementation that formats the data supplied by the report in the
layout required by the tax office.

When the user fills out the report selection screen, he specifies which custom layout he wants. The report
transfers this information to the Add-In, which then calls the custom layout implementation that you have
created with that filter value. Therefore, when you create your implementation, you have to assign a filter
value to it (the Layout Definition).

SAP Japan provides an implementation for this Add-In. For more information, see SAP Note 616975.

See also

Methods

Create Own Layout

Kingdom of Saudi Arabia

Set up Asset Groups for Tax Depreciation

Use

With this Customizing activity, you configure the defined asset groups for tax depreciation.

Requirements
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- You have specified which evaluation group (1-4) is to be used in Customizing for Asset Accounting
under Financial Accounting (New) --> Asset Accounting --> Master Data --> User Fields --> Define
4-Character Evaluation Groups.

Activities

Enter the following information for each asset group:
- CoCd: The company code to which the asset group applies

- Number, EvGr, Description: The evaluation group number, value, and description. Repeat the settings
you made in the activity Define 4-Character Evaluation Groups.

- To: The fiscal year up to which the asset group is valid. You can opt to use new asset groups from the
beginning of a new fiscal year. If you do not want to do this, enter 9999 in this field.

- Ord in PDF: Enter the order in which the asset group is to appear in the PDF output.
- Percent: Enter the depreciation percentage rate (column [7] in the PDF output).

- Number of Asset Group in PDF Output: Enter the value to appear in the column Group No's in the
PDF output.

- % to Add: Enter the percentage rate for additions (column [3] in the PDF output).
- % to Disp: Enter the percentage rate for disposals (column [5] in the PDF output).

- % to Exc.: Enter the percentage rate for excess on repair and maintenance (column [10] in the PDF
output).

- Description of Asset Group in PDF Output

Assign Asset Groups to Asset Classes

Use

In this Customizing activity, you assign asset groups to asset classes.

Note: If an asset master record is not assigned to an asset group, the report Tax Depreciation of Fixed
Assets derives its assignment from the asset class. As a result, you do not have to assign all assets
individually if an asset class contains only assets from a single asset group. If an asset group is entered in
both the asset master record and in the asset class, the entry in the asset master record takes precedence. If
the asset group can be derived neither from the asset class nor from the asset master record, the asset master
record is skipped.

Requirements

- You have defined evaluation groups in Customizing for Asset Accounting under Financial
Accounting (New) --> Asset Accounting --> Master Data --> User Fields -->  Define 4-Character
Evaluation Groups.

- You have defined asset groups in Set Up Asset Groups for Tax Depreciation
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Specify Asset Group Totals

Use

With this Customizing activity, you can enter (or check) the starting balance for an asset group. You enter
the balance for a specific company code and year.

The starting balance is used in the calculation of depreciation (column [1] of the PDF output).

Note: You have to enter the balance manually for the first year only. In subsequent years, the balance is
calculated automatically. If the report Tax Depreciation of Fixed Assets (IDSAU_TD_MAIN) is run in
update mode for year NNNN, it modifies the rows of the table for year NNNN + 1 with the value of the
calculated balance.

Requirements

- You have defined evaluation groups in Customizing for Asset Accounting under Financial
Accounting (New) --> Asset Accounting --> Master Data --> User Fields --> Define 4-Character
Evaluation Groups.

- You have defined asset groups in Set up Asset Groups for Tax Depreciation.

Russia

Depreciation Bonus

Define Depreciation Bonus Parameters

Use

You can use this IMG activity to define the tax depreciation area for depreciation bonus posting and validity
in periods when the depreciation bonus needs to be restored before asset retirement.

Define Depreciation Bonus Transaction Types

Use

You can use this IMG activity to assign depreciation transaction types to depreciation bonus transactions
(Depreciation bonus or Depreciation bonus restore).
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Define Asset Retirement Messages

Use

You can use this IMG activity to display a warning or an error for each transaction type during asset
retirement posting if there are unrestored depreciation bonuses.

Input VAT on Assets
Automatic Tracking of Invoices for APC

Define Tax Codes for Input VAT on Assets

Use
In this and the following IMG activities, you make the settings that allow the system to automatically track
invoices for acquisition and production costs. For more information, see the SAP Library documentation
listed below.

The settings are also used by the Redetermination of Invoices for APC report.

Activities
In this IMG activity, you specify which tax codes you use to post input VAT on:
- Purchases of fixed assets
- Purchases of materials, equipment, and services used in the construction of assets for your own use

When you enter an invoice item with any of these tax codes, the system automatically starts tracking it.

See also

SAP Library -> SAP ERP Central Component -> Financials -> Country Versions -> Europe and Africa

-> Russia -> Financial Accounting (FI) -> Asset Accounting (FI-AA) -> Business Transactions ->
Automatic Tracking of Invoices for APC

Specify Posting Keys for Asset Credit Memos

Use
In this IMG activity, you specify which posting keys you use to post credit memos for:

- Purchases of fixed assets
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- Purchases of materials, equipment, and services used in the construction of assets for your own use
When you enter a line item with any of these posting keys, the system automatically starts tracking
it.

Activities

Enter the credit memo posting keys (those that you use for posting vendor items as debits). Do not enter
posting keys for reversing credit memos.

Note

Unlike the other two IMG activities, the settings you make here are not used by the Redetermination of
Invoices for APC report.

Verification of Invoice Items Related to Capitalized Assets

Define Secondary Event Dates

Use

In this and the following IMG activity, you make the settings for the Verification of Invoice Items Related
to Capitalized Assets report. For more information about the report, see the SAP Library documentation
listed below.

Activities
In this IMG activity, you specify on which date the state recognizes input VAT on assets.
When you run the report, it sets the assets' secondary event date according to the settings you make here.
You can define rules for the secondary event date determination based on:
- Asset type
- Internal order type
- Project type (WBS element)

If you do not define the order type and project type, the secondary event date is calculated based on the
asset type only. In this case, make the following settings:

Asset Type Order Type Project Type  Secondary Event Date

Capital Investments  <Leave blank> <Leave blank> Capitalization Date
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Assets under Construction <Leave blank> <Leave blank> Depreciation Start Date

Do not make any settings for any other asset types.

Example

You run the report for an asset under construction. You do not specify any order types or project types.
The asset starts depreciating on 1 January; the program sets the secondary event date to 1 January.

See also

SAP Library -> SAP ERP Central Component -> Financials -> Country Versions -> Europe and Africa
-> Russia -> Financial Accounting (FI) -> Asset Accounting (FI-AA) -> Statutory Reporting ->
Preparation of Input VAT Returns -> Verification of Invoice Items Related to Capitalized Assets

Specify Which Assets Require State Registration

Use

In this IMG activity, you enter the OKOF codes of all assets that require state registration.

Then, when you run the Verification of Invoice Items Related to Capitalized Assets report, it blocks the
input VAT that you paid for the assets, pending registration with the state. You cannot offset the VAT until
you register the assets.

Secondary Events
Specify Tax Codes for Invoice ltems Whose Usage Changes

Use

In this IMG activity, you make the settings used by the Secondary Events program, in the event of an
invoice item's usage having changed.

For more information, see the SAP Library documentation listed below.
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Example
Assume that you use the following standard tax codes for the following transactions taxable at 18%:
- For purchases of assets, V2 (deferred VAT), V9 (VAT after invoice payment), and VC (VAT after
capitalization)
- For purchases of materials, P2 (deferred VAT) and PC (VAT after invoice payment)

So that the program can switch the tax from one tax code to the other, make the following settings for each
company code:

Company Code Event Error Code Old Tax Code New Tax Code

RUO1 Change in Item Usage Not Used in AssetsV2 P2
RUO1 Change in Item Usage Not Used in AssetsV9 PC
RUO1 Change in Item Usage Used in Assets P2 V2
RUO1 Change in Item Usage Used in Assets PC V9
See also

SAP Library -> SAP ERP Central Component -> Financials -> Country Versions -> Europe and Africa
-> Russia -> Financial Accounting (FI) -> Asset Accounting (FI-AA) -> Statutory Reporting ->

Preparation of Input VAT Returns -> Secondary Events -> Transfer Postings for Invoice Items Whose
Usage Changes

Define Secondary Event Types

Use

In this Customizing activity, you define the secondary event types that you use at your company.

Activities

You can define the secondary event types per company code. You enter a code and a description as
required.
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Profit Tax

Gains and Losses on Retirements

Classify Transaction Types

Use

In this and the following IMG activities, you make the settings used by the Gains and Losses on
Retirements program.

In this IMG activity, you specify which transaction types you use for different types of asset retirements
(sales, scrapping, and "other").

You can then run the program separately for each type of retirement.

See also

SAP Library -> SAP ERP Central Component -> Financials -> Country Versions -> Europe and Africa
-> Russia -> Financial Accounting (FI) -> Asset Accounting (FI-AA) -> Tax Returns -> Profit Tax -> Gains
and Losses on Retirements

Classify G/L Accounts

Use

In this IMG activity, you specify which G/L accounts you use for:
- Revenues from sales of assets
- Expenses from asset retirements

When the Gains and Losses on Retirements program calculates the gain or loss on the retirement of each
asset, it only takes into account line items on these accounts. It ignores all others.
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Profit Tax Depreciation Report
Define Depreciation Groups

Use

In this IMG activity, you define the depreciation groups used in the calculation of depreciation for profit
tax purposes.
See also

SAP Library -> SAP ERP Central Component -> Financials -> Country Versions -> Europe and Africa
-> Russia -> Financial Accounting (FI) -> Asset Accounting (FI-AA) -> Tax Returns -> Profit Tax -> Profit
Tax Depreciation Report

Property Tax

Regions, Districts, and OKATO Codes

Define Regions and Districts

Use

In this and the following IMG activities, you make the settings for the Property Tax Report.

Activities

In this IMG activity, you define the regions and districts that you submit property tax returns to.

See also

SAP Library -> SAP ERP Central Component -> Financials -> Country Versions -> Europe and Africa
->Russia -> Financial Accounting (FI) -> Asset Accounting (FI-AA) -> Tax Returns -> Property Tax Report

NIXONTAGMAN@GMAIL.COM | Asset Accounting



Define OKATO Codes

Use
In this IMG activity, you define the OKATO codes that you need.

Assign OKATO Codes to Regions and Districts

Use
In this Customizing activity, you assign each OKATO code to the appropriate region or district.

You can also specify which vendor master record you use for the region or district's tax authorities. The
report uses data such as the address from the master record.

Note

For transport tax, you only need to assign OKATO codes to regions and districts if the OKATO code does
not identify the regions uniquely.

Tax Rates, Reductions, and Exemptions
Define Federal Tax Concessions

Use

In this and the following IMG activities, you make the settings that the Property Tax Report uses to
determine each asset's property tax rate.

Activities
In this IMG activity, you define the tax concessions that are provided for by the federal government.

In the activities Define Tax Reductions and Define Tax Exemptions, you define the reductions and
exemptions that each region and district grants under the federal tax concessions.

In the activity Define Property Tax Rates, you define the rates of tax provided for by each region and
district.
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Define Tax Reductions
Use

In this IMG activity, you define the reductions that each region and district grants under the federal tax
concessions.

Define Tax Exemptions
Use

In this IMG activity, you define the exemptions that each region and district grants under the federal tax
concessions.

Define Tax Rates
Use

In this IMG activity, you define the different property tax rates provided for by each region and district,
including reduced tax rates and tax exemptions.

Define Structural Division for Property/Transport Tax

Use

In this IMG activity, you can define the data source for the structural divisions that you want to use for the
property/transport tax calculation and declaration. You define the structural division for a given company

code and for a given period.
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Example

CoCd Valid to Valid from Str.Div Str.Div Str.Div

RUO06 31.01007 01.01007 Business Area  LocationRoom

Define Depreciation Areas for Property Tax Calculation

Use

In this Customizing activity, you define the depreciation areas that you can use when calculating property
tax using the Property Tax Calculation (Russia) report. You define the depreciation areas for a given asset
class and period.

Note

If the report does not find the depreciation area you entered for a given period, it uses the default
depreciation area 01 for property tax calculation.

BAdI: Property Tax Calculation

Use

This Business Add-In (BAdI) is used in the Property Tax Calculation report.

You can use this BAdI to modify or validate the results of the report.
The BAdI offers a method that allows you to the make the final modifications in the result of the tax
calculation.

Standard settings

In the standard system, there is no activated BAdI implementation.

Activities

For information about implementing BAdIs as part of the Enhancement Concept, see SAP Library for SAP
NetWeaver under BAdIs - Embedding in the Enhancement Framework.

Example
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To display the sample code, choose Go to -> Sample Code -> Display.

See also

This BAdI uses the interface J 3R_PTAX_CALC_BADI_INTERFACE. For more information, display
the interface in the Class Builder.

Transport Tax
Official Codes
OKOF Codes

Define OKOF Codes

Use

In this and the following IMG activities, you make the settings for the Transport Tax Report. For more
information, see the SAP Library documentation listed below.

Activities

In this IMG activity, you define the OKOF codes that you need.
See also

SAP Library -> SAP ERP Central Component -> Financials -> Country Versions -> Europe and Africa

-> Russia -> Financial Accounting (FI) -> Asset Accounting (FI-AA) -> Tax Returns -> Transport Tax
Report

Define Depreciation Group Parameters for OKOF Codes

Use

In this IMG activity, you assign depreciation groups to OKOF codes and define the following parameters:

- Extended OKOF code

- Minimum and maximum useful life of the asset that belongs to the given OKOF code and depreciation

group
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- Default useful life of the asset, in years and in periods, that belongs to the given OKOF code and
depreciation group

Requirements

You have defined the OKOF codes in the IMG activity Define OKOF Codes.

Define Transport Types

Use
In this IMG activity, you define the transport types that you need.
Enter the transport types as published by the government, and assign them to the appropriate OKOF codes.

OKATO Codes
Define OKATO Codes

Use

In this IMG activity, you define the OKATO codes that you need for the purposes of calculating transport
tax.

Since transport tax rates do not vary from district to district, but are the same throughout each region, you
only need define part 1 of the OKATO codes. You do not need to define parts 2 and 3.

Assign OKATO Codes to Vendors

Use

In this IMG activity, you assign each OKATO code to the appropriate vendor (tax authority office).
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Define Regions and Districts

Use

In this Customizing activity, you define the regions and districts that you submit transport tax returns to.

You only need to define regions and districts for transport tax if the OKATO code does not identify the
regions uniquely.

See also

SAP Library -> SAP ERP Central Component -> Financials -> Country Versions -> Europe and Africa

-> Russia -> Financial Accounting (FI) -> Asset Accounting (FI-AA) -> Tax Returns -> Transport Tax
Report

Assign OKATO Codes to Regions and Districts

Use

In this Customizing activity, you assign each OKATO code to the appropriate region or district.

You can also specify which vendor master record you use for the region or district's tax authorities. The
report uses data such as the address from the master record.

Note

For transport tax, you only need to assign OKATO codes to regions and districts if the OKATO code does
not identify the regions uniquely.

Tax Rates, Reductions, and Exemptions

Define Tax Reductions

Use

In this IMG activity, you enter the transport tax reductions that are defined by law.

NIXONTAGMAN@GMAIL.COM | Asset Accounting



Example

Code Description

20000 Reductions for organizations

20101 Organizations for the disabled
20102 Government bodies

20103 Tax authorities

20104 Rescue services

Define Tax Exemptions

Use

In this IMG activity, you enter the transport tax exemptions that are defined by law.

Example

Code Description

10200 Invalid cars with engines less than 100 HP
20300 Ships belonging to manufacturing companies 20401 Cargo ships and passenger ships

Define Tax Rates for OKATO Codes

Use

In this IMG activity, you define the transport tax rates.

Note

If the government changes the tax rates during the course of the fiscal year, overwrite the old tax rate. Do
not create a new record.
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Example

The City of Moscow publishes the following schedule of tax rates that is valid until 31 December 2007:

- For the first six years after manufacture, Lorries with up to 100 hp are taxed at RUB per unit of
horsepower.
- Lorries with 101-200 hp are taxed at 20 RUB per unit of horsepower.

- Lorries that belong to local government bodies are only taxed at RUB 10 and RUB 7 respectively.

Make the following settings:

OKATOTransport Type Valid Through Vehicle Age Reduction Code Tax
Tax Rate Base
45 52000 9999 0
2007 10
0
45 52000 9999 0 20
2007 20
0
45 52000 9999 20102100 7
2007
45 52000 9999 20102200 10
2007

Note that the OKATO code for the City of Moscow is 45, and that Lorries belong to the transport type
52000. The reduction code for local government bodies is 20102. There are no different tax rates for
vehicles of different ages.

Define Tax Rates for Regions and Districts

Use

In this Customizing activity, you define the transport tax rates for regions and districts.

As required by law, different tax rates apply for each region. In most of the cases, the first two digits of the
OKATO code identify the different regions. In these cases, you use the Customizing activity Define Tax
Rates for OKATO Codes to define the tax rates for OKATO codes.

In a few cases, however, OKATO codes with the same first two digits can refer to different regions. In this
case, you use this Customizing activity to define the tax rates for the different regions and districts.

Note

If the government changes the tax rates during the course of the fiscal year, overwrite the old tax rate. Do

not create a new record.
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Define Structural Division for Property/Transport Tax

Use
In this IMG activity, you can define the data source for the structural divisions that you want to use for the
property/transport tax calculation and declaration. You define the structural division for a given company
code and for a given period.

Example
CoCd Valid to Valid from Str.Div Str.Div Str.Div
RUO06 31.01007 01.01007 Business Area  LocationRoom

BAdI: Transport Tax Calculation

Use

This Business Add-In (BAdI) is used in the Transport Tax Calculation report.
You can use this BAdI to modify or validate the results of the report.

The BAdI offers a method that allows you to the make the final modifications in the result of the tax
calculation.
Standard settings

In the standard system, there is no activated BAdI implementation.

Activities

For information about implementing BAdIs as part of the Enhancement Concept, see SAP Library for SAP
NetWeaver under BAdls - Embedding in the Enhancement Framework.

Example

To display the sample code, choose Go to -> Sample Code -> Display.

See also

This BAdI uses the interface J 3R_TTAX_CALC_BADI_INTERFACE. For more information, display
the interface in the Class Builder.
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Statutory Forms
Basic Settings

Define Form Settings

Use

In this IMG activity, you can specify the name and the content structure name for the different forms.

The settings for this IMG activity are required for the generation of the PDF output. If you do not make
the settings for a specific form, the report execution terminates with an error message.

Example

The following table shows an example of the settings for one specific form. The columns not included in
this example are optional to fill in.

LK~ Name Text DDIC Structure
Name
EN INV19 Difference List for Stock J 3R_INV3 19

Define Company-Specific Settings

Use

In this IMG activity, you define company-specific settings for the different forms, including:
- Validity period

- Number range interval number

- Name of context

- Name of PDF interface

- Name of layout

Requirements

You have defined form settings for the relevant form in the IMG activity Define Form Settings.
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Example

The following table shows an example of the company-specific settings for one specific form. The columns
not included in this example are optional to fill in.

CoCd Name From To No. Context Name  Interface Name Layout Name

RUO06 INV1801.01006 01.01016 03 J_3R_INV18_CONTEXT
J_3R_INV18_INTERFACE J_3R_INV18_LAYOUT

Generate Forms

Use

In this IMG activity, you create interface and context for a new form based on the customizing settings you
defined.

Requirements

Make sure that:
- Adobe Reader 7 and Adobe Designer 7 is installed on your system (ERP2004 and above)
- You have defined the form settings in the IMG activity Define Form Settings

- You have defined the company-specific settings in the IMG activity Define Company-Specific
Settings

Define Number Range Intervals for Statutory Forms

Use

In this IMG activity, you define number range intervals for statutory forms used in Russia.

The system then assigns numbers from these intervals to the printout of the statutory forms.

Example
No. Year  From number to number Number Range Status Ext.
01 2006 0001000000 0001999999 10000000 Deselected
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Make Settings for Printing Asset Forms

Use

In this IMG activity, you define the main rules for the creation of asset accounting forms. You can define
the data source for the following fields:

- Inventory Card Number

- Structural Division (three fields concatenated)
- Location (three fields concatenated)

- Person Responsible

- Inventory Number

- Depreciation Calculation

- Short Characteristics of Intangible Assets

Check New Version of Inventory Card

Use

In this IMG activity, you can compare the data generated by the new and old versions of the Fixed Asset
Inventory Card (OS-6) for the selected fixed asset.

As of release ERP2005 there is a new version of the Fixed Asset Inventory Card. If you still use the
modified version of the old inventory card, differences may occur in the data gathered from the old and
new version of function modules. In this case, it might be necessary to check these differences, which are
displayed in the output of the program.

Business Add-Ins (BAdIs)

BAdI: Form INV-1

Use
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This Business Add-In (BAdI) is used in the Inventory List of Fixed Assets report.

You can use this BAdI to modify or validate the content of the Inventory List of Fixed Assets legal form.
The BAdI offers different methods that allow you to:

- Propose default values for the selection parameters

- Check and modify the user input

- Make final madifications in the content of the legal form after data selection

Standard settings

In the standard system, there is no activated BAdI implementation.

Activities

For information about implementing BAdIs as part of the Enhancement Concept, see SAP Library for SAP
NetWeaver under BAdIs - Embedding in the Enhancement Framework.

Example

To display the sample code, choose Go to -> Sample Code -> Display.

See also:

This BAdI uses the interface IF_J 3R_INV1 BADI_INTERFACE. For more information, display the
interface in the Class Builder.

BAdI: Form INV-1A

Use

This Business Add-In (BAdI) is used in the Inventory List of Intangible Assets report.

You can use this BAdI to modify or validate the content of the Inventory List of Intangible Assets legal
form.

The BAdI offers different methods that allow you to:
- Propose default values for the selection parameters
- Check and modify the user input

- Make final modifications in the content of the legal form after data selection

Standard settings

In the standard system, there is no activated BAdIl implementation.
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Activities

For information about implementing BAdIs as part of the Enhancement Concept, see SAP Library for SAP
NetWeaver under BAdls - Embedding in the Enhancement Framework.

Example

To display the sample code, choose Go to -> Sample Code -> Display.

See also:

This BAdI uses the interface J_3R_INV1A_BADI_INTERFACE. For more information, display the
interface in the Class Builder.

BAdI: Form INV-18

Use

This Business Add-In (BAdI) is used in the Difference List for Fixed Assets report.

You can use this BAdI to modify or validate the content of the Difference List for Fixed Assets legal
form.
The BAdI offers different methods that allow you to:

- Propose default values for the selection parameters
- Check and modify the user input

- Make final modifications in the content of the legal form after data selection

Standard settings

In the standard system, there is no activated BAdIl implementation.

Activities

For information about implementing BAdIs as part of the Enhancement Concept, see SAP Library for SAP
NetWeaver under BAdIs - Embedding in the Enhancement Framework.

Example
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To display the sample code, choose Go to -> Sample Code -> Display.

See also:

This BAdI uses the interface J_3R_INV18 BADI_INTERFACE. For more information, display the
interface in the Class Builder.

BAdI: Form OS-1

Use

This Business Add-In (BAdI) is used in the Acceptance and Retirement Record of Fixed Assets report.

You can use this BAdI to modify or validate the content of the Acceptance and Retirement Record of
Fixed Assets legal form.

The BAdI offers different methods that allow you to:
- Propose default values for the selection parameters
- Check and modify the user input

- Make final modifications in the content of the legal form after data selection

Standard settings

In the standard system, there is no activated BAdI implementation.

Activities

For information about implementing BAdIs as part of the Enhancement Concept, see SAP Library for SAP
NetWeaver under BAdIs - Embedding in the Enhancement Framework.

Example

To display the sample code, choose Go to -> Sample Code -> Display.

See also:

This BAdI uses the interface IF_J 3R_0OS1 BADI_INTERFACE. For more information, display the
interface in the Class Builder.
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BAdI: Form OS-1A

Use

This Business Add-In (BAdI) is used in the Acceptance and Retirement Record of Buildings report.

You can use this BAdI to modify or validate the content of the Acceptance and Retirement Record of
Buildings legal form.

The BAdI offers different methods that allow you to:
- Propose default values for the selection parameters
- Check and modify the user input

- Make final modifications in the content of the legal form after data selection

Standard settings

In the standard system, there is no activated BAdI implementation.

Activities

For information about implementing BAdIs as part of the Enhancement Concept, see SAP Library for SAP
NetWeaver under BAdIs - Embedding in the Enhancement Framework.
Example

To display the sample code, choose Go to -> Sample Code -> Display.

See also:

This BAdI uses the interface J_3R_OS1A BADI_INTERFACE. For more information, display the
interface in the Class Builder.

BAdI: Form OS-1B

Use

This Business Add-In (BAdI) is used in the Acceptance and Retirement Record of Fixed Asset Groups
report.

You can use this BAdI to modify or validate the content of the Acceptance and Retirement Record of

Fixed Asset Groups legal form.
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The BAdI offers different methods that allow you to:
- Propose default values for the selection parameters
- Check and modify the user input

- Make final madifications in the content of the legal form after data selection

Standard settings

In the standard system, there is no activated BAdI implementation.

Activities

For information about implementing BAdIs as part of the Enhancement Concept, see SAP Library for SAP
NetWeaver under BAdIs - Embedding in the Enhancement Framework.

Example

To display the sample code, choose Go to -> Sample Code -> Display.

See also:

This BAdI uses the interface J_3R_0OS1B_BADI_INTERFACE. For more information, display the
interface in the Class Builder.

BAdI: Form OS-2

Use

This Business Add-In (BAdI) is used in the Internal Transfer Record of Fixed Assets report.

You can use this BAdI to modify or validate the content of the Internal Transfer Record of Fixed Assets
legal form.

The BAdI offers different methods that allow you to:
- Propose default values for the selection parameters
- Check and modify the user input

- Make final madifications in the content of the legal form after data selection

Standard settings
In the standard system, there is no activated BAdI implementation.
Activities
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For information about implementing BAdIs as part of the Enhancement Concept, see SAP Library for SAP
NetWeaver under BAdIs - Embedding in the Enhancement Framework.

Example

To display the sample code, choose Go to -> Sample Code -> Display.

See also:

This BAdI uses the interface ] 3R_0S2_BADI_INTERFACE. For more information, display the interface
in the Class Builder.

BAdI: Form OS-3

Use

This Business Add-In (BAdI) is used in the Repairs and Improvements Record of Fixed Assets report.

You can use this BAdI to modify or validate the content of the Repairs and Improvements Record of
Fixed Assets legal form.
The BAdI offers different methods that allow you to:

- Propose default values for the selection parameters
- Check and modify the user input

- Make final modifications in the content of the legal form after data selection

Standard settings

In the standard system, there is no activated BAdI implementation.

Activities

For information about implementing BAdIs as part of the Enhancement Concept, see SAP Library for SAP
NetWeaver under BAdls - Embedding in the Enhancement Framework.

Example

To display the sample code, choose Go to -> Sample Code -> Display.

See also:
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This BAdI uses the interface J_3R_0S3_BADI_INTERFACE. For more information, display the interface
in the Class Builder.

BAdI: Form OS-4

Use

This Business Add-In (BAdI) is used in the Scrapping Record of Fixed Assets report.

You can use this BAdI to modify or validate the content of the Scrapping Record of Fixed Assets legal
form.

The BAdI offers different methods that allow you to:
- Propose default values for the selection parameters
- Check and modify the user input

- Make final modifications in the content of the legal form after data selection

Standard settings
In the standard system, there is no activated BAdI implementation.

Activities

For information about implementing BAdIs as part of the Enhancement Concept, see SAP Library for SAP
NetWeaver under BAdIs - Embedding in the Enhancement Framework.

Example

To display the sample code, choose Go to -> Sample Code -> Display.

See also:

This BAdI uses the interface J_ 3R_0S4 BADI_INTERFACE. For more information, display the interface
in the Class Builder.

BAdI: Form OS-4A

Use

This Business Add-In (BAdI) is used in the Scrapping Record of Vehicles report.
You can use this BAdI to modify or validate the content of the Scrapping Record of VVehicles legal form.
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The BAdI offers different methods that allow you to:
- Propose default values for the selection parameters
- Check and modify the user input

- Make final madifications in the content of the legal form after data selection

Standard settings

In the standard system, there is no activated BAdI implementation.

Activities

For information about implementing BAdIs as part of the Enhancement Concept, see SAP Library for SAP
NetWeaver under BAdIs - Embedding in the Enhancement Framework.
Example

To display the sample code, choose Go to -> Sample Code -> Display.

See also:

This BAdI uses the interface J_3R_0OS4A BADI_INTERFACE. For more information, display the
interface in the Class Builder.

BAdI: Form OS-4B

Use

This Business Add-In (BAdI) is used in the Scrapping Record of Fixed Asset Groups report.

You can use this BAdI to modify or validate the content of the Scrapping Record of Fixed Asset Groups
legal form.

The BAdI offers different methods that allow you to:
- Propose default values for the selection parameters
- Check and modify the user input

- Make final madifications in the content of the legal form after data selection

Standard settings
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In the standard system, there is no activated BAdI implementation.

Activities

For information about implementing BAdIs as part of the Enhancement Concept, see SAP Library for SAP
NetWeaver under BAdIs - Embedding in the Enhancement Framework.

Example

To display the sample code, choose Go to -> Sample Code -> Display.

See also:

This BAdI uses the interface J_3R_0S4B_BADI_INTERFACE. For more information, display the
interface in the Class Builder.

BAdI: Form OS-6

Use

This Business Add-In (BAdI) is used in the Fixed Assets Inventory Card report.

You can use this BAdI to modify or validate the content of the Fixed Assets Inventory Card legal form.
The BAdI offers different methods that allow you to:

- Propose default values for the selection parameters

- Check and modify the user input

- Make final modifications in the content of the legal form after data selection

Standard settings

In the standard system, there is no activated BAdI implementation.

Activities

For information about implementing BAdIs as part of the Enhancement Concept, see SAP Library for SAP
NetWeaver under BAdIs - Embedding in the Enhancement Framework.
Example

To display the sample code, choose Go to -> Sample Code -> Display.

See also
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This BAdI uses the interface J_3R_0S6_BADI_INTERFACE. For more information, display the interface
in the Class Builder.

BAdI: Form OS-6A

Use

This Business Add-In (BAdI) is used in the Inventory Card for Fixed Asset Groups report.

You can use this BAdI to modify or validate the content of the Inventory Card for Fixed Asset Groups
legal form.
The BAdI offers different methods that allow you to:

- Propose default values for the selection parameters
- Check and modify the user input

- Make final modifications in the content of the legal form after data selection

Standard settings

In the standard system, there is no activated BAdl implementation.

Activities

For information about implementing BAdIs as part of the Enhancement Concept, see SAP Library for SAP
NetWeaver under BAdIs - Embedding in the Enhancement Framework.

Example

To display the sample code, choose Go to -> Sample Code -> Display.

See also:

This BAdI uses the interface J_3R_OS6A BADI_INTERFACE. For more information, display the
interface in the Class Builder.
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BAdI: Form OS-6B

Use

This Business Add-In (BAdI) is used in the Inventory Book for Fixed Assets report.

You can use this BAdI to modify or validate the content of the Inventory Book for Fixed Assets legal
form.

The BAdI offers different methods that allow you to:
- Propose default values for the selection parameters
- Check and modify the user input

- Make final modifications in the content of the legal form after data selection
Standard settings
In the standard system, there is no activated BAdI implementation.

Activities

For information about implementing BAdIs as part of the Enhancement Concept, see SAP Library for SAP
NetWeaver under BAdIs - Embedding in the Enhancement Framework.

Example

To display the sample code, choose Go to -> Sample Code -> Display.

See also:

This BAdI uses the interface J 3R_0S6B_BADI_INTERFACE. For more information, display the
interface in the Class Builder.

BAdI: Form OS-14

Use

This Business Add-In (BAdI) is used in the Acceptance Record of Equipment report.

You can use this BAdI to modify or validate the content of the Acceptance Record of Equipment legal
form.

The BAdI offers different methods that allow you to:
- Propose default values for the selection parameters

- Check and modify the user input
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- Make final madifications in the content of the legal form after data selection

Standard settings

In the standard system, there is no activated BAdI implementation.

Activities

For information about implementing BAdIs as part of the Enhancement Concept, see SAP Library for
SAP NetWeaver under BAdIs - Embedding in the Enhancement Framework.

Example

To display the sample code, choose Go to -> Sample Code -> Display.

See also:

This BAdI uses the interface J_3R_0S14 BADI_INTERFACE. For more information, display the
interface in the Class Builder.

BAdI: Inventory Card Enhancements

Use

This Business Add-In (BAdI) allows you to make settings for printing the inventory card for fixed (OS-6)
or intangible (NMA-1) assets. You can use this BAdI to change all the output fields in the inventory cards.
You call this BAdI definition before printing these forms.

Standard settings

In the standard system, there is no activated BAdI implementation. The BAdI is designed for multiple use.

Activities

For information about implementing BAdIs as part of the Enhancement Concept, see SAP Library for SAP
NetWeaver under BAdls - Embedding in the Enhancement Framework.
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Investments and Improvements

Maintain Transaction Types for Investments and Improvements

Use

In this IMG activity, you can maintain transaction types for investments and improvements.

Depending on the report you want to execute, you use this IMG activity for different purposes:
- The Depreciation Bonus Calculation report uses only those transaction types for which you set the
indicator in the Investment column

- The Fixed Assets Inventory Cards report uses all the transaction types that you define in this IMG
activity

- The Balance Sheet Supplement N5 (FI-AA) report calculates the values for improvements using the
total of the transaction types you define here

Balance Sheet Supplement N5

Define Selection Criteria for Asset Classes

Use

You use this IMG activity to define groups of selection criteria based on asset classes.

These groups of asset classes are used in the Balance Sheet Supplement N5, FI-AA report. The figures in
the columns for each row of the balance sheet supplement N5 are calculated only for the assets that are
included in the corresponding asset class group.

Requirements

You have defined asset classes in the IMG activity Define Asset Classes.
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Maintain Sections in Balance Sheet Suppl. N5 (FI-AA)

Use

In this IMG activity, you can:

Define the sections you want to include in the Balance Sheet Supplement N5 (FI-AA)
Add or delete columns for each section and define their attributes

Add or delete line items for each section and define their attributes

Requirements

You have defined the selection criteria for asset classes in the IMG activity Define Selection Criteria for
Asset Classes.

Revaluation

Maintain Additional Accounts for Posting Revaluation

Use

You use this IMG activity to assign additional accounts to downward and upward revaluation of retired
assets. You need this setting for posting revaluation in the Fixed Asset Revaluation program.

Besides the standard accounts for depreciation posting, the Fixed Asset Revaluation program uses the
following four additional accounts that you assign in this IMG activity:

APC revaluation account for cumulative downward revaluation
Ordinary depreciation revaluation account for cumulative downward revaluation
APC revaluation account for cumulative upward revaluation of retired assets

Depreciation revaluation account for cumulative upward revaluation of retired assets

Requirements

The accountant has created the accounts above in the chart of accounts.
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Russian Fields in Asset Accounting Reports

Customizing Include: Add Russian Fields to Logical Database
Use

In this Customizing activity, you can add Russia-specific fields to the logical database (ADA), which
allows the system to automatically fill in the Russia-specific fields in the standard asset accounting reports.

You can only include fields beginning with GLO* (fields from tables GLOFAAASSETDATA and
GLOFAATMDPNDNT).

Note

If there are more than one time-dependent records in the table GLOFAATMDPNDNT for the current asset,
the system selects only the one that is valid on the reporting date

Activities

To add new fields to the logical database, follow the steps below:
1. Inthe Database table field, enter ANLAV and choose Display.
2. Onthe Components tab page, double-click the customizing include ClI_GLOFIELDS.

3. Create the structure and add the new fields as required on the Components tab page. Note
Only add fields beginning with GLO* (fields from tables GLOFAAASSETDATA and
GLOFAATMDPNDNT).

4. Choose Activate.

This Customizing activity only allows the system to fill in the Russia-specific fields already included in
the standard asset accounting reports. To include these fields in the reports, make the settings in the
Customizing activity Customizing Include: Add Russian Fields to Reports.

Customizing Include: Add Russian Fields to Reports

Use

In this Customizing activity, you can add Russia-specific fields to standard asset accounting reports.

For the standard reports below, you can use the following customizing includes to extend the relevant
structures with the fields as required?

ReportStructure Customizing Include
Asset Balances FIAA_SALVTAB_RABEST Cl|_REPRABEST
Asset History Sheet FIAA_SALVTAB_RAGITT CI_REPRAGIT
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Asset Transaction List FIAA_ SALVTAB_RABEWG Cl_REPRABEWG
Planned Depreciation List FIAA_ SALVTAB_RAHAFA Cl_REPRAHAFA

You can only include fields beginning with GLO* (fields from tables GLOFAAASSETDATA and
GLOFAATMDPNDNT).

Activities

To add new fields to the asset accounting reports, follow the steps below:
1. Inthe Data type field, enter the name of the structure as required and choose Change.
2. Onthe Components tab page, double-click the relevant customizing include.

3. Create the structure and add the new fields as required on the Components tab page. Note
Only add fields beginning with GLO* (fields from tables GLOFAAASSETDATA and
GLOFAATMDPNDNT).

4. Choose Activate.

This Customizing activity only allows you to include the Russia-specific fields in the asset accounting
reports. To allow the system filling in the fields with data, make the settings in the Customizing activity
Customizing Include: Add Russian Fields to Logical Database.

Ukraine

Basic Settings

Define Number Range Intervals for Statutory Forms

Use

In this IMG activity, you define number range intervals for statutory forms used in Ukraine.

The system then assigns numbers from these intervals to the printout of the statutory forms.

Example
No. Year  From number to number Number Range Status Ext.
01 2006 0001000000 0001999999 10000000 Deselected
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Define Form Settings

Use

In this IMG activity, you can specify the name, the content structure name, and the output settings for the
different forms.
The maintenance of the output settings is optional.

The settings for this IMG activity are required for the generation of the PDF output. If you do not make
the settings for a specific form, the report execution terminates with an error message.

We recommend that you make the following setting:

LK Name Text DDIC Structure Name

EN INV1_UA Physical Inventory List of Fixed Assets J_1UF_INV1

Define Company-Specific Settings

Use

In this IMG activity, you define company-specific settings for the different forms, including:
- Validity period

- Number range interval number

- Name of context

- Name of PDF interface

- Name of layout

We recommend that you make the following setting:
CoCd Form ValStDate ValEndDate No Form Interface  Name of Layout

+INV1_UA 01.01005 312999 01 J_1UF_INV1_CONTEXT J 1UF_INVL_|
NTERFACE J_1UF_INV1_LAYOUT

Requirements

You have defined form settings for the relevant form in the IMG activity Define Form Settings.
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Make Settings for Printing Asset Forms

Use

In this IMG activity, you define the main rules for the creation of asset accounting forms. You can define
the data source for the following fields:

- Inventory Card Number

- Structural Division (three fields concatenated)
- Location (three fields concatenated)

- Person Responsible

- Inventory Number

- Depreciation Calculation

- Short Characteristics of Intangible Assets

Example

KEYSET DESCRIPT CARDNUMBERSTRUCTDIV1 STRUCTDIV2 STRUCTDIV
3 LOCATION1 LOCATION2
0S6_MAIN ASSNUM GSBER KOSTL LOCAT GSBER LOCAT

Table continued:

LOCATION3RESP_PERSON INVNAUMBER DEPR_CALC  SHORT_CHAR DESC
RIPT

PLACE KOSTL INVNR PLAN OS-6 GENERAL SETTING

Business Add-Ins (BAdIs)

BAdI: Form INV -1

Use

This Business Add-In (BAdI) is used in the Physical Inventory List of Fixed Assets report.
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You can use this BAdI to modify or validate the content of the Physical Inventory List of Fixed Assets
legal form.

The BAdI offers different methods that allow you to:
- Propose default values for the selection parameters
- Check and modify the user input

- Make final modifications in the content of the legal form after data selection

Standard settings

In the standard system, there is no activated BAdI implementation.
Activities

For information about implementing BAdIs as part of the Enhancement Concept, see SAP Library for SAP
NetWeaver under BAdIs - Embedding in the Enhancement Framework.

Example

To display the sample code, choose Go to -> Sample Code -> Display.
See also

This BAdI uses the interface J_1UF_INV1 BADI_INTERFACE. For more information, display the
interface in the Class Builder.

China

Golden Audit (GB/T 24589-2010)
Specify Asset Classes

Use

In this Customizing activity, you specify the asset class’s specific to golden audit and describe each asset
class.

You need to specify the asset classes so that the Golden Audit: Assets (China) (GACNFIAA) report collates
all required asset data in the data file.

Requirements

For more information about reporting requirements and compliance with national standards, refer to the
latest publications from the China Electronics Standardization Institute (CESI).

Standard settings
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In this Customizing activity, you maintain the Asset Classes (Golden Audit) (V_IDCN_GA_ANLKL)
Customizing view.

Activities

1. Start view maintenance, using transaction SM30 and the Asset Classes (Golden Audit)
(V_IDCN_GA_ANLKL) Customizing view.

2. Create a new entry for the required asset class.

3. Enter the following data:
- Client

- Asset class -
Asset

description

4.  Save your entries.

Maintain Asset Transaction Types

Use

In this Customizing activity, you specify the transaction types for assets that are relevant for golden audit
reporting. Within Asset Accounting, the transaction type is used to classify business transactions and to
control system activities when business transactions are posted for assets.

You need to specify the transaction types for assets so that the Golden Audit: Assets (China) (GACNFIAA)
report collates all required asset data in the data file.

Requirements

For more information about reporting requirements and compliance with national standards, refer to the
latest publications from the China Electronics Standardization Institute (CESI).

Standard settings

In this Customizing activity, you maintain the Asset Transaction Types (Golden Audit)
(V_IDCN_GA_BWASL) Customizing view.

Activities
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1.  Start view maintenance, using transaction SM30 and the Asset Transaction Types (Golden Audit)
(V_IDCN_GA_BWASL) Customizing view.

2. Create a new entry for the required transaction type.
3. Enter the following data:
- Client
- Asset transaction type
- Asset transaction group (for golden audit reporting)

4.  Save your entries.

Maintain Asset Evaluation Groups

Use

In this Customizing activity, you define an asset evaluation group used to classify assets for golden audit
reporting.

You define asset evaluation groups so that the Golden Audit: Assets (China) (GACNFIAA) report collates
all required asset data in the data file.

Requirements

For more information about reporting requirements and compliance with national standards, refer to the
latest publications from the China Electronics Standardization Institute (CESI).
Standard settings

In this Customizing activity, you maintain the Asset Evaluation Group (Golden Audit)
(V_IDCN_GA_ORDNR) Customizing view.

Activities
1. Start view maintenance, using transaction SM30 and the Asset Evaluation Group (Golden Audit)
(V_IDCN_GA_ORDNR) Customizing view.
2. Create a new entry for the evaluation group.
3. Enter the following data:
- Company code
- Asset label number
- Usage status

- Change type
WHATSAPP +255738656506



[BECOME A MASTER OF SAP S/4 FINANCIAL ACCOUNTING
{8 CUSTOMIZING]

4.  Save your entries.

Specify Parameters for Asset Depreciation

Use

In this Customizing activity, you maintain the parameters based on which asset depreciation is calculated;
these parameters determine how asset depreciation data is reported in golden audit reporting.

You need to maintain asset depreciation parameters so that the Golden Audit: Assets (China) (GACNFIAA)
report collates all required asset data in the data file.

Requirements

For more information about reporting requirements and compliance with national standards, refer to the
latest publications from the China Electronics Standardization Institute (CESI).

Standard settings

In this Customizing activity, you maintain the Exchange Rate Types (Golden Audit) (V_IDCN_GA_DEP)
Customizing view.

Activities
1. Start view maintenance, using transaction SM30 and the Exchange Rate Types (Golden Audit)

(V_IDCN_GA_DEP) Customizing view.
2. Create a new entry for the required exchange rate type.

3.  Enter the following data:
- Company code

4.  Save your entries.

Asset Data Transfer

In the section "Data Transfer”, you transfer old assets data from a previous system to your SAP System.

Note

The transfer of old asset data using the old assets transaction does not affect the balances of the
corresponding reconciliation accounts in Financial Accounting. Therefore no automatic balance formation
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or reconciliation takes place and you will need to manually reconcile the balances. You can ascertain the
Asset Accounting values using the asset list. When you start this report, specify January 1st of the current
fiscal year as the report date. The system will then provide data as of December 31st of the previous fiscal
year (in other words, no depreciation from the current fiscal year is included). You can make any correction
postings to the reconciliation accounts using a special posting transaction (see Preparations for Productive
Operation.

Further notes

SAP library FI-AA: Asset Data Transfer

Set Company Code Status

In this step, you set your company codes to the status for old assets data takeover.

Requirements

You must have assigned a chart of depreciation to the company codes for Asset Accounting.

Standard settings

As standard, the company codes that have been assigned a chart of depreciation for Asset Accounting are
set to test mode. This means that

- assets can be taken over from a previous system
- posting can be carried out
When the status is "old assets data takeover", posting is no longer possible.

Activities

Set the company codes in question to the status "Old assets data takeover allowed".

Specify Sequence of Depreciation Areas

Use

In this activity, you determine the sequence in which the system presents the depreciation areas in the
legacy data transfer transaction.

It is recommended that you begin with the non-dependent depreciation areas. Dependent depreciation
areas, which take over values or depreciation terms from other depreciation areas, should appear last.

Note:

The specifications you make here affect performance during the automatic transfer of legacy data using
the batch input interface. The transfer data, however, does not have to be structured according to the
specifications you make in this activity.
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Activities

1.  First determine the sequence in which the depreciation areas are to be supplied with values in the
transaction for legacy data entry.

2. Number the depreciation areas according to this sequence.

Parameters for Data Transfer

In the following section, you specify parameters for the asset legacy data transfer.

Date Specifications

In the following section, you make specifications in connection with the time of the takeover.
Specify Transfer Date/Last Closed Fiscal Year

In this step, you determine the transfer date for the asset data transfer. This date determines the status of
posting to be used for the transfer (posting up to this date will be included in the transfer), not the actual
date the data transfer is carried out. This specification also determines whether you want to perform the
transfer during the fiscal year (with transfer of posted transactions/depreciation in the current fiscal year)
or at the end of the fiscal year (without transactions).

If the transfer date is not the last day of the fiscal year (according to the fiscal year variant in Fl), the system
interprets this as transfer during the fiscal year. The system cannot transfer any historical transactions. It
can only transfer cumulative values from the end of the last fiscal year, and the transactions in the current
fiscal year (the second is only possible for transfer during the fiscal year).

Example

Transfer date = December 31, 1997 =>
last closed fiscal year = 1997

Activities
Specify the transfer date for each company code.

Further notes

SAP library FI-AA: Asset Data Transfer -> Time of Transfer
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Specify Last Period Posted in Prv.System (Transf.During FY)

The following step is only necessary if you want to perform an old assets data takeover during the fiscal
year. In this case, you must specify the period up to which depreciation was posted in the previous system.
This period refers to the posted depreciation that is to be transferred during old assets data takeover.

Activities

Specify the period up to which depreciation was posted in the previous system.

Options

In the following section, you determine the control options for old assets data takeover.
Specify Entry of Net Book Value (No Accum. Ordinary Depr.)

If net book values are available in your previous system instead of accumulated depreciation values and
historical APC, then the net book values can be entered during value entry instead of the ordinary
depreciation. The ordinary depreciation amount is then calculated as the difference between the acquisition
value, the net book value and the other depreciation values (for example special depreciation). Note that
cumulative special depreciation may also be necessary for a correct calculation of the cumulative ordinary
depreciation.

Caution

Net book values can only be transferred using the manual takeover transactions. You cannot transfer net
book values using the batch input interface RAALTDO1.

Activities

Determine the company codes for which net book values should be entered during old assets data takeover
instead of cumulative depreciation.

Recalculate Depreciation for Previous Years

You can recalculate the accumulated depreciation from the past, based on SAP depreciation rules, when
- adepreciation area is newly entered
- The values from a depreciation area should be recalculated in the system.

This recalculation is based on the condition that the acquisition value was acquired completely at the time
of capitalization. However, for the book depreciation area, this is only possible in company codes that are
still in test mode.

Note

You can also recalculate accumulated past depreciation for individual assets using the transaction "change
old assets" (Function: recalculate values) after the takeover of data from your previous system.
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Activities

Determine the depreciation areas/company codes, for which you want to recalculate depreciation within
the framework of the takeover of old assets data from your previous system.

Recalculate Base Insurable Values

In this step, you determine whether the system should recalculate the base insurable value during old assets
data takeover.
Activities

Determine the depreciation areas/company codes for which the base insurable value is to be recalculated
during old assets data takeover.

Further notes

SAP library FI-AA: Special Valuations of Fixed Assets -> Insurance Values

Recalculate Replacement Values

In this step, you specify whether the system should newly calculate current replacement values (on the
basis of the index series currently stored in the system) during legacy data transfer. This assumes that the
complete acquisition value was posted at the time of capitalization. If a depreciation area is to be managed
with replacement values starting with the legacy data transfer date, these values can also be historically
calculated by the program.

Activities

Specify the depreciation areas/company codes for which replacement values should be recalculated during
the legacy asset data transfer.

Further notes

SAP Library FI-AA: Special Valuation -> Replacement Values

Transfer Foreign Currency Areas

You only need to carry out this step if you manage depreciation areas in foreign currencies.

In this step, you determine that foreign currency areas can receive values during old assets data takeover.
Then the depreciation areas are not supplied with values from another area by the system, although they

NIXONTAGMAN@GMAIL.COM | Asset Accounting



are defined as dependent areas by the Customizing settings. This specification can only be made for areas
that are managed in foreign currency.

Activities

Indicate the foreign currency areas that should be supplied with values during old assets data takeover.

Define Transaction Types for Transfer of Open Items

In this step, you define transaction types for the takeover of open items from a previous system. If you do
not have any assets under construction with line item management, you do not need this kind of transaction
type.

Automatic Data Transfer

In the following section, you copy old data from a previous system
- using a batch input procedure or

- as a direct import to the SAP database

Data Transfer Workbench: Fixed Assets

The data transfer workbench is a central transaction for the automatic transfer of data from a legacy system
into the ERP system. It offers the tools required for the initial and subsequent data transfer.

The complete documentation about the data transfer workbench is in the SAP Library:
CA - Cross-Application Components -> CA - Data Transfer Workbench

The documentation tells you step by step how to carry out the data transfer, and which object-specific
special features you should be aware of.

Define Enhancement for Direct Data Import

You only need this step if you have decided to use the direct data import method for asset data transfer.

In this step, you use a prepared customer enhancement project to define your own program checks for the
asset data transfer using direct data import (no batch input).

Note

Enhancement projects function on the basis of certain positions in standard SAP programming code that
have been prepared by SAP to allow the call of function modules programmed by the user to meet his/her
specific requirements. Therefore, it is possible to implement enhancement projects only if you have
knowledge of the ABAP/4 programming language.
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Standard settings

Only simple program checks are provided for the direct data import in the standard system (such as, checks
for the asset class, account determination, depreciation key, cost centre).

Recommendation

You should review your needs carefully. Generally, you should not need to use enhancement projects,
since all common requirements are already met by the standard system functions.
Activities

1.  Modify function module EXIT_RAALTD11 001 and the program included in it to your
requirements.

2. Activate a customer enhancement project (any key) with SAP enhancement ALTDO0O0OL.

Further notes

For more information, refer to the documentation for customer enhancement ALTDO0001 (transaction
SMOD).

For an overview of the customer enhancements in Asset Accounting, refer to the SAP Library under
"Customer Enhancements (Customer EXits)".

For general information on customer enhancements, refer to the documentation for transaction CMOD (the
"Information™ pushbutton).

Manual Online Transfer

In this step you enter old assets data from your previous system in the SAP system using an online
transaction.

Create/Change/Display Legacy Asset

In this step, you enter legacy assets from your previous system using an online transaction (Asset ->
Create). You can also change or display legacy assets.

Further notes

SAP Library: Legacy Data Transfer -> Transfer Methods -> Manual Transfer Using the Legacy Data
Transfer Transaction
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Create/Change/Display Legacy Group Asset

In this step you create old group assets by means of an online transaction (Asset -> Create).

You can also change or display old asset groups.

Legacy Data Transfer using Microsoft® Excel

In this step, you transfer legacy data using Microsoft Excel. This procedure is suitable when you want to
Transfer not more than a few hundred assets.

Requirements

You have to have already created an Excel sheet containing your legacy data.

Activities

1.  Start the transfer program.
2. Make the following settings in the initial screen of the transfer transaction:
a) Enter the path of the input file.

b) If you want to create a new field assignment, choose "Create field assignment.” On the next
screen, assign the field descriptions from your Excel worksheet to field in the SAP System.

c) If you want to use an existing field assignment, then select this field assignment and choose
"Start with field assignment.”

3. Carry out a test run, and correct any errors that occur during the test run.
4. Create the assets.

5. You can save field assignments by choosing "Saved assignments."

Further notes

For more information on legacy data transfer and on the structure of the Excel sheet, refer to the SAP
library under "Legacy Data Transfer Using Microsoft Excel."

Preparing for Production Start-up

After you have met your functional requirements by making the corresponding Customizing settings, you
carry out the more technically-oriented activities that are necessary for your SAP System to go productive
in the following section.
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Authorization Management

In the step "Management of authorization™
- You define the authorizations for the various authorization objects.

- you group the authorizations in authorization profiles
Further notes

SAP library FI-AA: Preparations for Productive Operation/ Authorizations -> Standard Authorization
Functions

Maintain Authorizations

Authorizations in Asset Accounting

The following authorization objects are defined for Asset Accounting:
- Asset classes

- Asset master records

- Transactions for asset master records

- Group assets

- Periodic processing

- Asset views

- Chart of depreciation

Detailed descriptions of these objects (for example, their fields) are found in the online documentation for
the individual authorization objects.

The object "ABAP Program Flow Checks" (Object class: Basis -> Development environment) exists for
the Information System in Asset Accounting. You can use this object to control whether a user can run a
report. The authorizations A_ALL, A_PROFIL_02 and A_PROFIL_04 are defined for the object. These
authorizations consist of an activity (running a report = SUBMIT) and the permissible authorization
groups. The available authorization groups correspond approximately with the nodes in FI-AA Standard
Report Selection:

AM10: ASSET LISTS

AM: INVENTORY LISTS

AM20: REAL ESTATE

AM25: VEHICLES

AM30: LEASED ASSETS

AMA40: BALANCE SHEET EXPLANATIONS
AM45: EXPLANATIONS FOR P&L

AMS50: COST ACCOUNTING
NIXONTAGMAN@GMAIL.COM | Asset Accounting



AMS55: DEPRECIATION FORECAST
AMG0: SPECIAL VALUATION

AM61: NET WORTH VALUATION
AM62: INSURANCE VALUES

AM70: PREPARATIONS FOR CLOSING
AMT75: DAY-TO-DAY ACTIVITIES
AMB80: TAXES

AMS85: HISTORY
This object links an authorization check with the call of standard FI-AA reports.

Requirements

You must have specified the workplaces and responsibilities of the system users.

Standard settings

SAP provides standard authorizations for the following Asset Accounting objects:

Assets: view

Asset postings: company code/asset class

Asset postings: asset class/transaction type

Asset classes: asset classes

Asset accounting: authorizations for periodic processing
Asset master maint: company code/asset class

Asset master maint: company code/business area

Asset master maint: company code/plant

Group assets: group assets

Asset Customizing: chart of depreciation

The authorization object for the program flow checks in the Information System has the following
characteristics:

- Complete authorization to start asset reports (A_ALL)
- Authorization for asset reports - Asset Accounting clerk ( A_PROFIL_ 02)
- Authorization for asset reports - technician (A_PROFIL_04)

You should note that the system always saves asset classes with 8 characters. Therefore, when you define
an authorization that is limited to certain asset classes, you have to enter the numerical key for the asset
class with leading zeroes.

SAP supplies the following standard profiles for Asset Accounting:

- A _ALL Complete authorization for Asset Accounting

- A_PROFIL_00 Sample profile for Asset Accounting system administrator
- A _PROFIL_01 Sample profile for asset accountant

- A_PROFIL_02 Sample profile for asset accounting clerk

- A _PROFIL_03 Sample profile for buyer for Asset Accounting

- A_PROFIL_04 Sample profile for a technician for Asset Accounting
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- A _PROFIL_05 Sample profile for a warehouse clerk for Asset Accounting

- F_ANLAGEN Sample profile for asset accountant from the view of the general ledger

For detailed descriptions of these objects (such as the fields belonging to them), refer to the online
documentation for each authorization profile.
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Description of the authorization objects
Object: A_B_ANLKL Asset postings: Company code/Asset class

Definition
This authorization object is the first part of the object ‘transactions in the asset master record.’

The definition at this level determines whether the user is authorized to post transactions to an asset master
record in an asset class within a given company code.

The activity type for the transaction is also defined here.

The system checks this authorization for Asset Accounting transactions. It also checks against this
authorization for posting transactions in other integrated areas, if an asset transaction is involved.

Defined fields
The following fields are allocated to the authorization object:

- Asset class: You limit the asset classes in the pop-up window using the codes you have defined for
your asset classes.

- Company code: You limit the company codes in the pop-up window using the codes you have defined
for your company codes.

- Activity type: there are three different activity types

- 01 =Create (post)

- 02 =Change - 03 = Display
Example
Field Value
Activity 01-03
Asset class LVA
Company code 0001

Object: A_ B_BWART Asset postings: Asset class/Transaction type

Definition
This authorization object is the second part of the object 'transactions in the asset master record.’

The definition at this level determines whether the user is authorized to post to an asset master record with
a given transaction type within an asset class.

Defined fields

The following fields are allocated to the authorization object:
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- Asset class (you limit the asset class in the pop-up window using the codes you have defined for your
asset classes)

- Company code (you limit the company code in the pop-up window using the codes you have defined
for your company codes)

Example

Field Value

Asset class *
Transaction type 100 - 400
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Object: A_S_ANLKL Asset master maintenance: Company code/Asset class

Definition

This authorization object is the first part of the object "asset master record."

The definition at this level determines whether the user is authorized to process data in a given company
code. The activity type for the transaction is also defined here. This authorization object is used for master
data transactions, for the display of value fields, and for reporting.

Defined fields

The following fields are assigned to the authorization object

Asset class (specified by entering a value in the pop-up window) - Company code
(specified by entering a value in the pop-up window)

Activity type - there are three different activity types:

01 = Create

02 = Change (including blocking and deleting)

03 = Display
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Object: A_S_GSBER Asset master maintenance: Company code/Business area

Definition
This authorization object is the second part of the object "asset master record."”

The definition at this level determines whether the user is authorized to work with the business areas in a
given company code.

Defined fields
The following fields are allocated to the authorization object:
- Company code (you limit the company code in the pop-up window using the codes you have defined)

- Business area (you limit the business area in the pop-up window using the codes you have defined)
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Object A_S WERK Asset master maintenance: Company code/plant

Definition
This authorization object is the fourth part of the object "asset master record."

The definition at this level determines whether the user is authorized to work with the master records for a
plant in a given company code.

Defined fields
The following fields are allocated to the authorization object:
- Company code (you limit the company code in the pop-up window using the codes you have defined)

- Plant (you limit the plant in the pop-up window using the codes you have defined)
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Object: A_A_VIEW Assets: View

Definition
This object controls the user authorization for an asset view in your installation.

You can define up to six different views in Asset Customizing. The asset view is itself a part of other
authorization checks (for example, the asset view '6' has no authorization for the field 'XY" in the asset
master record, or for the depreciation area '02").

The authorization is checked at the following times:
- when the user wants to select a different view

- When the user first calls up the display or maintenance transaction. The check takes place at this
point, since the first view that the user is authorized to use is assigned here.

Defined fields

The authorization object consists of the one field ‘asset view'. The values allowed are '1' to '6', or "',
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Object: A_PERI_BUK Asset Accounting: Authorizations for periodic work

Definition

This authorization object defines whether the user is authorized to carry out the following periodic
processing in Asset Accounting:

- Post depreciation (ACTVT 30)

- Recalculate depreciation (ACTVT 31)

- Post asset values (ACTVT 32)

- Post planned depreciation to cost accounting (ACTVT 33)
- Create new depreciation area ( ACTVT 34)

- Fiscal year change (ACTVT 35)

- Year-end closing (ACTVT 36)

- Archiving (ACTVT 37)

- Reload archive (ACTVT 38)

Defined fields
The fields in the authorization object are:

- Company code

- Activity
Example
Field Value
Activity 30 -
39
Company code 0001

Object: A_M_ANLKL Asset classes

Definition
Using this authorization object, you protect the asset classes in the client.

The system carries out a check only in the display and maintenance transactions in the asset class.

Defined fields

The fields of the authorization object are:
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- Asset class: The asset class has no authorization group. It is protected instead by means of the
key word (the code you have defined)

- Activity type: The system distinguishes the following activity types:
- 01 =Insertor Create

- 02 =Change - 03 = Display

- 05 = Lock
- 06 = Delete
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Object: A_S_ANLGR Group assets

Definition

This authorization object covers master data maintenance for group assets. This
does not affect authorizations for posting or reporting.

Defined fields
1. Company code
2. Activities supported:
a) Create (01)
b) Change (02)
c) Display (03)
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Object: A_C_AFAPL Chart of depreciation

Definition
Authorization object for the chart of depreciation in Asset Accounting.

Use this authorization object when you want to decentralize the maintenance of charts of depreciation, for
example, when you have an installation for several countries with different charts of depreciation.

Defined fields
3. Chart of depreciation
4. Activity:
a) Create (01)
b) Change (02)
c) Display (03)
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Assign Workflow Tasks

In this step, you make system settings for workflow control within the framework of Asset Accounting.
You need these settings for the following activities in Asset Accounting:

- making mass changes to master data using Workflow
- posting mass retirement using Workflow
- completing assets that were not completely created

A workflow activity consists of several tasks. The description of the task is in the task definition. The
responsibility for the task is assigned by linking the task to an organizational object from Personnel
Planning and Development (PD) organization management. Therefore, the following basic Customizing
settings are required in order to carry out a workflow activity in Asset Accounting:

- You have to assign the workflow tasks of Asset Accounting to organizational objects (such as the
position "asset accountant™)

- The corresponding organizational objects from your company organization structure have to be
assigned to the appropriate user as owner.

- The event linkage has to be activated for the standard tasks.

Note

You can also carry out mass changes and mass retirements without using workflow. For more information
on this option, see the objects on "Mass Changes to Master Data" and "Mass Retirement" in the SAP library
for Asset Accounting.

You can also process incomplete assets using normal asset reporting, if you choose. For more information,
see the object "Master Data Maintenance with Asset Views" in the SAP library for Asset Accounting.

If you decide not to use Workflow for the three activities discussed here, then you do not need to carry out
this step.

Standard settings

SAP supplies a task catalogue that contains all the relevant tasks for Asset Accounting.

Recommendation

You can also assign a Workflow task directly to a user. This option is only available if you use Workflow
only in Asset Accounting, and your organizational plan is not defined in the system. If this is the case, you
do not need any other organizational objects.

Activities

1. Assign the standard Asset Accounting tasks

- release work list

- correct work list
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- process incomplete assets
To an organizational unit, a position or a user.

You might want to allow the tasks "correct work list" and "release work list" to be called up in one
step. In that case, you have to make the same assignment for both tasks.

2. Activate the event linkage for the task "process incomplete assets."”

Further notes

SAP library FI-AA: Preparation for Production Start-up

Process Asset Views

In addition to the standard SAP authorization functions, the Asset Accounting component provides the
asset view, which offers additional authorization protection. The "asset view" authorization object
(A_A_VIEW) controls master data maintenance to a certain extent. You can use this object to assign users
limited views of asset data and asset values.

For each asset view, you can specify the field groups that can be maintained from this view, are displayed
only, or are suppressed. You also specify the field groups for which the user is only allowed to enter default
values.

Standard settings

The system can work with a maximum of 8 asset views. You can change these asset views, but you cannot
delete them or add new asset views.

To create asset master records you need at least one asset view. You have to use standard view 1 (asset
accounting) in order to be able to create complete asset master records.

Recommendation

You should use the standard SAP asset views. In that case, you do not have to carry out any activities here.
Activities

1. Choose "Asset view" and check the descriptions supplied by SAP. If necessary, change the
descriptions so they conform to your internal organization. Select the asset view with which you want
to work.

2. Choose "Authorization for master data fields". Specify which field groups in the selected asset view
can be edited, displayed or maintained.
Note: You can select several field groups at the same time and assign them the same authorization
using the "Set authorization" pushbutton (in group box "Set authorization for selected entries").

3. Choose "Authorization for depreciation areas". For each depreciation area, specify which
authorizations apply in the selected asset view.

Note: In the standard system, all depreciation areas can be maintained with asset view 1 (asset
accounting).
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Further notes

SAP Library: Asset Views

Check Consistency

After you have made all needed system settings, you can now check their consistency.
You should carry out this test for the following reasons:

- Along with the dialog checks, you should also check the consistency of your system settings at the
end as a whole (in overview).

- You should print out the settings.
In this step, you can
- check the plausibility of your system settings and

- print them out

Requirements

You must have worked through all of the previous steps.
Activity

1. Check the system settings for charts of accounts, company codes, and depreciation areas in the
corresponding overview lists.
2.  Start the consistency report for the asset general ledger accounts.

3. Start the consistency report for the FI-AA Customizing settings.

Production Start-up

In the section "Productive start”, you can reset the test company codes and assign the status "productive”
to the company codes.

Set or Reset Reconciliation Accounts

In this step, you can define the G/L accounts of Asset Accounting as reconciliation accounts, or you can
set these reconciliation accounts back to being normal, postable accounts. You can make these changes
only as long as the company code is not live for Asset Accounting. Another prerequisite is that this change
is no longer possible in Financial Accounting itself, because of balances from asset data transferred from

your legacy system.
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Set reconciliation accounts

Once you make this change, it is no longer possible to post directly to these accounts. Instead only
integrated posting using Asset Accounting is possible after this point.

Requirements

- You defined your account determination.

- You reconciled asset accounting balance sheet values with the balances of the reconciliation
accounts concerned.

- Todo so, use the Asset Accounting report Asset List. Enter the report date January 1, YYYY (if
data was transferred at fiscal yearend). YYYY denotes the year the system went live. In
Financial Accounting (FI), you can use an appropriate balance list for this purpose.

- Another option is to use reconciliation reports for this reconciliation.
Activities

Procedure for automatic conversion:
1.  On the detail screen, choose Set Reconciliation Ind. for All Accounts.

2.  Print the balances and the FI-AA asset list as a record for audits.

Caution

The accounts affected by the conversion are not allowed to be posted while the conversion is taking place.

Reset reconciliation accounts

Resetting the reconciliation account indicator in the account master data is also allowed only when the
company code is still in test status. This step is not necessary during an ordinary system implementation.
However, changing the reconciliation accounts could become necessary under the following
circumstances:

- You entered an incorrect account in an account assignment for Asset Accounting, and then carried
out the "Set reconciliation accounts™ step.

- You have to post balance adjustments to reconciliation accounts after the original conversion.

- You copied the account definitions from an asset accounting company code to another company code,
where asset accounting is not active. This second company code is intended for parallel accounting.
Now you would like to reset all reconciliation account indicators for this second company code.

Activities

3. Choose the company code you want to process.
4. Do one of the following:
a) Reset the reconciliation account indicator for individual accounts.

b) Reset the reconciliation account indicator for all displayed accounts by choosing Delete
Reconciliation Ind. for All Accts.
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Caution

Once the indicator is reset, these G/L accounts can again be posted directly, so that consistency between
the sub ledger balances and G/L balances is no longer guaranteed.

Transfer Balances

In this step you can post balances to G/L accounts which have already been defined as reconciliation
accounts. You can only post these corrections in company codes which have implementation status.

The transfer of legacy asset data using the legacy asset transaction does not affect the balances of the
corresponding reconciliation accounts in Financial Accounting. Therefore no automatic balance formation
or reconciliation takes place and you will need to manually reconcile the balances. You can ascertain the
Asset Accounting values using of the asset list. When you start this report, specify January 1st of the
current fiscal year as the report date. The system will then provide data as of December 31st of the previous
fiscal year (in other words, no depreciation from the current fiscal year is included).

Activities

Copy the balances from any suspense accounts to the Asset Accounting reconciliation accounts.

Activate Company Code

In the "Activate Company Code" step, you set the live indicator (0) for the company codes in which the
test phase and legacy data transfer have ended. The live indicator ensures that data is not deleted from live
company codes by programs for deleting test data.

Requirements

After legacy data transfer and before setting a company code to live (production status) it is mandatory
to reconcile account balances, since the transfer of legacy data does not affect the reconciliation accounts
for Financial Accounting. There is no automatic creation and reconciliation of balances during legacy data
transfer.

Note

It is absolutely mandatory that you set the company code to live status (not test status) before you start live
use of the company code. In order to ensure the safety of live data, a live company code should not be set
back to test status. However, should it become necessary to enter legacy asset data after you have set the
status to live, you can still reset the status.

Activities

Set the live indicator for the desired company codes.
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Tools

In the "Tools" section, you can carry out reset activities that are needed during the system implementation
or during production operation.

Reset Company Code

In this step, you can delete test application data (asset master records and transactions) for a company code.
This might be necessary, for example, following a test takeover of old assets data.

Customizing settings are not deleted.

Caution

- At present, you cannot reload the deleted data again.

- If you are also using the IM (Investment Management) component, the assets under construction
belonging to capital investment measures are also reset. This can lead to inconsistencies in relation
to the orders/WBS elements, to which the assets under construction belong.

Requirements

1.  The company code you want to reset must be in test status.

2. You must have entered the application data (asset master records and transactions) in the test
installation.

Note

Keep in mind that Asset Accounting data is deleted in this processing step, but integrated applications (for
example, Financial Accounting) are not affected. Therefore you should only carry out this step in
conjunction with the other applications.

There is no problem with data that was transferred within the framework of the old assets data transaction
(or the batch input interface), since the old data takeover transaction does not update the values in Financial
Accounting.

Activity

1.  Settest status in the asset definition of the affected company code.

2. Start the reset program for the affected company code.

Reset Posted Depreciation

In this step, you can reset the posted depreciation in the asset sub ledger (only when the company code is
in test status). The system then deletes the corresponding value data of all the fixed assets for a company
code. This reset also deletes all data that is used to manage and monitor the depreciation posting runs. This
action might be necessary if you need to return to the original depreciation posting status during the system
installation phase, if errors occurred when you tested the depreciation posting run.
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This is not a reset in the accounting sense. No documents or posting sessions are created to cancel the
depreciation posting already made in Financial Accounting. As a consequence, a reset in Asset Accounting
results in differences between the accumulated depreciation of the fixed asset in the sub ledger and the
respective accounts in Financial Accounting. You need to make manual adjustment postings in the general
ledger to eliminate these differences. A reset is therefore only possible for company codes in a test
installation. The reset of the depreciation data is logged in the system log.

Caution

Please keep in mind that the data of all posting runs is deleted, not just the data of the last depreciation
posting run. In addition, the posted values entered during a data transfer during the fiscal year (depreciation
in the year of data transfer that was already posted in the legacy system) are deleted. This legacy data
therefore has to be re-entered.

Activities

1.  Start the reset program. Specify the company code and press ENTER.

2. Modify the number range of the document type for depreciation postings after successfully resetting
the posted depreciation. Define a new interval. As a lower limit of the new interval enter the number
following the last assigned document number.

Example:

Old number range: 0300000000 to 0399999999
last assigned document number: 0300000123 new
number range: 0300000124 to 0399999999

3. Correct the balances of the expense accounts or the accumulated depreciation accounts in Financial
Accounting (see balance transfer).

Reset Year-End Closing

In this step, you can reset the fiscal year that was last closed in Asset Accounting. This fiscal year is then
open again for posting. You can limit the reset by company code, or to specific depreciation areas within
a company code.

The precondition, however, is that the fiscal year is also reopened in Financial Accounting (FI General
Ledger).

Recommendation

Normally you are not allowed to reopen a fiscal year after it was already closed for accounting.
Therefore, you should only use this function in test systems.

Activities

Open the last closed fiscal year.
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Overview for Experts

The following steps do not contain additional functions. Instead they offer an overview of settings made
in other places in the Implementation Guide (IMG). They are sorted here by objects or activities (such as,
depreciation areas or asset data transfer). If you have already made these settings using the previous steps
in the IMG, you can check them again here at a glance.

Most of Customizing for Asset Accounting (FI-AA) is structured according to functions. This means that
your enterprise's requirements are represented by the functions of the FI-AA component. For example, the
settings for depreciation can all be maintained within one node of the IMG.

This functional approach simplifies Customizing for Asset Accounting. However, it also means that the
settings for one object can be at different places in the IMG. For example, you can make settings for the
depreciation area under "Valuation" and under "Depreciation."

Therefore, the Asset Accounting component also offers this object-oriented perspective, in addition to the
functional approach, for important objects and activities of Asset Accounting. This object-oriented
perspective offers a systematic overview of the settings made.

In the next steps, you can check the settings made for the following objects and activities at various other
places in the IMG:

- Depreciation areas

- Real depreciation areas

- Depreciation areas of company codes
- Company codes

- Data transfer

- Account assignment
- Transaction types

Note

For technical reasons, it is not possible to make changes to Customizing settings in the Overview for
Experts. This overview is only able to provide a unified way of looking at the Customizing settings already
made. You have to make any changes in the normal Implementation Guide.

Further notes

For more information, see the appropriate sections of the Implementation Guide (IMG) and the SAP
Library.

Check Depreciation Areas

In this step, you check various settings for depreciation areas.
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Further notes

For more information, refer to the documentation in Overview for Experts.

Check Real Depreciation Areas

In this step, you check various settings for real depreciation areas.

Further notes

For more information, refer to the documentation in Overview for Experts.
Check Company Code

In this step, you check various settings for company codes.

Further notes

For more information, see the documentation for Overview for Experts step.

Check Depreciation Areas of Company Codes

In this step, you check various settings for depreciation areas of company codes.
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Further notes

For more information, refer to the documentation in Overview for Experts.

Check Legacy Data Transfer

In this step, you check various settings for legacy data transfer.

Further notes

For more information, refer to the documentation for Overview for Experts.

Check Account Assignments

In this step, you check various settings for account assignments.

Further notes

For more information, refer to the documentation in Overview for Experts.

Check Transaction Types

In this step, you check various settings for transaction types.

Further notes

For more information, refer to the documentation in Overview for Experts.
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Check Asset Classes

Use

This activity offers an overview of all settings made up to now for asset classes. Changes are not possible
here. If you want to change Customizing for asset classes, use the normal IMG step
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